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Preface

This guide describes how to upgrade from earlier versions of MarkView and configure third-party 
products that integrate with MarkView. Use this document in conjunction with the Kofax MarkView 
Installation Worksheet.

Who should read this guide
The audience for this document includes:
• Oracle Database Administrators who are experienced with Oracle Relational Database 

Management System (RDBMS), can edit and run PL/SQL scripts, and are familiar with their ERP 
system.

• Application Server Administrators who have J2EE technology knowledge.
• Windows Server Administrators who have Microsoft Windows experience and who can install and 

configure Windows applications and hardware.
• Customers who are planning a new installation or a migration from a previous release of any 

MarkView product.

Administrators should be familiar with MarkView system operation.

Related documentation
The documentation set for Kofax MarkView is available online:1

https://docshield.kofax.com/Portal/Products/MarkView/10.5.0-yw2qf8m7r6/MarkView.htm

In addition to this guide, the documentation set includes the following items:

Kofax MarkView Features Guide
Use this guide to learn about the features included and options available with MarkView; to become 
familiar with MarkView products; and to decide which are important to the business challenges 
you face and best suit your site. This guide includes information about how features impact the 

1 You must be connected to the Internet to access the full documentation set online. If the 
security policy for your organization requires offline access (without an Internet connection), see 
the Installation Guide.
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workflow, the interaction between features, the touch points with the ERP system, and how features 
address business problems.

Kofax MarkView Planning Guide
Use this guide to learn about the prerequisites for implementing MarkView products. This guide 
includes system information, such as the protocols required for communication between servers, 
hardware and software prerequisites, and minimum RAM requirements.
Use this guide in conjunction with the Kofax MarkView Technical Specifications document on the Kofax 
MarkView Product Documentation site to prepare a site for product installation.

Kofax MarkView Installation Worksheet
Use this worksheet to collect and record the information you need to install or upgrade MarkView 
products.

Kofax MarkView Installation Guide
Use this guide in conjunction with the Kofax MarkView Installation Worksheet to install and configure 
MarkView products and to configure third-party products that integrate with MarkView.

Kofax MarkView Integration Guide
Use this guide in conjunction with the Kofax MarkView Technical Specifications document on the Kofax 
MarkView Product Documentation site to learn about the prerequisites for implementing Kofax 
products and preparing a site for product installation.

Kofax MarkView Reintegration Guide for Upgrades to Oracle E-Business Suite R12 or 12.2
Use this guide to reintegrate MarkView after an upgrade to Oracle E-Business Suite R12 or 12.2.

Kofax MarkView Administrator's Guide, Volume 1
Use this guide to administer the MarkView system. This guide describes how to configure and 
maintain the applications, solutions, and users that make up the MarkView Suite. The guide also 
describes how MarkView influences the administration of other servers and software that interface 
with MarkView applications.
The MarkView Administrator should be well-versed in database administration, application server 
setup, tuning and maintenance, or should know where to get such information. The administrator's 
guide does not replicate this information, but conveys MarkView product-specific information.

Kofax MarkView Administrator's Guide, Volume 2
Use this guide to maintain MarkView components that are administered outside of the MarkView 
interface. This guide includes advanced administrative tasks and describes MarkView custom 
packages and join points.

Kofax MarkView Release Notes
Use this document to learn what is new with the latest MarkView release, identify outstanding 
defects and workaround solutions where applicable, and learn which defects the release fixes.

Kofax MarkView Technical Specifications
Use this document to learn about supported operating systems and other system requirements.
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Getting help with Kofax products
The Kofax Knowledge Portal repository contains articles that are updated on a regular basis to 
keep you informed about Kofax products. We encourage you to use the Knowledge Portal to obtain 
answers to your product questions.

To access the Kofax Knowledge Portal, go to https://knowledge.kofax.com.

 The Kofax Knowledge Portal is optimized for use with Google Chrome, Mozilla Firefox, or 
Microsoft Edge.

The Kofax Knowledge Portal provides:
• Powerful search capabilities to help you quickly locate the information you need.

Type your search terms or phrase into the Search box, and then click the search icon.
• Product information, configuration details and documentation, including release news.

To locate articles, go to the Knowledge Portal home page and select the applicable Solution 
Family for your product, or click the View All Products button.

From the Knowledge Portal home page, you can:
• Access the Kofax Community (for all customers).

On the Resources menu, click the Community link.
• Access the Kofax Customer Portal (for eligible customers).

Go to the Support Portal Information page and click Log in to the Customer Portal.
• Access the Kofax Partner Portal (for eligible partners).

Go to the Support Portal Information page and click Log in to the Partner Portal.
• Access Kofax support commitments, lifecycle policies, electronic fulfillment details, and self-

service tools.
Go to the Support Details page and select the appropriate article.
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Chapter 1

Before you start

MarkView system requirements
The primary source of information about supported operating systems and other MarkView 
requirements is the Kofax MarkView Technical Specifications document which is available on the Kofax 
MarkView Product Documentation site.

Oracle patches
Oracle Accounts Payable processing requires Oracle patch 20725445:R12.AP.

If you plan to use the WebLogic application server with Oracle JDBC drivers version 12.1, apply 
Oracle patches 21043834, 20692348, and 19028811 on WebLogic. If you plan to use WebLogic with 
Oracle JDBC drivers version 11.2, verify that you use Oracle JDBC drivers 11.2.0.3 or higher.

See the Oracle website for more information.

WebLogic JDK for 64-bit WebLogic servers
The 32-bit versions of the WebLogic client come with a bundled JDK. For the 64-bit WebLogic client, 
you need a separate 64-bit JDK.

See the Oracle website for more information.

Complete the Kofax MarkView installation worksheet
The installation worksheet is a Microsoft Word document that helps you gather and record 
the information to upgrade and configure MarkView. Before you proceed, verify that you have 
completed all the applicable fields in the worksheet. Have the worksheet available as you upgrade.
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Upgrade paths

Upgrade from MarkView 5.x
To upgrade from MarkView 5.x, follow the instructions in the Kofax MarkView 7.1 Upgrade Guide
to run the MarkView installer. Do not perform any of the post-installation steps listed in the Kofax 
MarkView 7.1 Upgrade Guide. Do not upgrade the Oracle Forms.

To upgrade from MarkView 7.1, follow the instructions in the Kofax MarkView 8.2 Upgrade Guide
to run the MarkView installer. Do not perform any of the post-installation steps listed in the Kofax 
MarkView 8.2 Upgrade Guide. Do not upgrade the Oracle Forms.

Then, follow the instructions in this guide to upgrade from MarkView 8.2 to MarkView 10.5.0 and 
upgrade the Oracle Forms.

Upgrade from MarkView 6.x
To upgrade from MarkView 6.x, follow the instructions in the Kofax MarkView 8.2 Upgrade Guide
to run the MarkView installer. Do not perform any of the post-installation steps listed in the Kofax 
MarkView 8.2 Upgrade Guide. Do not upgrade the Oracle Forms.

Then, follow the instructions in this guide to upgrade from MarkView 8.2 to MarkView 10.5.0  and 
upgrade the Oracle Forms.

Upgrade from MarkView 7.x
To upgrade from MarkView 7.x, follow the instructions in the Kofax MarkView 8.2 Upgrade Guide
to run the MarkView installer. Do not perform any of the post-installation steps listed in the Kofax 
MarkView 8.2 Upgrade Guide. Do not upgrade the Oracle Forms.

Then, follow the instructions in this guide to upgrade from MarkView 8.2 to MarkView 10.5.0  and 
upgrade the Oracle Forms.

Upgrade from MarkView 8.0 and 8.1
To upgrade from MarkView 8.0 and 8.1, follow the instructions in the Kofax MarkView 8.2 Upgrade 
Guide to run the MarkView installer. Do not perform any of the post-installation steps listed in the
Kofax MarkView 8.2 Upgrade Guide. Do not upgrade the Oracle Forms.

Then, follow the instructions in this guide to upgrade from MarkView 8.2 to MarkView 10.5.0 and 
upgrade the Oracle Forms

Upgrade from MarkView 8.2
If you are upgrading from MarkView 8.2, upgrade the items listed in these tables.
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Product Components Upgrade Needed?

MarkView installer for Application Server 
and Database Components (KofaxMarkView-
<version_number>_Oracle.zip)

yes

MarkView installer for Oracle 
Objects (KofaxMarkView-
<version_number>_Oracle_Objects.zip)

yes

MarkView installer for Capture and 
Output Components (KofaxMarkView-
<version_number>_Сapture_Output.zip)

yes

MarkView Fax Server unsupported

MarkView Document Server Windows-only (Mail 
Gateway Server, Bar Code Server)

yes

MarkView Import Server yes

MarkView Data Export Server yes

Upgrade from MarkView 9.x
If you are upgrading from MarkView 9.x, upgrade the items listed in these tables.

Product Components Upgrade Needed?

MarkView installer for Application Server 
and Database Components (KofaxMarkView-
<version_number>_Oracle.zip)

yes

MarkView installer for Oracle 
Objects (KofaxMarkView-
<version_number>_Oracle_Objects.zip)

yes

MarkView installer for Capture and 
Output Components (KofaxMarkView-
<version_number>_Сapture_Output.zip)

yes

MarkView Fax Server unsupported

MarkView Document Server Windows-only (Mail 
Gateway Server, Bar Code Server)

yes

MarkView Import Server yes

MarkView Data Export Server yes

Upgrade from MarkView 10.x
If you are moving from MarkView 10.x, upgrade the items listed in these tables.

Product Components Upgrade Needed?

MarkView installer for Application Server 
and Database Components (KofaxMarkView-
<version_number>_Oracle.zip)

yes
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Product Components Upgrade Needed?

MarkView installer for Oracle 
Objects (KofaxMarkView-
<version_number>_Oracle_Objects.zip)

yes

MarkView installer for Capture and 
Output Components (KofaxMarkView-
<version_number>_Сapture_Output.zip)

yes

MarkView Document Server Windows-only (Mail 
Gateway Server, Bar Code Server)

yes

MarkView Import Server yes

MarkView Data Export Server yes

Upgrade checklist
Use this checklist to track the upgrade steps for your system.

Task Section Notes Done?

Prerequisites MarkView system requirements

Complete the Kofax MarkView 
installation worksheet

Download and decompress 
distribution files

Back up your MarkView schema

End MarkView items in process in 
the connector validation workflow

Set locale-sensitive environment 
variables

Configure schema user

(Optional) Uninstall Advisor If MarkView AP Advisor was 
previously installed on your 
system and you integrate with 
Oracle E-Business Suite 12.2, 
follow the steps in this section.

Empty the Oracle database recycle 
bin

(Optional) Complete in-process 
invoices for Self-Service Invoice

Follow the instructions in this 
section only if you have Self-
Service Invoice installed.

(Optional) Back up your files If you have updated your 
_CUSTOM packages, follow the 
steps in this section to back up 
your files.
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Task Section Notes Done?

(Optional) Back up the MarkView 
Kofax Transformation Modules 
project and batch classes

If your system includes Kofax 
Transformation Modules and 
you have modified your Kofax 
Transformation Modules 
project files, follow the steps in 
this section.

Upgrade Kofax Transformation 
Modules

Before you upgrade MarkView, 
make any planned upgrades 
to Kofax Transformation 
Modules.

Verify and
Upgrade

Either:
• To use the MarkView silent 

installer, see Silent verification 
and upgrade.

• To use the MarkView interactive 
mode, see:
• Verify your environment
• Upgrade MarkView

Set up Your Oracle 
Environment

Set up your environment and install 
MarkView Oracle Objects

Configure the 
Oracle Forms

Configure Oracle Forms

(Optional) Upgrade
Capture and 
Output modules 
to control how 
documents enter 
into and are 
output from the 
MarkView system.

Capture and Output modules Capture and Output 
components include:
• MarkView Bar Code Server
• MarkView Mail Gateway
• MarkView Import Server
• MarkView Data Export 

Server (for MarkView with 
Kofax Transformation 
Modules)

(Optional) 
Configure 
MarkView for 
Accounts Payable.

Configure MarkView for Accounts 
Payable

Follow the steps in this section 
if your system includes 
MarkView for Accounts 
Payable.

(Optional) 
Configure Self-
Service Invoice.

Configure Self-Service Invoice Follow the instructions in this 
section only if you have Self-
Service Invoice installed.

(Optional) 
Configure Oracle 
Forms

Configure Oracle Forms If you apply an Oracle 
Applications patch, 
update your Oracle Forms 
configuration. The specific 
updates depend on which 
patch you install.
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Task Section Notes Done?

(Optional) 
Integrate with 
other Kofax 
products.

Integration with other Kofax 
products

Follow the steps in this 
chapter to integrate with 
other Kofax products, such 
as Kofax Capture or Kofax 
Transformation Modules.

(Optional) Migrate 
Data

Migrate environments
Customization migration tools

If you are migrating your 
environment, review 
the information in these 
appendices.

 When upgrading Kofax MarkView, the existing Oracle personalizations get overwritten. To 
prevent data loss, back up your existing personalizations and after the upgrade is complete, 
restore the backup manually.

Download and decompress distribution files
Your Kofax representative will give you the location from which to download the compressed 
MarkView system setup files.

1. Log in to the application server host operating system as the application server owner.
2. Create a temporary distribution directory for the compressed MarkView installer and 

verification files. For example, <home_directory>/mvdist where <home_directory> is the 
user home directory.

3. In the distribution directory, create the following subdirectories:
• <distribution_directory>/verify

• <distribution_directory>/installer

Where <distribution_directory> is the name of the directory you just created.
4. Download the following file into the verify directory:

KofaxMarkView-<version_number>_Oracle_Verify.zip
5. Download the following file into the installer directory:

KofaxMarkView-<version_number>_Oracle.zip
6. Extract the files.

 The built-in ZIP utilities in certain versions of Windows have issues with lengthy directory 
paths. Kofax recommends using a third-party extraction utility to decompress the distribution 
files.
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Pre-upgrade tasks

Redefine c_MARKVIEW_TOP (Oracle EBS 12.2 only)

 Only follow the steps below if you upgraded to Oracle E-Business Suite 12.2.

Redefine the c_MARKVIEW_TOP environment variable:
1. Remove all the occurrences of c_MARKVIEW_TOP from FND_OAM_CONTEXT_CUSTOM table:

a. Log in to the database as the APPS user.

b. From the SQL prompt, run the following script:
delete from fnd_oam_context_custom where  
name = 'c_MARKVIEW_TOP' or name = 'C_MARKVIEW_TOP'; commit;

2. Remove all the occurrences of c_MARKVIEW_TOP from $CONTEXT_FILE XML file:

a. On the Oracle E-Business Suite server, open a command shell and log in as the Oracle E-
Business Suite owner. The default account for this user is applmgr.

b. To set the environment variables, source the run file system environment file.
For example, from a UNIX shell, run the following command:
$ source $APPL_TOP/../../../EBSapps.env run

c. Open $CONTEXT_FILE XML file and remove all the lines which contain ‘c_MARKVIEW_TOP’.
For example, remove the following line, if any:
<c_MARKVIEW_TOP oa_var="c_MARKVIEW_TOP" scope="CUSTOM" oa_type="PROD_TOP"
oa_enabled="FALSE">/appl01/apps/apps_st/appl/markview/12.0.0</c_MARKVIEW_TOP>

d. To set the environment variables, source the patch file system environment file.
For example, from a UNIX shell, run the following command:
$ source $APPL_TOP/../../../EBSapps.env patch

e. Open $CONTEXT_FILE XML file and remove all the lines which contain ‘c_MARKVIEW_TOP’.

f. To set the environment variables, source the run file system environment file.
For example, from a UNIX shell, run the following command:
$ source $APPL_TOP/../../../EBSapps.env run

3. Add the c_MARKVIEW_TOP environment variable to the $customfile custom environment files.

a. On the Oracle E-Business Suite server, open a command shell and log in as the Oracle E-
Business Suite owner. The default account for this user is applmgr.

b. To set the environment variables, source the run file system environment file.
For example, from a UNIX shell, run the following command:
$ source $APPL_TOP/../../../EBSapps.env run

c. Create the $customfile custom environment file (if it does not already exist).

d. Add the following lines to the end of the $customfile custom environment file:
export c_MARKVIEW_TOP=`dirname ${BASH_SOURCE[1]}`/markview/12.0.0 
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  export C_MARKVIEW_TOP=$c_MARKVIEW_TOP

e. To set the environment variables, source the patch file system environment file.
For example, from a UNIX shell, run the following command:
$ source $APPL_TOP/../../../EBSapps.env patch

f. Create the $customfile custom environment file (if it does not already exist).

g. Add the following lines to the end of the $customfile custom environment file:
export c_MARKVIEW_TOP=`dirname ${BASH_SOURCE[1]}`/markview/12.0.0 
  export C_MARKVIEW_TOP=$c_MARKVIEW_TOP

h. To set the environment variables, source the run file system environment file.
For example, from a UNIX shell, run the following command:
$ source $APPL_TOP/../../../EBSapps.env run

Back up your MarkView schema
Before you begin to upgrade, back up your MarkView schema. See the Kofax MarkView 
Administrator's Guide, Volume 1, for the information about backup strategies.

End MarkView components in process
Before you upgrade, stop all MarkView components, unless needed for the upgrade, including all 
Capture and Output services, as well as Capture and Kofax Transformation Modules services.

End MarkView items in process in the connector validation workflow
Before you upgrade, verify that no MarkView work items remain in process in the connector 
validation workflow. Run the following query against the MarkView database schema:
select wi.workitem_instance_id, q.queue_name 
  from sf_workitem_info wi, sf_queue_tab q, sf_workflow w
where w.workflow_name = 'Connector Validation v5.9.1.1' 
   and wi.workflow_id = w.workflow_id 
   and q.queue_id = wi.queue_id 
   and q.queue_name_unq in 
       ('Starting Point', 'Validate Entity', 'Populate Interface');

If the query returns work items, process those work items to an end queue before upgrading 
MarkView.

Set locale-sensitive environment variables
To avoid or resolve SQLExceptions that can occur with the MarkView verify or install program, adjust 
the locale settings on the application server.

The following is an example of an exception that may be logged in the installer log file when the 
verify or install program fails:
java.sql.SQLException: ORA-01403: no data found 
 ORA-06512: at "APPS.FND_DOC_CATEGORIES_PKG", line 345 
 ORA-06512: at line 68 
 ORA-06510: PL/SQL: unhandled user-defined exception
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Such exceptions can occur when the language setting in the session on the application server 
where the MarkView verify or install program executes does not match any language in the Oracle 
EBS tables (for example, FND_LOOKUP_VALUES). Ensure that the locale-sensitive environment 
variables in the session on the application server are set to the primary language used in the 
Oracle EBS tables. For example, if the primary language used in the EBS tables is en-GB, set the 
LANG environment variable on the application server to en-GB before you run the install or verify 
program.

Depending on the operating system of the application server, other locale-sensitive environment 
variables may be defined. Ensure that any of these variables that is defined is set to the EBS 
language:
• NLS_LANG
• LC_TYPE
• LC_TIME
• LC_MONETARY
• LC_NUMERIC
• LC_MESSAGES
• LC_COLLATE

Configure schema user
The MarkView schema user is the MarkView database administrator.

The scripts directory includes automated SQL scripts to help you configure the MarkView schema 
user. This directory may also include other scripts that you do not need to run. The steps in this 
section describe how to use each upgrade script.

The scripts directory is <distribution_directory>/installer/scripts (where
<distribution_directory> is the location where you downloaded and decompressed the 
installation files). The scripts directory includes:
• gencomp.sql (for installations and upgrades): Checks for invalid packages, recompiles objects and 

resolves dependencies between objects. You will use this script after you upgrade.
• markview_grant_privileges.sql (for installations and upgrades): Assigns grants and privileges to 

the MarkView schema user.

Assign grants and privileges to the MarkView schema user
If you upgrade from MarkView 8.1.x and earlier and integrate with Oracle E-Business Suite 12.2, skip 
this section and continue at Reconfigure MarkView for upgrades from MarkView 8.1.x and earlier 
(Oracle EBS 12.2 only). Perform the following procedure later according to the instructions.

The markview_grant_privileges.sql script assigns grants and privileges to the MarkView schema 
user. Do not modify this script.

1. Log in to the MarkView database as SYSDBA.
2. Navigate to <distribution_directory>\installer\scripts, where <distribution_directory> is the 

location where you downloaded and decompressed the installation files.
3. Run markview_grant_privileges.sql.
4. At the prompt, enter the MarkView schema user name.
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Historical data cleanup (optional)
The script cleanup_connector_history.sql is used to clean up the MarkView historical data if 
you want to reduce the length of time that the MarkView upgrade process takes. The script is 
located in the directory <distribution_directory>/installer/scripts/cleanup_historical_data (where 
<distribution_directory> is the location where you downloaded and decompressed the installation 
files).

Clean up the Connector historical data (optional)
Use cleanup_connector_history.sql to partially delete the Connector historical data imported from 
Kofax Transformation Modules to your MarkView environment if you want to reduce the length of 
time that the MarkView upgrade process takes. Do not modify this script.

 The connector data include the information about invoices imported from Kofax Capture/
Kofax Transformation Modules through the MarkView Connector subsystem. The MarkView 
Connector uses these records during the internal validation and before ERP export phase. Once 
the invoices are exported to the ERP, the records become historical. If the Connector fails to create 
invoices in the ERP, the records are used by MarkView Quick Invoices for the required corrections.

1. Grant read, write and execute permissions to the directory <distribution_directory>/ 
installer/scripts/cleanup_historical_data, where <distribution_directory> is the 
location where you downloaded and decompressed installation files.

2. Log in to the MarkView database as the MarkView schema user.
3. Navigate to <distribution_directory>/installer/scripts/

cleanup_historical_data.
4. Run cleanup_connector_history.sql.
5. At the output, check the total number of records in the connector tables.
6. At the prompt, enter the time period (in months), for which you would like to save the 

connector historical data and confirm the start of the cleanup.

If any errors occur, contact the system administrator.

Configure historical data migration period for upgrades from MarkView 
8.1.x and earlier (optional)

Skip this section if you upgrade from MarkView 8.2 and higher and continue to Empty the Oracle 
database recycle bin.

Skip this section if you are integrating MarkView with Oracle E-Business Suite 12.2 and continue to
Reconfigure MarkView for upgrades from MarkView 8.1.x and earlier (Oracle EBS 12.2 only).

The data migration includes moving of connector historical data imported from Kofax 
Transformation Modules to your MarkView environment. The following connector historical tables 
will be migrated: MVCN_ELEMENT, MVCN_STRUCTURE_MESSAGE.
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The length of time that the MarkView upgrade process takes depends on the number of months 
you want to migrate the data for (the default is 12 months). To configure the data transfer period, 
manually update the migration scripts. To shorten the upgrade process time, you may reduce the 
number of months to migrate the data for. Do not modify the files if you want to save the default 
value for the data transfer period or if you do not use Kofax Capture/Kofax Transformation Modules 
integration.

 The connector data include the information about invoices imported from Kofax Capture/
Kofax Transformation Modules through the MarkView Connector subsystem. The MarkView 
Connector uses these records during the internal validation and before ERP export phase. Once 
the invoices are exported to the ERP, the records become historical. If the Connector fails to create 
invoices in the ERP, the records are used by MarkView Quick Invoices for the required corrections.

1. In the <distribution_directory>/installer/modules/connector-dist-10.5.0/connector-db/patches/
scripts directory, open connector-1219-mvcnelement-migrate.sql for editing.

2. Locate the following string:
DEF_MONTH_NUMBER_TO_KEEP_DATA CONSTANT NUMBER := 12;

and change the default value 12 to the number of months for which you want to save the 
historical connector data of the MVCN_ELEMENT table.

3. In the <distribution_directory>/installer/modules/connector-dist-10.5.0/connector-db/patches/
scripts directory, open connector-1218-mvcnstructuremessage-migrate.sql for editing.

4. Locate the following string:
DEF_MONTH_NUMBER_TO_KEEP_DATA CONSTANT NUMBER := 12;

and change the default value 12 to the number of months for which you want to save the 
historical connector data of the MVCN_STRUCTURE_MESSAGE table.

Reconfigure MarkView for upgrades from MarkView 8.1.x and earlier 
(Oracle EBS 12.2 only)

Skip this section if you are integrating MarkView with Oracle E-Business Suite 12.1 or earlier Empty 
the Oracle database recycle bin.

Skip this section if you upgrade from MarkView 8.2 and higher and continue at Uninstall Advisor.

The scripts used to repair the MarkView schema after Oracle EBS 12.2 installation are located in 
the directory <distribution_directory>/installer/scripts/repair_mv_schema_on_EBS12_2 (where 
<distribution_directory> is the location where you downloaded and decompressed the installation 
files). The scripts directory includes:
• migrate_connector_tables.sql (for upgrades): Transforms connector tables and migrates data;
• schema_correction.sql (for upgrades): Corrects MarkView schema changes after upgrading to 

Oracle E-Business Suite 12.2.

Transform connector tables and migrate data
The following steps apply only after upgrading to Oracle E-Business Suite 12.2. Use 
migrate_connector_tables.sql to migrate connector data. Do not modify this script.
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The data migration includes moving of connector historical data imported from Kofax 
Transformation Modules to your MarkView environment. The following connector historical tables 
will be migrated: MVCN_ELEMENT, MVCN_STRUCTURE_MESSAGE.

The length of time that the MarkView upgrade process takes depends on the number of months 
you want to migrate the data for (the default is 12 months). To configure the data transfer period, at 
the prompt enter the number of months for which you would like to keep the connector historical 
data.

 The length of time that running the connector data migration process takes depends on the 
amount of data imported from Kofax Transformation Modules to your MarkView environment and 
the speed of your system processors. To track the progress, use DBA Oracle tools, for example, 
system view v$session_longops.

1. Grant read, write and execute permissions to the directory <distribution_directory>/installer/
scripts/repair_mv_schema_on_EBS12_2 , where <distribution_directory> is the location where 
you downloaded and decompressed installation files.

2. Grant read permissions to the directory <distribution_directory>/installer/modules/connector-
dist-х.х.х/connector-db/patches/scripts, where <distribution_directory> is the location where 
you downloaded and decompressed installation files and x.x.x is the product version number.

3. Log in to the MarkView database as the MarkView schema user.
4. Navigate to <distribution_directory>/installer/scripts/repair_mv_schema_on_EBS12_2.
5. Run migrate_connector_tables.sql.
6. At the prompt, enter the MarkView data tablespace and index tablespace names.
7. At the prompt, enter the number of months for which you would like to keep the connector 

historical data.

If any errors occur, contact the system administrator.

Correct the MarkView schema
The following steps apply only after upgrading to Oracle E-Business Suite 12.2. Use 
schema_correction.sql to correct the MarkView schema after upgrading to Oracle EBS 12.2. Do not 
modify this script.

1. Grant read, write and execute permissions to the directory <distribution_directory>/installer/
scripts/repair_mv_schema_on_EBS12_2 , where <distribution_directory> is the location where 
you downloaded and decompressed installation files.

2. Grant read permissions to the directory <distribution_directory>/installer/modules/connector-
dist-x.x.x/connector-db/schema/types, where <distribution_directory> is the location where you 
downloaded and decompressed installation files and x.x.x is the product version number.

3. Log in to the MarkView database as the MarkView schema user.
4. Navigate to <distribution_directory>/installer/scripts/repair_mv_schema_on_EBS12_2.
5. Run schema_correction.sql.

Enable editions (for Oracle EBS 12.2 only)
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Use enable_editions.sql to make the MarkView schema editionable. Do not modify this script.
1. Verify that the upgrade to Oracle E-Business Suite 12.2 is completed.
2. Log in to the MarkView database as SYSDBA.
3. Navigate to <distribution_directory>\installer\scripts, where

<distribution_directory> is the location where you downloaded and decompressed the 
installation files.

4. Run enable_editions.sql.
5. At the system prompt for the user name, enter the MarkView database schema name, for 

example, markview.

Assign grants and privileges to the MarkView schema user
The markview_grant_privileges.sql script assigns grants and privileges to the schema user. Do not 
modify this script.

1. Log in to the MarkView database as SYSDBA.
2. Navigate to <distribution_directory>\installer\scripts, where

<distribution_directory> is the location where you downloaded and decompressed the 
installation files.

3. Run markview_grant_privileges.sql.
4. At the prompt, enter the MarkView schema user name.

Recreate grants and synonyms
The following steps apply only after upgrading to Oracle E-Business Suite 12.2.

1. Log in to SQL*Plus and set the working directory to modules/erp-integration-oracle-dist-
x.x.x/oracle-toolkit/sql/schema/grants_synonyms  where x.x.x is the product version 
number.

2. At the SQL prompt, run the script @mvoa_create_grants_synonyms.sql.
3. Follow the prompts to enter the MarkView and Apps schema information.
4. When prompted for the Oracle E-Business Suite version, enter 11.5 (select this version for 

Oracle EBS R12 and 12.2).

 When granting access on FND_DOCUMENTS, FND_DOCUMENTS_TL, AP_TAX_DEFAULT_PKG, 
AP_TAX_RECOVERY_PKG to MarkView, error messages may appear. This is expected behavior. The 
error messages can be ignored.

Recompile invalid objects after upgrading to Oracle E-Business Suite 
12.2

1. Log in as the MarkView database user.
2. In <distribution_directory>\installer\scripts, where <distribution_directory> is the location 

where you downloaded and decompressed the installation files run @gencomp.sql.
You should see a message similar to the following:
Recursively compiling 2 object(s).
Please wait...

23



Kofax MarkView Upgrade Guide for Oracle E-Business Suite

 INVALID objects with compilation errors may appear. This is expected behavior.

Uninstall Advisor
Skip this section if you do not have MarkView AP Advisor.

Kofax MarkView 9.1 and higher does not support Advisor.

Delete MarkView synonyms for Advisor (Oracle EBS 12.2 only)
If you integrate MarkView with Oracle E-Business Suite 12.1 or earlier, skip this section.

1. Log in as the MarkView database user.
2. Navigate to <distribution_directory>\installer\scripts, where

<distribution_directory> is the location where you downloaded and decompressed the 
installation files.

3. Run synonym_drop_in_all_editions.sql and when prompted enter the MarkView schema user 
name and MarkView database logging directory name.
The synonym_drop_in_all_editions.sql script creates synonym_drop_in_all_editions_autogen.sql 
in the MarkView database logging directory.
For information about the MarkView database logging directory, see the Kofax MarkView 
Installation Guide.

4. Log in to the MarkView database as SYSDBA.
5. Navigate to the MarkView database logging directory and run 

synonym_drop_in_all_editions_autogen.sql to drop synonyms that connect the MarkView and 
Advisor user schemas in database editions.
Do not modify this script.

Uninstall Advisor from MarkView
Before you upgrade MarkView, uninstall Advisor.

1. Log in to the WebLogic ro WildFly Server Administration Console.
2. On the Deployments tab, select and delete the following Advisor deployments:

• analytics-core
• analytics-actionable
• analytics-markview

3. Delete analytics JMS queues from the Web server.
• For the WebLogic users:

a. In the Domain Structure section, navigate to Services > Messaging > JMS Modules.

b. Click MarkViewJmsModule.

c. Click MarkViewForeignServer.

d. On the Destinations tab, select and delete the following queues:
• MV_ADVISOR_HOTSYNC_Q
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• MV_ADVISOR_HS_Q
• MV_ADVISOR_RLTIME_Q
• MV_ADVISOR_RT_Q

• For the WildFly users:

a. On the Configuration tab, select Subsystems.

b. Navigate to Messaging > Destinations and in Available Messaging Provider, select 
the provider.

c. In Option, click View and delete the following queues:
• MV_ADVISOR_HOTSYNC_Q
• MV_ADVISOR_HS_Q
• MV_ADVISOR_RLTIME_Q
• MV_ADVISOR_RT_Q

4. Log in as the MarkView database user and run <distribution_directory>\installer
\scripts\remove_advisor.sql to uninstall the Advisor queue tables, where
<distribution_directory> is the location where you downloaded and decompressed the 
installation files.

5. Delete AnalyticsDataSource from the Web server:
• For the WebLogic users: Navigate to Services > Data Sources > AnalyticsDataSource and 

click Delete.
• For the WildFly users: Navigate to Configuration > Datasources > AnalyticsDataSource

and click Remove.
6. To delete the Advisor schema and tablespaces:

a. Stop the MarkView application server.

b. Log in to the MarkView database as SYSDBA and run the following SQL commands:
drop user <AdvisorSchema> cascade;
drop tablespace <AdvisorDataTablespace> including contents and datafiles;
drop tablespace <AdvisorIndexTablespace> including contents and datafiles;

Where <AdvisorSchema> is the user name of the Advisor schema user,
<AdvisorDataTablespace> is the data tablespace for Advisor, and
<AdvisorIndexTablespace> is the index tablespace for Advisor.

c. Start the MarkView application server.
7. In MarkView Admin, delete the ADVSYS user.
8. Log in as the MarkView database user and run <distribution_directory>\installer

\scripts\gencomp.sql to recompile objects, where <distribution_directory> is the 
location where you downloaded and decompressed the installation files.

Empty the Oracle database recycle bin
Empty the Oracle database recycle bin prior to installing MarkView.

1. Log in as the MarkView schema owner.
2. Run select count(*) from recyclebin; to determine whether objects exist in the recycle 

bin:
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3. If the results return a count larger than zero, run purge user_recyclebin;.
The system displays a message that the recycle bin is purged.

4. Verify that the recycle bin is empty. The result should look like:
SQL>select count(*) from recyclebin;
COUNT(*)
_________
0

Add SSL certificate to Oracle Wallet (for SSL only)
Skip this section if you do not plan to use Secure Sockets Layer (SSL) to provide secure web 
communications for the application server.

1. Log in to the Oracle EBS server as the EBS user.
2. If you do not have an Oracle Wallet, from the command line, run the following command to 

create Oracle Wallet and set the Oracle Wallet location:
orapki wallet create -wallet <WalletFolder> -pwd <WalletPasswd> -auto_login

3. Add the SSL certificate to the Oracle Wallet:
orapki wallet add -wallet <WalletFolder> -trusted_cert -cert "<certificate>" -pwd 
 <WalletPasswd>

Where:
• <WalletFolder> is a directory where Oracle Wallet files are located.
• <certificate> is a file that contains the self-signed certificate or any other certificate 

received from the certificate authority.
If you have a certificate received from the certificate authority, verify that root and 
intermediate certificates from the certification chain are in the Oracle Wallet and run the 
indicated command to add the missing certificates.

• <WalletPasswd> is a password for the Oracle Wallet.

Add SSL certificate to the RDBMS Java truststore (for SSL only)
Skip this section if you do not plan to use SSL to provide secure web communications for the 
application server.

1. Log in to the RDBMS as SYSDBA.
2. Run the following SQL command to get the <java_home> value:

SELECT  dbms_java.get_ojvm_property(PROPSTRING=>'java.home') FROM dual

3. From the command line, run the following command to add the certificate to the RDBMS Java 
truststore:
keytool -import -alias <alias> -keystore <java_home>/jre/lib/security/cacerts -
file <certificate>

Where:
• <alias> is a keystore entry unique name.
• <java_home> is a Java installation directory.
• <certificate> is a file that contains the self-signed certificate or any other certificate 

received from the certificate authority.
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If you have a certificate received from the certificate authority, verify that root and 
intermediate certificates from the certification chain are in the RDBMS Java truststore and 
run the indicated command to add the missing certificates.

The default Java certificate authority keystore is cacerts. The default password for cacerts is
<changeit>.

4. If you use Oracle EBS 19c database with SSL, perform the following procedure.

a. Check if <java_home>/jdk/jdk8/lib/security/ contains the cacerts.alt file. If the 
file exists, add a certificate to the cacerts.alt file as follows:
keytool -importcert -trustcacerts -keystore <java_home>/jdk/jdk8/lib/
security/cacerts.alt -storepass <password> -file <certificate> -alias 
<alias>

Where:
• <alias> is a keystore entry unique name.
• <certificate> is a file that contains the self-signed certificate or any other certificate 

received from the certificate authority.
If you have a certificate received from the certificate authority, verify that root and 
intermediate certificates from the certification chain are in the RDBMS Java truststore.

• <password> is a password. The default password for cacerts is <changeit>.

b. If the file does not exist, copy the cacerts file created on step 3 to <java_home>/jdk/
jdk8/lib/security/ and rename it to cacerts.alt.

c. Log in to the RDBMS as SYSDBA.

d. If you use a pluggable database, switch to the PDB where the MarkView schema resides.

e. Run the following command to add the cacert.alt file to the RDBMS:
exec dbms_java.loadjava('-schema SYS -grant PUBLIC -dirprefix 
<java_home>/jdk/jdk8 <java_home>/jdk/jdk8/lib/security/cacerts.alt');

Complete in-process invoices for Self-Service Invoice
If you have Self-Service Invoice installed, complete all in-process invoices before you upgrade 
MarkView.

To find in-process invoices, log in to the MarkView database as the MarkView schema user and run:
select *
from sf_workitem_info wi, sf_queue_tab q
where wi.workflow_id in
(select workflow_id
from sf_workflow
where workflow_name = 'Self-Service Invoice')
and q.queue_id = wi.queue_id
and q.queue_name_unq not in
('Completed',
'Error Queue',
'Cancelled Requests')

If the query returns work items, process those work items to an end queue before upgrading 
MarkView.
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Back up your files

Back up _CUSTOM packages
The _CUSTOM packages contain functionality and scripting that is unique to an installation of 
MarkView database objects.

Back up all _CUSTOM packages and store a copy of the SQL script files that create the current 
version of your _CUSTOM packages.

To extract the current version of your _CUSTOM packages from the database, use the tool 
associated with Extracting custom package bodies from your MarkView schema.

See the Kofax MarkView Administrator's Guide, Volume 2 for more information about _CUSTOM 
packages.

Back up the MarkView Kofax Transformation Modules project and batch 
classes

If your system includes Kofax Transformation Modules, copy your customized MarkView Kofax 
Transformation Modules project files and batch classes to a safe location before you upgrade. When 
you upgrade, MarkView automatically installs a new MarkView Kofax Transformation Modules 
project in C:\KTM\Markview.

After you upgrade, refer to your customized MarkView Kofax Transformation Modules project files 
and batch classes, manually edit the new MarkView Kofax Transformation Modules project files and 
batch classes, and save them in your runtime directory, for example C:\KTM\Markview\MyProject.

Back up XSLT files
If you have any customizations of the following XSLT files used by MVImportAPIConfig, back up 
these XSLT files:
• KofaxCapture82Generic.xslt
• KofaxCapture82ImportServer.xslt
• KofaxCapture82Parse.xslt

Upgrade Kofax Transformation Modules
If you plan to upgrade Kofax Transformation Modules, do it before you upgrade MarkView. Follow 
the instructions in the Kofax Transformation Modules Upgrade guide.

Move to a new application server during MarkView upgrade
During MarkView upgrade, you can move from your current application server to a new application 
server.
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Skip this section if you plan to upgrade MarkView on your current application server.
1. Stop your current application server.
2. (Optional) If you plan to use SSL to provide secure web communications for your new 

application server, follow the steps in Create the certificate keystore (for SSL only).
3. Install and configure the environment.

• For WebLogic, follow the steps in Configure the WebLogic environment on page 29.

• For WildFly or JBoss EAP, follow the steps in Configure WildFly or JBoss EAP environments
on page 34.

Create the certificate keystore (for SSL only)
Skip this section if you are not using SSL.

Run one of the following commands to create the certificate keystore:
• If you have a self-signed certificate for the application server, import the certificate to the JKS 

format keystore:
keytool -import -v -alias selfsigned -file <certificate> -keystore <keystore> -
storepass <keystorepassword>

• If you have any other certificate received from the certificate authority, import the certificate to 
the JKS format keystore:
keytool -importkeystore -srckeystore <certificate> -srcstoretype pkcs12 -
destkeystore <keystore> -deststoretype JKS -storepass <keystorepassword>

Where:
• <certificate> is a file that contains the self-signed certificate or any other certificate received 

from the certificate authority.
• <keystore> is a repository that contains your security certificate or certificates.
• <keystorepassword> is a password of the keystore.

Configure the WebLogic environment
If you plan to use the WildFly or JBoss EAP application servers, skip this section and continue with
Configure WildFly or JBoss EAP environments on page 34.

Before you proceed, verify that your system meets the MarkView system requirements.

Configure environment variables for WebLogic
Configure the environment variables for your WebLogic application server.

Set WL_HOME, MW_HOME, and ORACLE_HOME to your WebLogic installation directory. Set the 
JAVA_HOME variable and point it to the Java SDK installation directory.

For WebLogic 12.1 only, run the installation configuration script to configure the WebLogic 
installation:

1. Run the installation configuration script.
• Windows: %MW_HOME%\configure.cmd
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• UNIX: $MW_HOME/configure.sh
2. When prompted if you want to configure a new domain, enter N and press Enter to complete 

the configuration.

Set up memory properties
For UNIX:

1. In <markview_domain>/bin/startWebLogic.sh, locate the following strings:
# Call setDomainEnv here.
DOMAIN_HOME=

2. Immediately before these strings, add the command to set the USER_MEM_ARGS parameter or 
replace the existing command with the following:
USER_MEM_ARGS="-Xms8g -Xmx8g -XX:CompileThreshold=8000 -XX:MetaspaceSize=1g -
XX:MaxMetaspaceSize=2g -Djava.net.preferIPv4Stack=true" export USER_MEM_ARGS

3. Log in to the WebLogic Server Administration Console.
4. Go to Environment > Servers.
5. On the list of servers, click AdminServer and go to Configuration > Server Start tab.
6. In the Arguments field, remove the following arguments, if any:

-Xms1024m -Xmx1400m -XX:CompileThreshold=8000 -XX:MetaspaceSize=128m -
XX:MaxMetaspaceSize=256m

The values for your environment may differ.

 Do not remove other arguments in order for MarkView to function correctly.

7. Restart WebLogic.

For Windows:
On Windows, select one of the following procedures to set up the memory properties for the 
WebLogic application:
• Use the command line start script
• Use Windows Service

Use the command line start script
1. In <markview_domain>\bin\startWebLogic.cmd, locate the following strings:

@REM Call setDomainEnv here. 
        set DOMAIN_HOME=

2. Immediately before these strings, add the command to set the USER_MEM_ARGS parameter:
set USER_MEM_ARGS=-Xms8g -Xmx8g -XX:CompileThreshold=8000 -XX:MetaspaceSize=1g -
XX:MaxMetaspaceSize=2g

3. Log in to the WebLogic Server Administration Console.
4. Go to Environment > Servers.
5. On the list of servers, click AdminServer and go to Configuration > Server Start tab.
6. In the Arguments field, remove the following arguments, if any:

-Xms1024m -Xmx1400m -XX:CompileThreshold=8000 -XX:MetaspaceSize=128m -
XX:MaxMetaspaceSize=256m
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The values for your environment may differ.

 Do not remove other arguments in order for MarkView to function correctly.

7. Restart WebLogic.

Use Windows Service
1. Log in to the WebLogic Server Administration Console.
2. Go to Environment > Servers.
3. On the list of servers, click AdminServer and go to Configuration > Server Start tab.
4. In the Arguments field, remove the following arguments, if any:

-Xms1024m -Xmx1400m -XX:CompileThreshold=8000 -XX:MetaspaceSize=128m -
XX:MaxMetaspaceSize=256m

The values for your environment may differ.

 Do not remove other arguments in order for MarkView to function correctly.

5. Select one of the following options to set up the memory properties:
• Uninstall your current WebLogic Windows Service and before creating your new WebLogic 

Windows Service, verify that the following parameter is set up correctly in the start script:
set USER_MEM_ARGS=-Xms8g -Xmx8g -XX:CompileThreshold=8000 -XX:MetaspaceSize=1g -
XX:MaxMetaspaceSize=2g

• Back up your current version of the Windows Registry and update the
HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\services\<WebLogic_Service_name>
\Parameters\CmdLine key that contains memory options for your service as follows:
-server -Xms8g -Xmx8g -XX:CompileThreshold=8000 -XX:MetaspaceSize=1g -
XX:MaxMetaspaceSize=2g

Verify the JDK version and Java virtual machine availability for WebLogic
For the Java JDK version supported, see the Kofax MarkView Technical Specifications document on the
Kofax MarkView Product Documentation site.

To check the JDK version, and if necessary, add Java to your path:
1. In the JDK installation directory, open the bin directory.
2. Run java -version to verify the installed JDK version.
3. Set JAVA_HOME to the JDK installation directory.
4. Add JAVA_HOME/bin to your path.

JDBC driver version (for WebLogic 12.1.3)
Before you proceed, to verify that you use the appropriate JDBC driver version compatible with 
your environment, see the Kofax MarkView Technical Specifications document on the Kofax MarkView 
Product Documentation site.
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Replace the JDBC driver version 12.1.0.1 with the recommended version.
1. Download the JDBC driver from the Oracle website.
2. Stop the WebLogic servers.
3. Navigate to $MW_HOME/oracle_common/modules/oracle.jdbc_12.1.0 and make a backup 

copy of the existing JDBC driver.
4. Copy the recommended JDBC driver version to:

$MW_HOME/oracle_common/modules/oracle.jdbc_12.1.0

5. Restart the WebLogic servers.

Configure SSL for WebLogic 12c (for SSL only)
Skip this section if you are not using SSL.

1. Log in to the WebLogic Server Administration Console using a non-SSL port.
2. Go to Environment > Servers.
3. On the list of servers, click the administration server to configure and go to Configuration >

Keystores tab.
4. If you are on the production mode, click Lock & Edit.

a. In the Keystores field, click Change and select Custom Identity and Custom Trust.
Click Save.

b. In the Identity section, enter the required identity information such as:
• Custom Identity Keystore: <keystore>
• Custom Identity Keystore Type: JKS
• Custom Identity Keystore Passphrase: <keystorepassword>
• Confirm Custom Identity Keystore Passphrase: <keystorepassword>

Where:
• <keystore> is a certificate repository that you created or imported in Create the 

certificate keystore (for SSL only).
• <keystorepassword> is a password of the keystore.

c. In the Trust section, enter the required trust information such as:
• Custom Identity Keystore: <truststore>
• Custom Identity Keystore Type: JKS
• Custom Identity Keystore Passphrase: <truststorepassword>
• Confirm Custom Identity Keystore Passphrase: <truststorepassword>

Where:
• <truststore> is a repository that contains a trusted certificate or certificates.
• <truststorepassword> is a password of the truststore.

d. Click Save.
5. Click the SSL tab, enter the required information and save changes:

• Private Key Alias: <alias>
• Private Key Passphrase: <keypassphrase>
• Confirm Private Key Passphrase: <keypassphrase>
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Where:
• <alias> is a keystore entry unique name.
• <keypassphrase> is a password of the certificate.

6. Click the General tab, clear Listen Port Enabled and select SSL Listen Port Enabled.
Click Save.

7. If you are on the production mode, click Activate Changes.
8. Restart the Node Manager and the WebLogic application server.

Set up Node Manager (for SSL only)
1. Open <markview_domain>/nodemanager.properties for editing.
2. Enter the following information:

KeyStores=CustomIdentityAndCustomTrust
CustomIdentityKeystoreType=jks
CustomIdentityKeyStoreFileName=<keystore>
CustomIdentityKeyStorePassPhrase=<keystorepassword>
CustomIdentityPrivateKeyPassPhrase=<keypassphrase>
CustomIdentityAlias=<alias>
CustomTrustKeystoreType=jks
CustomTrustKeyStoreFileName=<truststore>
CustomTrustKeyStorePassPhrase=<truststorepassword>

3. Restart the Node Manager and the WebLogic application server.

Enable secure session cookies (for SSL only)
To enable MarkView to securely work over SSL, enable the cookie-secure flag by modifying 
the weblogic.xml file. The weblogic.xml file is located in the \WEB-INF directories on all web 
applications. You must perform the following procedure for all weblogic.xml files within the 
specified path.

1. In the <installation_directory>\applications\<ear_file>\<war_file>\WEB-INF
directories, locate the weblogic.xml file.
• <installation_directory>: MarkView installation directory.
• <ear_file>: All .ear files located in the MarkView installation directory.
• <war_file>: All .war files located within the .ear file.

2. In weblogic.xml, locate the <session-descriptor> element.
3. Add the <cookie-secure>true</cookie-secure> tag inside the <session-descriptor>

element and save the file.

Disable WebLogic basic authentication
1. Log in to the WebLogic host as the WebLogic owner.
2. Open the domain configuration file, which is located in the directory specified when you 

created the domain, for example:
/<WL_home>/../user_projects/domains/<markview domain>/config/config.xml

3. Add the following XML code immediately before the close tag for the security configuration:
<enforce-valid-basic-auth-credentials>false  
</enforce-valid-basic-auth-credentials>

4. Restart the server.
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Exclude conflicting libraries (WebLogic 12.2 only)
1. Locate the file:

<WL_HOME>/modules/com.oracle.weblogic.security.opensaml2.jar

The WL_HOME environment variable points to the directory where you installed the WebLogic 
server.

2. Change the file name, or back up and remove the file.
3. If you need to apply a patch on the WebLogic server after the preceding procedure, perform 

the following steps:

a. Restore the file <WL_HOME>/modules/
com.oracle.weblogic.security.opensaml2.jar.

b. Apply the WebLogic patch.

c. Change the file name, or back up and remove the file.

Verify that WebLogic components are running
Verify that the NodeManager is running on every platform and that the WebLogic user has the 
permissions required for access.

1. Log in to the WebLogic Server Administration Console.
2. Go to Environment > Machines and click markview_machine.
3. On the Monitoring tab, verify that Status is Reachable.

Set up Java Options for WebLogic on AIX
Skip this section, if you do not use AIX platform.

1. Log in to the WebLogic Server Administration Console.
2. Go to Environment > Servers.
3. On the list of servers, click markview_server and go to Configuration > Server Start tab.
4. In the Arguments field, add the following to the end of the line:

-XX:+PositiveIdentityHash -XX:-IgnoreUnrecognizedVMOptions -XX:
+UnlockExperimentalVMOptions

5. Restart markview_server.

Configure WildFly or JBoss EAP environments
Kofax MarkView supports the WildFly application server, formerly known as JBoss, and JBoss 
Enterprise Application Platform, known as JBoss EAP.

The MarkView installer has the option to install and configure Wildfly as part of the MarkView 
installation process, so that you do not need to install WildFly before running the MarkView installer. 
Alternatively, you can manually install and configure the WildFly environment.

Kofax MarkView supports MarkView installation on the WildFly application server and JBoss EAP in 
both standalone mode and domain mode.
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 The WildFly application server in the silent-mode installation files is referred to as JBoss.

Skip this section, if you plan to use the MarkView installer to install and configure WildFly.

For information about downloading and installing both the WildFly and JBoss EAP application 
servers, see the corresponding documentation on the WildFly website.

Complete the following procedures to configure the JBoss EAP environment or to manually set up 
WildFly.
• Configure environment variables on page 35.
• Set up memory properties (standalone mode only) on page 35.
• Set up memory properties (domain mode only) on page 36.
• Create WildFly or JBoss EAP users on page 37.
• Configure ports and hosts on page 37.
• Start WildFly or JBoss EAP application servers on page 38.
• Configure SSL for WildFly and JBoss EAP (for SSL only) on page 39.
• Create a new WildFly or JBoss EAP server for the MarkView instance (domain mode only) on page

42 .
• Set up Java Options for WildFly or JBoss EAP (standalone mode only) on AIX on page 43.
• Set up Java Options for WildFly or JBoss EAP (domain mode only) on AIX on page 43.

Install WildFly or JBoss EAP
1. Download the WildFly or JBoss EAP server from the WildFly website.
2. Extract the downloaded ZIP file to JBOSS_HOME,

where JBOSS_HOME is the WildFly or JBoss EAP installation directory.

Configure environment variables
Configure the environment variables for your WildFly or JBoss EAP application servers. Set 
JBOSS_HOME to your WildFly or JBoss EAP installation directory and ensure that the JBOSS_HOME 
environment variable persists with the shell profile, such as export JBOSS_HOME=<drive&path>/
wildfly.

For more information about setting JBOSS_HOME for UNIX or Windows, see the installation guide 
on the WildFly website.

Set up memory properties (standalone mode only)
Skip this section if you configure the WildFly or JBoss EAP application servers in domain mode.

For UNIX:
1. For standalone mode, open JBOSS_HOME/bin/standalone.conf for editing.
2. Locate the string similar to the following:

JBOSS_JAVA_SIZING="-Xms64m -Xmx512m -XX:MetaspaceSize=96M -
XX:MaxMetaspaceSize=256m"
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Change the string to:
JBOSS_JAVA_SIZING="-Xms8g -Xmx8g -XX:CompileThreshold=8000 -XX:MetaspaceSize=1g -
XX:MaxMetaspaceSize=2g"

 This command must be run on a single line. If you cut and paste from this guide, remove 
any line breaks.

For Windows:
1. For standalone mode, open JBOSS_HOME\bin\standalone.conf.bat for editing.
2. Locate the following string:

set "JBOSS_JAVA_SIZING=-Xms64M -Xmx512M -XX:MaxMetaspaceSize=256m"

Change the string to:
set "JBOSS_JAVA_SIZING=-Xms8g -Xmx8g -XX:CompileThreshold=8000 -
XX:MetaspaceSize=1g -XX:MaxMetaspaceSize=2g"

 This command must be run on a single line. If you cut and paste from this guide, remove 
any line breaks.

Set up memory properties (domain mode only)
Skip this section if you configure the WildFly or JBoss EAP application servers in standalone mode.

For UNIX:
1. For domain mode, open JBOSS_HOME/bin/domain.conf for editing.
2. Locate the string similar to the following:

JBOSS_JAVA_SIZING="-Xms64m -Xmx512m -XX:MetaspaceSize=96M -
XX:MaxMetaspaceSize=256m"

Change the string to:
JBOSS_JAVA_SIZING="-Xms2g -Xmx2g -XX:CompileThreshold=8000 -XX:MetaspaceSize=1g -
XX:MaxMetaspaceSize=2g"

 This command must be run on a single line. If you cut and paste from this guide, remove 
any line breaks.

For Windows:
1. For domain mode, open JBOSS_HOME\bin\domain.conf.bat for editing.
2. Locate the following string:

set "JBOSS_JAVA_SIZING=-Xms64M -Xmx512M -XX:MaxMetaspaceSize=256m"

Change the string to:
set "JBOSS_JAVA_SIZING=-Xms2g -Xmx2g -XX:CompileThreshold=8000 -
XX:MetaspaceSize=1g -XX:MaxMetaspaceSize=2g"
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 This command must be run on a single line. If you cut and paste from this guide, remove 
any line breaks.

For Unix and Windows:
1. Log in to WildFly or JBoss EAP Administration Console.
2. On the Runtime tab, select Server Groups.
3. On the Server Group menu, select Server Group Name.
4. In the Server Group Name box, click the View button.
5. On the left pane, select JVMs, and add a new JVM configuration.
6. Click Edit, and set the following memory properties for your application server. Suggested 

values are:

a. Heap Size to
8g

b. JVM Options to
-XX:MetaspaceSize=1g

-XX:MaxMetaspaceSize=2g

7. Click Save.

Create WildFly or JBoss EAP users
1. Navigate to JBOSS_HOME\bin.
2. Run either:

• Windows: add-user.bat
• UNIX: add-user.sh

For more information about creating both the WildFly and JBoss EAP users, see the administrator's 
guide on the WildFly website.

Configure ports and hosts
The configuration process varies depending on the mode you use for running the application 
server.

1. For standalone mode: In JBOSS_HOME\standalone\configuration, do the following:

a. Rename standalone.xml to standalone_old.xml.

b. Rename standalone-full.xml to standalone.xml.

c. Open standalone.xml for editing and do the following to configure the host on the 
server:
• Locate <inet-address 
value="${jboss.bind.address.management:127.0.0.1}"/> and change the 
default value 127.0.0.1 to the appropriate host name.

• Locate <inet-address value="${jboss.bind.address:127.0.0.1}"/> and 
change the default value 127.0.0.1 to the appropriate host name.
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d. In stanalone.xml, locate the following string to configure the admin port on the server:
<socket-binding name="management-http" interface="management" 
port="${jboss.management.http.port:9990}"/>

Change the default value 9990 to the appropriate port value.

e. In standalone.xml, locate the following string to configure the HTTP port on the server:
<socket-binding name="http" port="${jboss.http.port:8080}"/>

Change the default value 8080 to the appropriate port value.
2. For domain mode: In JBOSS_HOME\domain\configuration, do the following:

a. Open host.xml for editing and do the following to configure the host on the server:
• Locate <inet-address 
value="${jboss.bind.address.management:127.0.0.1}"/> and change the 
default value 127.0.0.1 to the appropriate host name.

• Locate <inet-address value="${jboss.bind.address:127.0.0.1}"/> and 
change the default value 127.0.0.1 to the appropriate host name.

b. In host.xml, locate the following string to configure the port:
<socket interface="management" 
port="${jboss.management.http.port:9990}"/>

Change the default value 9990 to the appropriate port value.

c. In domain.xml, configure the HTTP port on the server:
• In the <socket-binding-groups> section, locate socket binding group with the 

name of your MarkView profile, such as <socket-binding-group name="full-ha-
sockets" default-interface="public">

• In <socket-binding name="http" port="8080"/>, change the default value 8080
to the appropriate port value.

Start WildFly or JBoss EAP application servers
Start the WildFly or JBoss EAP application servers in standalone or domain modes. For more 
information about the operating modes, see the WildFly website.

If the JBoss EAP or WildFly application servers fail to start, check the application server log file 
for TimeoutException. For JBoss EAP and WildFly, the timeout parameter default value is 300. To 
increase the timeout parameter, add the blocking.timeout Java option:

1. Open the file for your configuration:
• Standalone mode: bin/standalone.conf.bat or bin/standalone.conf.
• Domain mode: bin/domain.conf.bat or bin/domain.conf.

2. Add the following line:
• For Windows: set "JAVA_OPTS=%JAVA_OPTS% -
Djboss.as.management.blocking.timeout=600"

• For Unix: JAVA_OPTS="$JAVA_OPTS -Djboss.as.management.blocking.timeout=600"
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Configure SSL for WildFly and JBoss EAP (for SSL only)
Skip this section if you are not using SSL.

Select one of the following procedures depending on the mode:
• Standalone mode
• Domain mode

Standalone mode
1. Open JBOSS_HOME/standalone/configuration/standalone.xml for editing.
2. Locate the <key-stores> line and add the following strings right after the line:

<key-store name="<keystorename>"> 
   <credential-reference clear-text="<keystorepassword>"/> 
   <file path="<keystore>" relative-to="jboss.server.config.dir"/> 
  </key-store> 
  <key-store name="<truststorename>"> 
   <credential-reference clear-text="<truststorepassword>"/> 
   <file path="<truststore>" relative-to="jboss.server.config.dir"/> 
  </key-store>

Where:
• <keystorename> is a name of the repository that contains your security certificate or 

certificates.
• <keystorepassword> is a password of the keystore.
• <truststorename> is a name of the repository that contains a trusted certificate or 

certificates.
• <truststorepassword> is a password of the truststore.

3. Locate the <key-managers> line and add the following strings right after the line:
<key-manager name="<keymanagername>" key-store="<keystorename>"> 
   <credential-reference clear-text="<keystorepassword>"/> 
  </key-manager>

Where:
• <keymanagername> is a name of the repository that contains a trusted certificate or 

certificates.
• <keystorename> is a name of the repository that contains your security certificate or 

certificates.
• <keystorepassword> is a password of the keystore.

4. Right after the <key-managers>..</key-managers> tag, add the following strings:
<trust-managers> 
   <trust-manager name="<trustmanagername>" key-store="<truststorename>"/> 
  </trust-managers>

5. Locate the <server-ssl-contexts> line and add the following strings right after the line:
<server-ssl-context name="<managementsslcontextname>" key-
manager="<keymanagername>" trust-manager="<trustmanagername>"/> 
  <server-ssl-context name="<applicationsslcontextname>" key-
manager="<keymanagername>" trust-manager="<trustmanagername>"/>
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Where:
• <managementsslcontextname> is a management SSL context name
• <keymanagername> is a key manager name.
• <trustmanagername> is a trust manager name.
• <applicationsslcontextname> is an application SSL context name.

6. Locate the following line:
<http-interface http-authentication-factory="management-http-authentication"> 
   <http-upgrade enabled="true" sasl-authentication-factory="management-sasl-
authentication"/> 
   <socket-binding http="management-http"/> 
  </http-interface>

Change the line to:
<http-interface http-authentication-factory="management-http-authentication" ssl-
context="<managementsslcontextname>"> 
   <http-upgrade enabled="true" sasl-authentication-factory="management-sasl-
authentication"/> 
   <socket-binding https="management-https"/> 
  </http-interface>

7. Locate the following line:
<https-listener name="https" socket-binding="https" ssl-context="applicationSSC" 
 enable-http2="true"/>

Change the line to:
<https-listener name="https" socket-binding="https" ssl-
context="<applicationsslcontextname>" enable-http2="true"/>

8. Locate the following string:
<socket-binding name="management-https" interface="management" 
port="${jboss.management.https.port:9993}"/>

Change the default value 9993 to the appropriate port value.
9. Locate the following string:

<socket-binding name="https" port="${jboss.https.port:8443}"/>

Change the default value 8443 to the appropriate port value.
10. Copy the <keystore> and <truststore> JKS files to JBOSS_HOME/standalone/

configuration.
11. Restart the WildFly or JBoss EAP application server.

Domain mode
1. Open JBOSS_HOME/domain/configuration/host.xml for editing.
2. Right after the <sasl>..</sasl> tag, add the following strings:

<tls> 
   <key-stores> 
    <key-store name="<keystorename>"> 
     <credential-reference clear-text="<keystorepassword>"/> 
     <implementation type="JKS"/> 
     <file path="<keystore>" relative-to="jboss.domain.config.dir"/> 
    </key-store> 
    <key-store name="<truststorename>"> 
     <credential-reference clear-text="<truststorepassword>"/> 
     <implementation type="JKS"/> 
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     <file path="<truststore>" relative-to="jboss.domain.config.dir"/> 
    </key-store> 
   </key-stores> 
   <key-managers> 
    <key-manager name="<keymanagername>" key-store="<keystorename>"> 
     <credential-reference clear-text="<keystorepassword>"/> 
    </key-manager> 
   </key-managers> 
   <trust-managers> 
    <trust-manager name="<trustmanagername>" key-store="<truststorename>"/> 
   </trust-managers> 
   <server-ssl-contexts> 
    <server-ssl-context name="<managementsslcontextname>" key-
manager="<keymanagername>" trust-manager="<trustmanagername>"/> 
   </server-ssl-contexts> 
  </tls>

Where:
• <keystorename> is a name of the repository that contains your security certificate or 

certificates.
• <keystorepassword> is a password of the keystore.
• <truststorename> is a name of the repository that contains a trusted certificate or 

certificates.
• <truststorepassword> is a password of the truststore.
• <keymanagername> is a key manager name.
• <trustmanagername> is a trust manager name.
• <managementsslcontextname> is a management SSL context name.

3. Locate the following line:
<http-interface http-authentication-factory="management-http-authentication">

Change the line to:
<http-interface http-authentication-factory="management-http-authentication" ssl-
context="<managementsslcontextname>">

4. Locate the following line:
<socket interface="management" port="${jboss.management.http.port:9990}"/>

Change the line to:
<socket interface="management" secure-port="<securemangementport>"/>

5. Open JBOSS_HOME/domain/configuration/domain.xml for editing and locate <profile 
name="full-ha">

a. Within <profile name="full-ha">, locate the <key-stores> line and add the 
following strings right after the line :
<key-store name="<keystorename>"> 
    <credential-reference clear-text="<keystorepassword>"/> 
    <file path="<keystore>" relative-to="jboss.domain.config.dir"/> 
   </key-store> 
   <key-store name="<truststorename>"> 
    <credential-reference clear-text="<truststorepassword>"/> 
    <file path="<truststore>" relative-to="jboss.domain.config.dir"/> 
   </key-store>

b. Locate the <key-managers> line and add the following strings right after the line:
<key-manager name="<keymanagername>" key-store="<keystorename>"> 
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    <credential-reference clear-text="<keystorepassword>"/> 
   </key-manager>

c. Right after the <key-managers>..</key-managers> tag, add the following strings:
<trust-managers> 
    <trust-manager name="<trustmanagername>" key-store="<truststorename>"/> 
   </trust-managers>

d. Locate the <server-ssl-contexts> line and add the following strings right after the 
line:
<server-ssl-context name="<sslcontextname>" key-manager="<keymanagername>" 
 trust-manager="<trustmanagername>"/>

e. Locate the following line:
<https-listener name="https" socket-binding="https" ssl-
context="applicationSSC" enable-http2="true"/>

Change the line to:
<https-listener name="https" socket-binding="https" ssl-
context="<applicationsslcontextname>" enable-http2="true"/>

f. Locate the <servlet-container name="default"> tag and add the following string 
between <jsp-config/> and <websockets/>:
<session-cookie http-only="true" secure="true"/>

6. Locate the <socket-binding-group name="full-ha-sockets" line and then locate the 
following string:
<socket-binding name="https" port="${jboss.https.port:8443}"/>

Change the default value 8443 to the appropriate port value.
7. Copy the <keystore> and <truststore> JKS files to JBOSS_HOME/domain/configuration.
8. Restart the WildFly or JBoss EAP application server.

Create a new WildFly or JBoss EAP server for the MarkView instance 
(domain mode only)
Create a new domain

1. Log in to the WildFly or JBoss EAP Administration Console.
2. Select the Runtime tab.
3. On the Browser By menu, select Server Groups and click Add Server Group.
4. In the Add Server Group window, enter the following information and click Add:

• Name: <domain_name>
• Profile: full-ha
• Socket Binding Group: full-ha-sockets

Create a new server
1. In the WildFly or JBoss EAP Administration Console, select the Runtime tab.
2. On the Browser By menu, select Server Groups.
3. On the Server Group menu, select the newly created server group and click Add Server.
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4. In the Add Server window, enter the following information and click Add:
• Name: <domain_name>_server, where <domain_name> is the server group name.

Add the _server postfix to your server name.
• Host: master
• Auto Start: On
• Group: <domain_name>
• Socket Binding Port Offset: 0

5. On the Runtime tab, select Topology and click Refresh.
Start the created server by clicking its name.

Set up Java Options for WildFly or JBoss EAP (standalone mode only) on 
AIX
Skip this section if you do not use AIX platform or configure the WildFly or JBoss EAP application 
servers in domain mode.

For Windows:
1. Open the %JBOSS_HOME%\bin\standalone.conf.bat file for editing.
2. Go to end file and add string set "JAVA_OPTS=%JAVA_OPTS% -XX:

+PositiveIdentityHash -XX:-IgnoreUnrecognizedVMOptions -XX:
+UnlockExperimentalVMOptions" before  :JAVA_OPTS_SET instruction.

3. Save the file.

For Linux:
1. Open the  $JBOSS_HOME/bin/standalone.conf file for editing.
2. Go to end file and add string JAVA_OPTS="$JAVA_OPTS -XX:+PositiveIdentityHash -

XX:-IgnoreUnrecognizedVMOptions -XX:+UnlockExperimentalVMOptions".
3. Save the file.

Set up Java Options for WildFly or JBoss EAP (domain mode only) on AIX
Skip this section if you do not use AIX platform or configure the WildFly or JBoss EAP application 
servers in standalone mode.

1. Log in to the WildFly or JBoss EAP Administration Console.
2. On the Runtime tab, select Server Groups.
3. On the Server Group menu, select Server Group Name.
4. In the Server Group Name box, click the View button.
5. On the left pane, select JVMs and add a new JVM configuration.
6. Click Edit and set the following memory properties for your application server. Suggested 

values for JVM Options are:
-XX:+PositiveIdentityHash

-XX:-IgnoreUnrecognizedVMOptions

-XX:+UnlockExperimentalVMOptions
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Add SSL certificate to the application server truststore (for SSL only)
Skip this section if you are not using SSL to provide secure web communications for the application 
server.

Skip this section if you plan to use the MarkView installer to install and configure WildFly.

To add the certificate to the application server Java truststore, run the following command:

keytool -import -alias <alias> -keystore 
      <application_server_java_home>/jre/lib/security/cacerts -file 
      <certificate>

Where:
• <alias> is a keystore entry unique name
• <certificate> is a file that contains the self-signed certificate or any other certificate received 

from the certificate authority
If you have a certificate received from the certificate authority, verify that root and intermediate 
certificates from the certification chain are in the application server Java truststore and run the 
indicated command to add the missing certificates.

The default Java certificate authority keystore is cacerts. The default password for cacerts is
<changeit>.

Add truststore to the jboss-cli configuration file (for SSL only)
Skip this section if you are not using SSL to provide secure web communications for the application 
server.

In JBOSS_HOME/bin, open the jboss-cli.xml file for editing. Right after the <color-
output>..</color-output> tag, add the following strings:

<ssl> 
  <alias>"<alias>"</alias> 
  <trust-store>"<truststore>"</trust-store> 
  <trust-store-password>"<truststorepassword>"</trust-store-password> 
    </ssl>

Where:
• <alias> is a truststore entry unique name.
• <truststore> is a repository that contains a trusted self-signed certificate or certificates.
• <truststorepassword> is a password of the truststore.

What to do next
• To use Silent Installation mode, go to Silent verification and upgrade on page 45.
• To use Interactive mode, go to Verify your environment on page 59.
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Silent verification and upgrade

In silent mode, you set installation properties in a script that is used by the installer. The installer 
does not display windows or prompt for input during the installation process. Because you can 
reuse the install_silent script, you can automate identical installations on multiple systems.

You can use silent-mode installation on Windows or UNIX systems and can also use it to install 
Oracle Objects.

This chapter assumes that you:
• Completed the tasks described in Before you start.
• Completed the Kofax MarkView Installation Worksheet and have the worksheet available for 

reference.
• Logged in as the owner of the application server.

Using silent-mode installation requires you to complete the following procedures, which this
chapter describes:

1. Edit the interview files in the MarkView installation directory. See Silent-mode setup.

2. If you choose to run the verify_silent script, copy the interview files to the verify directory and 
run verify. See Run the verify_silent script on page 53.

3. Run the install_silent script. See Run the install_silent script on page 54.

 If you upgrade from MarkView 8.1.x and earlier, the length of time that the upgrade process 
takes depends on the amount of data imported from Kofax Transformation Modules to your 
MarkView environment, data migration period, and the speed of your system processors. To 
track the progress, use DBA Oracle tools, such as, system view v$session_longops. See Configure 
historical data migration period for upgrades from MarkView 8.1.x and earlier (optional).

When you finish the silent upgrade:
• For Accounts Payable post-upgrade steps, see Configure MarkView for Accounts Payable on page

105.
• For Oracle Objects post-upgrade steps, see Configure Oracle Forms on page 81.
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Silent-mode setup

Edit the preliminary_interview.properties file
1. Navigate to <distribution_directory>/installer/conf where

<distribution_directory> is the location where you downloaded and decompressed the 
installation files.

2. Back up the preliminary_interview.properties file.
3. Open the preliminary_interview.properties file and enter the following information.

 For installations running on Windows, when modifying manually populated fields, use a 
double backslash (\\) or a forward slash (/) as a path delimiter.

Field Allowed Values

AppServerType.app_server_type • WebLogic
• JBoss (use for WildFly and JBoss EAP)

InstallDirectory.install_directory Installation directory. This is user defined and must exist prior to
upgrade. This cannot be the same as the temporary distribution 
directory. See the MarkView Installation Worksheet.

InstallerAction.installer_action upgrade

InstallationType.installation_type • Standard Full Install (Select this option for upgrades.)
• Partial Install (Any value other than Standard Full Install 

performs a partial install)

SelectedProducts.selected_products These must exactly match what appears in the install_script.xml 
file. To verify product names, open install_script.xml and search 
for display = <product name>.
For example:
• MarkView for AP 10.5.0 with Transformation
• MarkView for Expense Management 10.5.0
• MarkView Document Library 10.5.0
• MarkView Self Service Invoice 10.5.0

To list multiple products, separate product names with commas.

ERPType.erp_type (Optional) Oracle, or blank

MarkView DBConn.password Password for MarkView schema user

Run the generateInterviewTemplate file
The generateInterviewTemplate script uses the information in the preliminary_interview.properties 
file to generate the installer_interview.properties file.

1. Navigate to <distribution_directory>\installer\bin, where
<distribution_directory> is the location where you downloaded and decompressed the 
installation files.
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2. Run either:
• UNIX: generateInterviewTemplate.sh
• Windows: generateInterviewTemplate.bat

Edit the installer_interview.properties file
1. Navigate to <distribution_directory>\installer\conf where

<distribution_directory> is the location where you downloaded and decompressed the 
installation files.

2. Back up the installer_interview.properties file.
3. Open the installer_interview.properties file.
4. Enter information for the fields identified with bold type in the following table. These fields 

appear in the same alphabetical order in the installer_interview.properties file. Use this list 
as a reference for all possible fields in the installer_interview.properties file. Your file may not 
contain all of the listed fields. Field names and values cannot contain spaces.

 Modifying automatically populated fields may cause unexpected results during the 
upgrade.

 For installations running on Windows, when modifying manually populated fields, use a 
double backslash (\\) or a forward slash (/) as a path delimiter.

Field Values Source Product

AppServer Type. app 
_server_type

• WebLogic
• JBoss (use for WildFly and JBoss EAP)

Automatically 
populated. Do 
not change this 
value.

All

AppServerType. type SimpleQuestion Automatically 
populated. Do 
not change this 
value.

All

Folder Location. 
location

Directory for the Document Server. Must 
exist prior to upgrade.

Enter the data 
from your 
Installation 
Worksheet.

AP

FolderLocation. type FolderLocation Automatically 
populated. Do 
not change this 
value.

AP

InstallDirectory. install 
_directory

From the preliminary _interview. 
properties file

Automatically 
populated. Do 
not change this 
value.

All

InstallDirectory. type SimpleQuestion Automatically 
populated. Do 
not change this 
value.

All
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Field Values Source Product

InstallationType. 
installation _type

From the preliminary _interview. 
properties file

Automatically 
populated. Do 
not change this 
value.

All

InstallationType. type SimpleQuestion Automatically 
populated. Do 
not change this 
value.

All

JBossAppServer. 
adminUserName

JBoss administrator name Enter the data 
from your 
Installation 
Worksheet.

All

JBossAppServer. 
adminPassword

JBoss application server administrator 
password

Enter the data 
from your 
Installation 
Worksheet.

All

JBossAppServer. 
adminPort

The admin HTTP port (for example, 9090) To change the 
default value, 
enter the data 
from your 
Installation 
Worksheet.

All

JBossAppServer.asSSL For SSL with WildFly or JBoss EAP: true
Valid values: true, false

Enter the data 
from your 
Installation 
Worksheet.

All

JBossAppServer.domain For domain mode, enter your domain 
name as follows:
JBossAppServer.domain=<domainName>

For standalone mode, leave the field value 
blank:
JBossAppServer.domain=

For domain 
mode, enter 
the data 
from your 
Installation 
Worksheet.

All

JBossAppServer. host Fully qualified hostname of this machine Enter the data 
from your 
Installation 
Worksheet.

All

JBossAppServer. port The HTTP port where MarkView 
applications listen (for example, 26000)

To change the 
default value, 
enter the data 
from your 
Installation 
Worksheet.

All

JBossAppServer. type JBossAppServer Automatically 
populated. Do 
not change this 
value.

All
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Field Values Source Product

JBossAppServer. 
jbossLocation

Defaults to
<distribution_directory>/../
wildfly,
where <distribution_directory> is 
the location where you downloaded and 
extracted the MarkView installation files.
If <distribution_directory>/../
wildfly does not exist prior to upgrade, 
the installer creates the directory.

To change the 
default value, 
enter the data 
from your 
Installation 
Worksheet.

All

JBossAppServer. 
oracleDriver

Defaults to
<distribution_directory>/distr/
ojdbc6-11.2.0.3.jar,
where <distribution_directory> is 
the location where you downloaded and 
extracted the MarkView installation files.

To change the 
default value, 
enter the data 
from your 
Installation 
Worksheet

All

JBossAppServer. 
needsDeploy

Defaults to <empty>
Valid values: no, yes

To change the 
default value, 
enter the data 
from your 
Installation 
Worksheet.

All

MarkView DBConn. 
dbType

oracle Automatically 
populated. Do 
not change this 
value.

All

MarkView DBConn. 
host

Fully qualified hostname where MarkView 
resides

Enter the data 
from your 
Installation 
Worksheet.

All

MarkView DBConn. 
indexspace

Tablespace for MarkView indexes Enter the data 
from your 
Installation 
Worksheet.

All

MarkView DBConn. 
loggingDirectory

Oracle logging directory for MarkView 
processes

Enter the data 
from your 
Installation 
Worksheet.

All

MarkView DBConn. 
password

Password for MarkView schema user Enter the data 
from your 
Installation 
Worksheet.

All

MarkView DBConn. 
port

Port for MarkView schema Enter the data 
from your 
Installation 
Worksheet.

All
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Field Values Source Product

MarkView DBConn. sid SID for MarkView schema Enter the data 
from your 
Installation 
Worksheet.

All

MarkView DBConn. 
tablespace

Tablespace for MarkView data Enter the data 
from your 
Installation 
Worksheet.

All

MarkView DBConn. 
type

OracleDatabase Connection Enter the data 
from your 
Installation 
Worksheet.

All

MarkView DBConn. 
user

User name for the MarkView schema user Enter the data 
from your 
Installation 
Worksheet.

All

OracleEBS. password Oracle APPS user password Enter the data 
from your 
Installation 
Worksheet.

All except Doc 
Lib

OracleEBS.type OracleEBSInstance Automatically 
populated. Do 
not change this 
value.

All except Doc 
Lib

OracleEBS. user Oracle APPS user name Enter the data 
from your 
Installation 
Worksheet.

All except Doc 
Lib

OracleEBSCodes. 
holdCode

170_SYSTEMS _HOLD Automatically 
populated. Do 
not change this 
value.

All except Doc 
Lib

OracleEBSCodes. 
releaseCode

170_SYSTEMS _RELEASE Automatically 
populated. Do 
not change this 
value.

All except Doc 
Lib

OracleEBSCodes. type OracleEBS Codes Automatically 
populated. Do 
not change this 
value.

All except Doc 
Lib

OracleText. password Oracle Text user password Enter the data 
from your 
Installation 
Worksheet.

Doc Lib
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Field Values Source Product

OracleText.type OracleText Automatically 
populated. Do 
not change this 
value.

Doc Lib

OracleText.user CTXSYS Enter the data 
from your 
Installation 
Worksheet.

Doc Lib

SelectedProducts. 
selected_ products

Products selected in the preliminary 
_interview. properties file

Automatically 
populated. Do 
not change this 
value.

All

Selected Products. type MultipleAnswer Question Automatically 
populated. Do 
not change this 
value.

All

SMTPInfo. password SMTP password, if necessary Enter the data 
from your 
Installation 
Worksheet.

All

SMTPInfo. serverName Fully qualified SMTP server address Enter the data 
from your 
Installation 
Worksheet.

All

SMTPInfo. type Custom Resource Automatically 
populated. Do 
not change this 
value.

All

SMTPInfo. username SMTP user name if necessary Enter the data 
from your 
Installation 
Worksheet.

All

WebLogic AppServer. 
adminPassword

WebLogic application server password Enter the data 
from your 
Installation 
Worksheet.

All

WebLogic AppServer. 
adminPort

The admin HTTP port (default 7001) Enter the data 
from your 
Installation 
Worksheet.

All

WebLogic AppServer. 
adminUserName

WebLogic administrator name Enter the data 
from your 
Installation 
Worksheet.

All
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Field Values Source Product

WebLogicAppServer. 
asSSL

For SSL with WebLogic: true
Valid values: true, false

Enter the data 
from your 
Installation 
Worksheet.

All

WebLogic AppServer. 
domainLocation

Defaults to ${WL_HOME}/../markview) To change the 
default value, 
enter the data 
from your 
Installation 
Worksheet.

All

WebLogic AppServer. 
domainName

Defaults to MarkView To change the 
default value, 
enter the data 
from your 
Installation 
Worksheet.

All

WebLogic AppServer. 
host

Fully qualified hostname of this machine Enter the data 
from your 
Installation 
Worksheet.

All

WebLogic AppServer. 
jarLocation

Defaults to ${WL_HOME}/server/lib/
weblogic.jar

To change the 
default value, 
enter the data 
from your 
Installation 
Worksheet.

All

WebLogic AppServer. 
javaHomeDir

Defaults to %WL_HOME/../jrockit_* To change the 
default value, 
enter the data 
from your 
Installation 
Worksheet.

All

WebLogic AppServer. 
nodeManagerPort

Defaults to 5556 To change the 
default value, 
enter the data 
from your 
Installation 
Worksheet.

All

WebLogic 
AppServer.port

The HTTP port where MarkView 
applications listen (default 8001)

To change the 
default value, 
enter the data 
from your 
Installation 
Worksheet.

All

WebLogic 
AppServer.type

WebLogicAppServer Automatically 
populated. Do 
not change this 
value.

All
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Run the verify_silent script
To ensure that your environment is configured properly for successful upgrade, run the verify script, 
which is a smaller version of the installation script.

1. Copy the installer_interview.properties file that you generated in Run the 
generateInterviewTemplate file and edited in Edit the installer_interview.properties file from
<distribution_directory>/installer/conf to <distribution_directory>/verify/
conf, (where <distribution_directory> is the location where you downloaded and 
decompressed the installation files).

2. Ensure that all the paths entered in the install_interview.properties file exist.
3. Skip this step if you do not use SSL for the application server. If you plan to use SSL, navigate 

to <distribution_directory>/verify/bin, (where <distribution_directory> is the 
location where you downloaded and decompressed the installation files), open for editing 
verify_silent.sh or verify_silent.bat and change the following string:
• For UNIX:

java -Xmx1024m -cp ${CLASSPATH} 
      -Doracle_home=${ORACLE_HOME} com.markview.installer.Installer "$@"

to:
java -Xmx1024m -cp ${CLASSPATH} 
      -Doracle_home=${ORACLE_HOME} -Dmarkview.ssl.alias=<alias> 
      -Djavax.net.ssl.keyStore=<keystore> 
      -Djavax.net.ssl.keyStorePassword=<keystorepassword> 
      -Djavax.net.ssl.trustStore=<truststore> 
      -Djavax.net.ssl.trustStorePassword=<truststorepassword> 
      com.markview.installer.Installer "$@"

• For Windows:
java -Xmx1024m -cp "%CLASSPATH%" 
      -Doracle_home=%ORACLE_HOME% com.markview.installer.Installer %*

to:
java -Xmx1024m -cp "%CLASSPATH%" 
      -Doracle_home=%ORACLE_HOME% -Dmarkview.ssl.alias=<alias> 
      -Djavax.net.ssl.keyStore=<keystore> 
      -Djavax.net.ssl.keyStorePassword=<keystorepassword> 
      -Djavax.net.ssl.trustStore=<truststore> 
      -Djavax.net.ssl.trustStorePassword=<truststorepassword> 
      com.markview.installer.Installer %*

4. In <distribution_directory>/verify/bin, run either:
• UNIX: verify_silent.sh
• Windows: verify_silent.bat

If no errors occur, verify_silent returns to a command prompt with no further messages.

If Verify encounters an error
1. Review the verify logs located in the distribution directory in the reports folder.
2. Resolve the issue.
3. Rerun the verify script.
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If no errors occur, the script returns to a command prompt with no further messages.

Run the install_silent script
1. Skip this step if you do not use SSL for the application server. If you plan to use SSL, navigate 

to <distribution_directory>/installer/bin, (where <distribution_directory> is 
the location where you downloaded and decompressed the installation files), open for editing 
install_silent.sh or install_silent.bat and change the following string:
• For UNIX:

java -Xmx1024m -cp ${CLASSPATH} 
      -Doracle_home=${ORACLE_HOME} com.markview.installer.Installer "$@"

to:
java -Xmx1024m -cp ${CLASSPATH} 
      -Doracle_home=${ORACLE_HOME} -Dmarkview.ssl.alias=<alias> 
      -Djavax.net.ssl.keyStore=<keystore> 
      -Djavax.net.ssl.keyStorePassword=<keystorepassword> 
      -Djavax.net.ssl.trustStore=<truststore> 
      -Djavax.net.ssl.trustStorePassword=<truststorepassword> 
      com.markview.installer.Installer "$@"

• For Windows:
java -Xmx1024m -cp "%CLASSPATH%" 
      -Doracle_home=%ORACLE_HOME% com.markview.installer.Installer %*

to:
java -Xmx1024m -cp "%CLASSPATH%" 
      -Doracle_home=%ORACLE_HOME% -Dmarkview.ssl.alias=<alias> 
      -Djavax.net.ssl.keyStore=<keystore> 
      -Djavax.net.ssl.keyStorePassword=<keystorepassword> 
      -Djavax.net.ssl.trustStore=<truststore> 
      -Djavax.net.ssl.trustStorePassword=<truststorepassword> 
      com.markview.installer.Installer %*

2. In <distribution_directory>\installer\bin, run either:
• UNIX: install_silent.sh
• Windows: install_silent.bat

 If the installer encounters an error, the upgrade stops. Review the log files located 
in the log folder in the MarkView installation directory. Resolve the issue, then rerun the 
install_silent script.

Upon successful completion, the install_silent script returns to the command prompt with no 
further messages.

Install Oracle Objects
Make sure that your environment is configured correctly for installing Oracle Objects. See
Set up your environment and install MarkView Oracle Objects on page 77. Copy the 

54



Kofax MarkView Upgrade Guide for Oracle E-Business Suite

target_registry_service.properties file from the MarkView installation directory to the Oracle Objects 
installation directory.

Silent-mode setup for Oracle Objects

Edit the preliminary_interview.properties file for Oracle Objects
1. Log in to the Oracle EBS server as the EBS user.
2. Navigate to <distribution_directory>/installer/conf (where

<distribution_directory> is the location where you downloaded and decompressed the 
installation files).

3. Back up the preliminary_interview.properties file.
4. Open the preliminary_interview.properties file and enter the following information.

Field Allowed Values

AppServerType.app_server_type • WebLogic
• JBoss (use for WildFly and JBoss EAP)

InstallDirectory.install_directory Installation directory. This is user defined and must 
exist prior to installation. See the Kofax MarkView 
Installation Worksheet.

InstallerAction.installer_action upgrade

InstallationType.installation_type Standard Full Install
Partial Install (Any value other than Standard Full 
Install will perform a partial install)

SelectedProducts.selected_products Must be an exact match to contents of the 
install_script.xml file. To verify product names, 
open install_script.xml and search for display 
= <product name>. To list multiple products, 
separate product names with commas.

ERPType.erp_type Oracle or blank - optional field

Run the generateInterviewTemplate file for Oracle Objects
1. Log in to the Oracle EBS server as the EBS user.
2. Navigate to <distribution_directory>\installer\bin where

<distribution_directory> is the location where you downloaded and decompressed the 
installation files.

3. Run either:
• UNIX: generateInterviewTemplate.sh
• Windows: generateInterviewTemplate.bat

Edit the Oracle Objects installer_interview.properties file
1. Log in to the Oracle EBS server as the EBS user.
2. Navigate to the conf folder in the MarkView installation directory.
3. Back up the installer_interview.properties file.
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4. Open the Oracle Objects installer_interview.properties file.
5. Enter information for the fields marked with bold type. There are no spaces in field names.

 Modifying fields populated by the preliminary_interview.properties file may cause 
unexpected results during installation.

Field Values Source Product

InstallDirectory. 
install_directory

MarkView installation 
directory from the 
preliminary_ interview. 
properties file

preliminary_ interview. 
properties

All

InstallDirectory. type Simple Question preliminary_ interview. 
properties

All

InstallationType. 
installation_type

Install type seeded from 
preliminary_ interview . 
properties

preliminary_ interview. 
properties

All

InstallationType . type SimpleQuestion preliminary_ interview. 
properties

All

MarkView DBConn. 
dbType

Enter oracle. preliminary_ interview. 
properties

All

MarkView DBConn. 
host

Fully qualified hostname 
where MarkView resides

Installation Worksheet All

MarkView DBConn. 
indexspace

Tablespace where 
MarkView indexes will 
reside

Installation Worksheet All

MarkView DBConn. 
logging Directory

Oracle logging directory 
for MarkView processes

Installation Worksheet All

MarkView DBConn. 
password

Password for MarkView 
schema user

Installation Worksheet All

MarkView DBConn. 
port

Port for MarkView 
schema

Installation Worksheet All

MarkView DBConn. sid SID for MarkView 
schema

Installation Worksheet All

MarkView DBConn. 
tablespace

Tablespace where 
MarkView data will 
reside

Installation Worksheet All

MarkView DBConn. 
type

Oracle Database 
Connection

Installation Worksheet All

MarkView DBConn. 
user

User name for MarkView 
schema user

Installation Worksheet All

OAForms EnvInfo. 
appl_top

install_silent.sh Forms

OAForms EnvInfo. 
au_top

install_silent.sh Forms
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Field Values Source Product

OAForms EnvInfo. 
c_markview_ top

install_silent.sh Forms

OAForms EnvInfo. 
fnd_top

install_silent.sh Forms

OAForms EnvInfo. type install_silent.sh Forms

OAFrameworks EnvInfo. 
appl_top

install_silent.sh OA Frameworks, OA 
Expense

OAFrameworks EnvInfo. 
common_top

install_silent.sh OA Frameworks, OA 
Expense

OAFrameworks EnvInfo. 
java_top

install_silent.sh OA Frameworks, OA 
Expense

OAFrameworks EnvInfo. 
type

OAFramework EnvInfo 
Resource

install_silent.sh OA Frameworks, OA 
Expense

OracleEBS password Oracle APPS user 
password

Installation Worksheet All except Doc Lib

OracleEBS .type Oracle EBSInstance preliminary_ interview. 
properties

All except Doc Lib

OracleEBS. user Oracle APPS user name Installation Worksheet All except Doc Lib

Selected Products. 
selected_products

Products selected from 
preliminary_ interview. 
properties

preliminary_ interview. 
properties

All

Selected Products. type Multiple Answer 
Question

preliminary_ interview. 
properties

All

Run the verify_silent script for Oracle Objects
1. Log in to the Oracle EBS server as the EBS user.
2. Copy the installer_interview.properties file from <distribution_directory>/installer/

conf to <distribution_directory>/verify/conf (where <distribution_directory> is 
the location where you downloaded and decompressed the installation files).

3. Ensure that all the paths entered in the install_interview.properties file exist.
4. In <distribution_directory>/verify/bin, run either:

• UNIX: verify_silent_oracle_objects.sh
• Windows: verify_silent_oracle_objects.bat

If no errors exist, verify_silent_oracle_objects returns to a command prompt with no further 
messages.

If Verify Oracle Objects encounters an error
1. Review the verify logs located in the reports folder in the distribution directory.
2. Resolve the issue.
3. Rerun the verify script.

If no errors exist, the script returns to a command prompt with no further messages.
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Run the install_silent script for Oracle Objects
1. Log in to the Oracle EBS server as the EBS user.
2. If the Target Registry Service is already deployed, copy the existing 

target_registry_service.properties file to the MarkView installation directory for Oracle Objects.
3. In <distribution_directory>/installer/bin, (where <distribution_directory> is 

the location where you downloaded and decompressed the installation files), run either:
• UNIX: install_silent.sh
• Windows: install_silent.bat

 If the installer encounters an error, the installation stops automatically. Review the log 
files located in the log folder in the target installation directory. Resolve the issue, then rerun 
the install_silent script.

4. Continue at Post-upgrade steps.

If no errors exist, the install_silent file returns to the command prompt with no further messages.
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Chapter 3

Verify your environment

The Verify tool is a smaller version of the installation application. Verify checks many of the system 
configuration settings and generates log files to help you identify and correct any issues before you
upgrade MarkView.

Before running Verify:
• Ensure that your system is in compliance with the Kofax MarkView Technical Specifications

document on the Kofax MarkView Product Documentation site.
• Complete the Kofax MarkView Installation Worksheet.
• Complete the tasks described in Before you start.

Run Verify
The MarkView verification process requires information about your environment. Complete the 
sections of the installation worksheet that apply to your environment before you begin to verify 
MarkView.

Run verify on all systems where MarkView products are installed or being upgraded:
• Application server hosts
• Oracle E-Business Suite hosts

Verify hosts
Verify checks the following:
• Version information for

• Operating System
• Database
• Database Server
• Application Server
• Forms Server

• MarkView Oracle RDBMS user privileges
• Oracle XML DB
• Oracle Advanced Queuing
• MarkView schema user setup

Verify generates logs that contain information about issues that can cause the MarkView upgrade to 
fail.
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Run Verify on the MarkView application server host
Use the information that you entered on the Kofax MarkView Installation Worksheet to respond to the 
Verify prompts. Run Verify before upgrading MarkView.

1. Log in to the application server host operating system as the application server owner.
2. Ensure that the MarkView application server is running.
3. Ensure that the environment variables are correct.

For more information, see:
• Set locale-sensitive environment variables
• Configure environment variables for WebLogic or Configure environment variables

4. Skip this step if you do not use SSL for the application server. If you plan to use SSL, navigate 
to <distribution_directory>/verify/bin, (where <distribution_directory> is the 
location where you downloaded and decompressed the installation files), open for editing 
verify.sh or verify.bat and change the following string:
• For UNIX:

java -Xmx1024m -cp ${CLASSPATH} 
      -Doracle_home=${ORACLE_HOME} com.markview.installer.InstallerVerify "$@"

to:
java -Xmx1024m -cp ${CLASSPATH} 
      -Doracle_home=${ORACLE_HOME} -Dmarkview.ssl.alias=<alias> 
      -Djavax.net.ssl.keyStore=<keystore> 
      -Djavax.net.ssl.keyStorePassword=<keystorepassword> 
      -Djavax.net.ssl.trustStore=<truststore> 
      -Djavax.net.ssl.trustStorePassword=<truststorepassword> 
      com.markview.installer.InstallerVerify "$@"

• For Windows:
java -Xmx1024m -cp "%CLASSPATH%" 
      -Doracle_home=%ORACLE_HOME% com.markview.installer.InstallerVerify %*

to:
java -Xmx1024m -cp "%CLASSPATH%" 
      -Doracle_home=%ORACLE_HOME% -Dmarkview.ssl.alias=<alias> 
      -Djavax.net.ssl.keyStore=<keystore> 
      -Djavax.net.ssl.keyStorePassword=<keystorepassword> 
      -Djavax.net.ssl.trustStore=<truststore> 
      -Djavax.net.ssl.trustStorePassword=<truststorepassword> 
      com.markview.installer.InstallerVerify %*

5. Navigate to <distribution_directory>/verify/bin, (where
<distribution_directory> is the location where you downloaded and decompressed the 
installation files), and run the command for your operating system:
• UNIX: verify.sh
• Windows: verify.bat

6. On the Which products do you want to verify for this environment? page, select only the 
products that you plan to upgrade.

7. Follow the on-screen prompts and click Verify.

 On the Installation Progress window, click Show Details to display the progress.
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8. Review the generated reports located in the MarkView installation directory you selected 
during the verification. Save these logs in another directory to avoid overwriting them.
The log file reports/EnvironmentReport.txt describes issues with your environment that 
will prevent successful upgrade.

9. Make changes as indicated in the failure reports. You are now ready to upgrade.

To run Verify for the Oracle Objects installer on the Oracle EBS host before running the application 
server and database components installer, copy the target_registry.properties file from the 
MarkView installation directory on the application server host to the installation directory on the 
OEBS host. See Download the Oracle Objects installer and Verify files on page 77.
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Upgrade MarkView

Follow the steps in this chapter to run the MarkView installer. If you used the silent-mode 
installation, skip this section.

Upgrade MarkView products
Before running the installer to upgrade MarkView products:
• Use the Installation Worksheet completed when MarkView products were installed.
• Run Verify: Perform this task if you have not already done so. For information about Verify, see

Run Verify on the MarkView application server host on page 60.
• Follow the steps described in Run the MarkView installer on page 64.

If you are upgrading both MarkView and your  Oracle ERP system, Kofax recommends that you 
upgrade  Oracle first.

Restart the application server

WebLogic
1. Log in to the WebLogic Server Administration Console.
2. Go to Environment > Servers > Control tab.
3. Select the check box next to markview_server.
4. Click Shutdown and select Force shutdown now.
5. Select the check box next to markview_server and click Start.

 When you restart markview_server the first time after installing or upgrading applications, not 
all applications transition to the Active state. At this point, not all applications need to be active.

WildFly or JBoss EAP
Skip this section, if you want to use the MarkView installer to install and configure WildFly and 
proceed to Run the MarkView installer on page 64.

If you use manually configured WildFly or JBoss EAP, make sure that the application server is 
started. See Start WildFly or JBoss EAP application servers on page 38.
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Add SSL certificate to the MarkView installer Java truststore 
(for SSL only)

Skip this section if you are not using SSL to provide secure web communications for the application 
server.

To add the certificate to the MarkView installer Java truststore, run the following command:

 keytool -import -alias <alias> -keystore 
      <installer_java_home>/jre/lib/security/cacerts -file 
      <certificate>

Where:
• <alias> is a keystore entry unique name.
• <certificate> is a file that contains the self-signed certificate or any other certificate received 

from the certificate authority.
If you have a certificate received from the certificate authority, verify that root and intermediate 
certificates from the certification chain are in the MarkView installer Java truststore and run the 
indicated command to add the missing certificates.

The default Java certificate authority keystore is cacerts. The default password for cacerts is
<changeit>.

Modify installation scripts (for SSL only)
Skip this section if you are not using SSL to provide secure web communications for the application 
server or if your MarkView installation is already configured on the application server with SSL and 
you perform the upgrade on the same application server.

1. Navigate to <distribution_directory>/installer/bin where
<distribution_directory> is the location where you downloaded and extracted the 
installation files, and open for editing:
• UNIX: install.sh
• Windows: install.bat

2. Locate and change the string as follows:
• For UNIX:

java -Xmx1024m -cp ${CLASSPATH} 
      -Doracle_home=${ORACLE_HOME} com.markview.installer.Installer "$@"

to:
java -Xmx1024m -cp ${CLASSPATH} 
      -Doracle_home=${ORACLE_HOME} -Dmarkview.ssl.alias=<alias> 
      -Djavax.net.ssl.keyStore=<keystore> 
      -Djavax.net.ssl.keyStorePassword=<keystorepassword> 
      -Djavax.net.ssl.trustStore=<truststore> 
      -Djavax.net.ssl.trustStorePassword=<truststorepassword> 
      com.markview.installer.Installer "$@"

• For Windows:
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java -Xmx1024m -cp "%CLASSPATH%" 
      -Doracle_home=%ORACLE_HOME% com.markview.installer.Installer %*

to:
java -Xmx1024m -cp "%CLASSPATH%" 
      -Doracle_home=%ORACLE_HOME% -Dmarkview.ssl.alias=<alias> 
      -Djavax.net.ssl.keyStore=<keystore> 
      -Djavax.net.ssl.keyStorePassword=<keystorepassword> 
      -Djavax.net.ssl.trustStore=<truststore> 
      -Djavax.net.ssl.trustStorePassword=<truststorepassword> 
      com.markview.installer.Installer %*

Where:
• <alias> is a keystore attribute that defines the string alias used to store and retrieve the 

server private key.
• <keystore> is a repository that contains private keys and the certificates with the 

corresponding public keys.
• <keystorepassword> is a password of <keystore>.
• <truststore> is a repository that contains trusted certificates from other parties that it 

expects to communicate with, or from Certificate Authorities that it trusts to identify other 
parties.

• <truststorepassword> is a password of <truststore>.

Run the MarkView installer

WebLogic
The installer populates some fields based on entries in the Target Registry Service (TRS) file. 
(Installing MarkView for Accounts Payable creates the TRS file.) Some information, like passwords, is 
not saved. Have your completed installation worksheet available when you start the installer.

1. Log in to the application server host operating system as the application server owner.
2. Verify that the application server is running.
3. Ensure that the environment variables are correct.

For more information, see:
• Set locale-sensitive environment variables
• Configure environment variables for WebLogic

4. Navigate to <distribution_directory>\installer\bin where
<distribution_directory> is the location where you downloaded and extracted the 
installation files, and run the command for your operating system:
• UNIX: install.sh.
• Windows: install.bat.

5. On the Which products do you want to install? window, select the products to upgrade.
6. Click Next.
7. Select Standard Full Install and click Next.
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8. Select WebLogic and click Next.
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9. Use the installation worksheet to complete the windows as prompted by the installer.
The windows and prompts that appear vary based on your selections.

10. When prompted, click Install.

 If you are keeping your existing Application Server, select the same MarkView installation 
directory where MarkView is installed. See your Kofax MarkView Installation Worksheet.

 If you upgrade from MarkView 8.1.x and earlier, the length of time that the upgrade 
process takes depends on the amount of data imported from Kofax Transformation 
Modules to your MarkView environment, data migration period, and the speed of your 
system processors. To track the progress, use DBA Oracle tools, for example, system view 
v$session_longops. See Configure historical data migration period for upgrades from 
MarkView 8.1.x and earlier (optional).

11. Click Exit to complete the upgrade.
The installer finishes with a message indicating whether the upgrade is successful.

12. The installer creates a log file in the MarkView installation directory. Save the installation log 
files in a safe place in case you need this information for Technical Support.
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WildFly or JBoss EAP
The installer populates some fields based on entries in the Target Registry Service (TRS) file. 
(Installing MarkView for Accounts Payable creates the TRS file.) Some information, like passwords, is 
not saved. Have your completed installation worksheet available when you start the installer.

1. Log in to the application server host operating system as the application server owner.
2. If you use manually installed WildFly or JBoss EAP, verify that the application server is running.
3. If you use manually installed WildFly or JBoss EAP, ensure that the environment variables are 

correct.
For more information, see:
• Set locale-sensitive environment variables
• Configure environment variables

4. Navigate to <distribution_directory>\installer\bin where
<distribution_directory> is the location where you downloaded and extracted the 
installation files, and run the command for your operating system:
• UNIX: install.sh.
• Windows: install.bat.

5. On the Which products do you want to install? window, select the products to upgrade.
6. Click Next.
7. Select Standard Full Install and click Next.
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8. On the Which type of J2EE application server will MarkView use? window, select WildFly/
JBoss and click Next.

9. Use the installation worksheet to complete the windows as prompted by the installer.
The windows and prompts that appear vary based on your selections.

• Admin Username
• Admin User Password
• Domain

For the domain mode, enter your domain name in the Domain field.
For the standalone mode, leave the Domain field blank.

• App Server Directory
For manually configured WildFly or JBoss EAP, specify <JBOSS_HOME>.
If you are using the MarkView installer to install and configure WildFly, specify the location to 
store your WildFly installation files.

• Host Name
Specify your application server host name.

• Admin Port
The admin ports for manually configured WildFly and JBoss EAP may differ. See Configure 
ports and hosts.

• SSL
Select the check box if you are upgrading MarkView on SSL.
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• HTTP Port
See Configure ports and hosts.

• Install WildFly
Select Install WildFly, to use the MarkView installer to install and configure the WildFly 
application server.
Clear Install WildFly, to use the manually installed WildFly.

10. On the installer screen, check the summary of your selections.

 In the Application server field, the value JBoss is set.

11. When prompted, click Install.

 If you are keeping your existing Application Server, select the same MarkView installation 
directory where MarkView is installed. See your Kofax MarkView Installation Worksheet.

 In Show Details > Output, Installing or verifying JBoss server... line indicates the 
WildFly installation and verification process.

 If you upgrade from MarkView 8.1.x and earlier, the length of time that the upgrade 
process takes depends on the amount of data imported from Kofax Transformation 
Modules to your MarkView environment, data migration period, and the speed of your 
system processors. To track the progress, use DBA Oracle tools, for example, system view 
v$session_longops. See Configure historical data migration period for upgrades from 
MarkView 8.1.x and earlier (optional).

12. Click Exit to complete the upgrade.
The installer finishes with a message indicating whether the upgrade is successful.

13. The installer creates a log file in the MarkView installation directory. Save the installation log 
files in a safe location in case you need them later for Technical Support.
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Post-upgrade steps

Add SSL certificate for WildFly (for SSL only)
Only follow the instructions in this section if you used the MarkView installer to install and configure 
WildFly and if you use SSL to provide secure web communications for the WildFly application server.

To add the certificate to the application server Java truststore, run the following command:

keytool -import -alias <alias> -keystore 
      <application_server_java_home>/jre/lib/security/cacerts -file 
      <certificate>

Where:
• <alias> is a keystore entry unique name.
• <certificate> is a file that contains the self-signed certificate or any other certificate received 

from the certificate authority.

The default Java certificate authority keystore is cacerts. The default password for cacerts is
<changeit>

Set up memory properties (for WebLogic only)
1. Log in to the WebLogic Server Administration Console.
2. Go to Environment > Servers.
3. On the list of servers, click markview_server and go to Configuration > Server Start tab.
4. In the Arguments field, remove the following arguments, if any:

-Xms1024m -Xmx1400m -XX:CompileThreshold=8000 -XX:MetaspaceSize=128m -
XX:MaxMetaspaceSize=256m

The values for your environment may differ.

 Do not remove other arguments in order for MarkView to function correctly.

Set up the log files location
To set up the log files location, configure the markview.home variable.
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WebLogic
1. Log in to the WebLogic Server Administration Console.
2. Go to Environment > Servers.
3. On the list of servers, click markview_server and go to Configuration > Server Start tab.
4. In the Arguments field, add the following to the end of the line:

-Dmarkview.home=<path>

Where <path> is the location where you installed MarkView.
The WebLogic log files will be located in the <path>/log directory.

5. Click Save.

WildFly or JBoss EAP
1. Open one of the following configuration files depending on the mode you use to run the 

application server:

a. For Unix: JBOSS_HOME/bin/standalone.conf or JBOSS_HOME/bin/domain.conf

b. For Windows: JBOSS_HOME/bin/standalone.conf.bat or JBOSS_HOME/bin/
domain.conf.bat

2. Locate the JAVA_OPTS value and add the markview.home parameter to the end of the string as 
follows:
JAVA_OPTS="... -Dmarkview.home=<path>"

Where <path> is the location where you installed MarkView.
The WildFly or JBoss EAP log files will be located in the <path>/log directory.

Configure the print function (for WebLogic 12.1.3 only)
To set up the print function for MarkView Viewer on WebLogic 12.1.3 application server, perform the 
following steps.

1. Log in to the WebLogic Server Administration Console.
2. Go to Environment > Servers.
3. On the list of servers, click markview_server and go to Configuration > Server Start tab.
4. In the Arguments field, add the following to the end of the line:

-DUseSunHttpHandler=true

5. Click Save.

Standard/Basic WebLogic license
In case you have a Standard/Basic license for WebLogic, you need to make the following changes to 
the frameworks deployment after the installation:

1. Log in to the WebLogic Server Administration Console.
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2. Shut down markview_server.
3. Delete frameworks deployment.

a. Go to Deployments.

b. Select the frameworks deployment and click Delete.
4. Install and rename the application. Do not rename the ear file, only the application.

a. On the Deployments tab, click Install.

b. Update the path to point at
<installation_directory>/applications/frameworks.ear

Where <installation_directory> is the MarkView installation directory.

c. Select the frameworks.ear and click Next.

d. Select Install this deployment as application and click Next.

e. Select markview_server and click Next.

f. Change the name of the application from frameworks to aframeworks and click Finish.

 Repeat the renaming step (4.f) after major updates or when you apply fix packs.

Restart the application server

WebLogic
1. Log in to the WebLogic Server Administration Console.
2. Go to Environment > Servers > Control tab.
3. Select the check box next to markview_server.
4. Click Shutdown and select Force shutdown now.
5. Select the check box next to markview_server and click Start.

 When you restart markview_server the first time after installing or upgrading applications, not 
all applications transition to the Active state. At this point, not all applications need to be active.

WildFly or JBoss EAP
If you used the MarkView installer to install and configure WildFly, before starting the application 
server, configure the memory properties. See Set up memory properties (standalone mode only) on 
page 35 or Set up memory properties (domain mode only) on page 36 for more information.

1. Set the JBOSS_HOME environmental variable, such as:
JBOSS_HOME=<drive&path>/wildfly

For specific details related to UNIX or Windows, see the installation guide on the JBoss website.
2. Start the WildFly or JBoss EAP application server in standalone or domain modes. See the JBoss 

website for more information about the operating modes.
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Reintegrate _CUSTOM packages
There are several changes to the _CUSTOM packages.

If you have not customized your _CUSTOM packages, compile these packages to upgrade them 
to the current versions.

Compile these custom packages from the distribution directory (/modules/erp-integration-
dist-10.5.0/erp-integration-db/schema/custom_package_bodies/custom_package_bodies_private/):

• @mverp_dfm_custom_pb.sql
• @mverp_dfm_descr_flex_custom_pb.sql
• @mverp_dfm_lov_custom_pb.sql

If you have customized your _CUSTOM packages, modify and compile your packages before you 
can test other aspects of the system such as entering invoices into the system, and displaying and 
marking up these invoices.

See the Kofax MarkView Administrator's Guide, Volume 2 for more information about custom 
packages.

To support Oracle R12, MarkView divides the definition of distribution line into distributions and 
invoice lines. These custom packages have changed as a result of this division and although the 
changes are applicable only for Oracle 12, you must edit and recompile these packages for all 
Oracle and SAP environments.
• MVERP_DFM_DESCR_FLEX_CUSTOM: This package has a new function, a new procedure, and a 

change to an existing procedure:
• New function, SetContextValueForLine. Derives Descriptive FlexField (DFF) content for an 

invoice line. This is only applicable for Oracle R12 environments when the DFM is created with 
the DFM_FIELD_DFF field enabled.

• New Procedure, PopulateSegmentForLine. Populates DFF segments for a distribution 
line. This is only applicable for Oracle R12 environments when the DFM is created with the 
DFM_FIELD_DFF field enabled.

• MVERP_DFM_CUSTOM: This package has new procedures and a new function.
• New function, GetDefaultAccountForLine. Gets the default concatenated account segments 

whenever the amount is entered on an invoice line and the account has not already been 
entered. This is only applicable for Oracle R12 environments when the DFM has been created 
with UseProjects set to FALSE.

• New procedures, SetLineTypeDefaultsForLine and SetLineTypeDefaults. Set the default 
values for the Tax fields when the Line Type of an invoice line or a distribution line changed. 
This is only applicable for Oracle environments when the DFM has been created with 
EnableLineTypeDefaults set to TRUE.

• New procedure, SetProjectDefaultsForLine. Sets the default values for additional project-
related fields when the Project has been changed on an invoice line. This is only applicable for 
Oracle R12 environments when the DFM has been created with UseProjects set to TRUE.

• New procedure, ValidateInvoiceLine. Performs custom validation on an invoice line. This 
procedure cannot change values on an invoice line. This is only applicable for Oracle R12 
environments.
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• MVERP_DFM_LOV_CUSTOM: This package has a new procedure.
• New procedure, PopulateFlexSegmentForLine. Populates LOV for flex segment values for an 

invoice line. This is only applicable for Oracle R12 environments when the DFM is created with 
the DFM_FIELD_DFF field enabled.

Check for invalid packages
1. Log in as the MarkView database user.
2. Enter the following SQL statement:

SELECT OBJECT_NAME, OBJECT_TYPE FROM USER_OBJECTS WHERE STATUS 
      = 'INVALID';

 Systems with Self-Service Invoice (SSI) display invalid package messages until the SSI 
upgrade is complete. This is expected behavior and not an error.

3. If invalid database objects exist, save the output from the SQL statement and run 
@gencomp.sql in <distribution_directory>\installer\scripts, where
<distribution_directory> is the location where you downloaded and decompressed the 
installation files.
A message similar to the following appears:
Recursively compiling 2 object(s).
Please wait...
All objects compiled successfully.

4. Review the information in the COMPILE.LOG. If the message says that it is recursively 
compiling more than 0 objects, rerun @gencomp.sql. Dependencies between objects can 
require more than one execution to complete compilations successfully before the other 
completes compilations.

5. If any objects still fail to compile, run SQL*Plus SHOW ERRORS to view the error messages. Use 
the following format for this command:
SHOW ERRORS { FUNCTION | PROCEDURE | PACKAGE | PACKAGE BODY | TRIGGER | VIEW }  
 name

For example, to view the PL/SQL errors for the package body 
MVERP_DFM_DESCR_FLEX_CUSTOM, enter:
SQL> SHOW ERRORS PACKAGE BODY MVERP_DFM_DESCR_FLEX_CUSTOM

The errors that occurred during compilation of the object are displayed.

Configure MarkView to use the Oracle Wallet (for SSL only)
Skip this section if you do not use SSL to provide secure web communications for the application 
server.

1. Log in to MarkView and navigate to Administration > MarkView Admin.
2. Select the Preferences tab.
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3. Locate and change the settings for the following preferences:

a. Set SECURITY_SSL_WALLET_LOCATION to <WalletFolder>.

b. Set SECURITY_SSL_WALLET_PASSWORD to <WalletPasswd>.
For information about the values, see Add SSL certificate to Oracle Wallet (for SSL only).

Verify access to Document Server
To verify the access:
• If you are moving your application server, verify that the OS user running the MarkView 

application server can access the Document Server directory.
• Verify that you can read and write to your existing Document Server directory. If necessary, copy 

the Document Server directory to a new location. If you copy the directory to a new location, 
update the Volume Path after you upgrade the system. See the Kofax MarkView Administrator's 
Guide, Volume 1 for instructions.

• If the Document Server directory was moved to a new location before MarkView upgrade, update 
the Volume Path after MarkView upgrade. See the Kofax MarkView Administrator's Guide, Volume 1
for instructions.

Verify the system setup
1. Log in to MarkView and navigate to Administration > Verify MarkView.
2. In the Test Folder that opens, click the document icon next to the About MarkView document. 

MarkView Viewer displays the document, which validates that the viewer operates correctly.

 The first time that you try to view a document after upgrade, you may get a null pointer 
exception. If this happens, restart the application server and retry this step.

3. Navigate to Utilities > Process Monitor. Open a configuration to verify that you can view it.
4. Navigate to Utilities > Bar Code Generation and generate a bar code for Supplier Document.

Verify that database jobs are running
1. Log in to MarkView and navigate to Utilities > System Status.
2. Locate DBMS User Jobs Broken.

Status Current 
Value

Limit Over Limit Description

DBMS User Jobs 
Broken

2 0 Y The number of current MarkView database user 
jobs and scheduler jobs that are in error.

Disconnected Bar 
Code Server

1 0 Y Checks v$session to see if the Bar Code server 
has a connection to the database.
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3. Contact Kofax Technical Support if the current value for DBMS User Jobs Broken is greater 
than 0.
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Set up your environment and install 
MarkView Oracle Objects

Follow these steps if you installed MarkView manually. If you installed MarkView Oracle Objects in 
silent mode, continue at After you run the installer.

Upgrade MarkView Oracle Objects
Complete the following procedures:
• Download the Oracle Objects installer and Verify files
• Run Verify on the Oracle E-Business Suite host
• Run the MarkView Oracle Objects installer

Download the Oracle Objects installer and Verify files
1. On the Oracle E-Business Suite server, open a command shell and log in as the Oracle E-

Business suite owner. The default account for this user is applmgr.
2. Create a temporary distribution directory for the compressed MarkView installer and 

verification files. For example, <home_directory>/mvforms_dist where <home_directory> is 
the user home directory.

3. In the distribution directory, create these subdirectories:
• <distribution_directory>/verify

• <distribution_directory>/installer

Where <distribution_directory> is the temporary distribution directory you just created.
4. Download the following file into the verify directory (where <version_number> is the MarkView 

version number):
KofaxMarkView-<version_number>_Oracle_Verify.zip (for all hosts)

5. Download the following file into the installer directory (where <version_number> is the 
MarkView version number):
KofaxMarkView-<version_number>_Oracle_Objects.zip

6. Decompress the files.
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Add SSL certificate to the MarkView Oracle Objects installer 
Java truststore (for SSL only)

Skip this section if you do not use SSL to provide secure web communications for the application 
server.

Add the certificate to the MarkView installer Java truststore on the system where you plan to run the 
Oracle Objects installer:

keytool -import -alias <alias> -keystore "<installer_java_home>\jre\lib\security
\cacerts" –file <certificate>

Where:
• <alias> is a keystore entry unique name.
• <certificate> is a file that contains the self-signed certificate or any other certificate received 

from the certificate authority.
If you have a certificate received from the certificate authority, verify that root and intermediate 
certificates from the certification chain are in MarkView installer Java truststore and run the 
indicated command to add the missing certificates.

The default Java certificate authority keystore is cacerts. The default password for cacerts is
<changeit>.

Run Verify on the Oracle E-Business Suite host
Use the information that you entered on the MarkView Installation Worksheet to respond to the 
Verify prompts. Run Verify before upgrading MarkView.

1. On the Oracle E-Business Suite server, open a command shell and log in as the Oracle E-
Business suite owner. The default account for this user is APPLMGR.

2. Ensure that the environment variables are correctly set up:
• $PATH: Confirm the appropriate Java version comes first (or run java –version). For 

the Java version, see the Kofax MarkView Technical Specifications document on the Kofax 
MarkView Product Documentation site.

• $APPL_TOP: Confirm this is the correct instance of Oracle E-Business Suite
• $FORMS_PATH: Confirm that it includes $AU_TOP/resource and $AU_TOP/forms/US.

Also, for more information, see:
• Set locale-sensitive environment variables
• Configure environment variables for WebLogic or Configure environment variables.

3. Ensure that the MarkView application server is running.
4. Navigate to <distribution_directory>/verify/bin, where <distribution_directory> is the 

location where you downloaded and decompressed the installation files.
5. Run Verify:

• On Unix, enter ./verify_oracle_objects.sh.
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• On Windows, enter verify_oracle_objects.bat.
6. Select the products you are planning to install with the Oracle Objects installer.

• Oracle Forms Integration
• OA Framework Integration for AP
• OA Framework Integration for Expense (only if you are running MarkView for Expense 

Management)

Consider these points when you select products:
• Only systems running Oracle EBS 12.x that also include MarkView for Account Payables can 

select OA Framework Integration for AP.
• Only systems running MarkView for Expense Management can select OA Framework 

Integration for Expense.
7. Follow the prompts.
8. Review the generated reports. The reports are located in the MarkView installation directory 

you selected during the verification. Save these logs in another directory to prevent overwriting 
them.
The file reports/EnvironmentReport.txt describes issues with your environment that will 
prevent successful installation.

9. Make changes as indicated in the failure reports. You are now ready to upgrade.

Run the MarkView Oracle Objects installer
To run the installer:

1. On the Oracle E-Business Suite server, open a command shell and log in as the Oracle E-
Business suite owner. The default account for this user is applmgr.

2. Make sure that all environment variables are correctly set up for this account, check:
• $PATH: Confirm the appropriate Java version comes first (or run java –version). For 

the Java version, see the Kofax MarkView Technical Specifications document on the Kofax 
MarkView Product Documentation site.

• $APPL_TOP: Confirm this is the correct instance of Oracle E-Business Suite
• $FORMS_PATH: Confirm that it includes $AU_TOP/resource and $AU_TOP/forms/US.

3. Ensure that the application server is running.
4. Navigate to <distribution_directory>/installer/bin, where <distribution_directory> is 

the temporary distribution directory.
5. Start the installer by running either:

• For Unix: ./install.sh
• For Windows: install.bat

6. Select the applications to install. Available choices are:
• Oracle Forms Integration
• OA Framework Integration for AP
• OA Framework Integration for Expense
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Consider the following when selecting products:
• Only systems running Oracle Release 12 that also include MarkView for Account Payables 

can select OA Framework Integration for AP.
• Only systems running MarkView for Expense Management can select OA Framework 

Integration for Expense.
7. Click Next.
8. Select Standard Full Install and click Next.
9. Click Select Folder to navigate to the MarkView installation directory and click Next.

10. Enter your MarkView schema password and click Next.
11. Enter your Oracle Applications schema password and click Next.

The order and appearance of the next few steps vary depending on the installation options.
12. Review the values displayed and click Next:

• Location of APPL_TOP value: Confirm this is the instance of Oracle E-Business Suite where 
you want to install Forms.

• Location of AU_TOP and FND_TOP values: Confirm this is the instance of Oracle E-Business 
Suite where you want to install Forms (both directories should be under $APPL_TOP).

• Location of $c_MARKVIEW_TOP value: It should be the value you set up in the Pre-Install 
steps.

13. Verify the Oracle Framework Environment Variable values APPL_TOP, COMMON_TOP, and 
JAVA_TOP and click Next.

14. Review the Summary and click Next.
15. Click Install.

The process can take several minutes. To track the progress, click Show Details.
The installation finishes with a message indicating whether the installation is successful.
The installation script creates log files in the MarkView installation directory.

16. Click Exit.

After you run the installer
You must restart the application server processes to pick up the new components.

Oracle R12:

$ADMIN_SCRIPTS_HOME/adapcctl.sh stop
$ADMIN_SCRIPTS_HOME/adoacorectl.sh stop
$ADMIN_SCRIPTS_HOME/adapcctl.sh start
$ADMIN_SCRIPTS_HOME/adoacorectl.sh start

Oracle 12.2:

$ADMIN_SCRIPTS_HOME/adapcctl.sh stop
$ADMIN_SCRIPTS_HOME/admanagedsrvctl.sh stop oacore_server1
$ADMIN_SCRIPTS_HOME/adapcctl.sh start
$ADMIN_SCRIPTS_HOME/admanagedsrvctl.sh start oacore_server1
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Chapter 7

Configure Oracle Forms

If you have made customizations to the CUSTOM.pll file, follow the steps in this chapter:
• Verify the environment (Oracle EBS 12.2 only)
• Set up the Oracle Forms environment variables
• Start Oracle Forms Builder
• Update the custom library (CUSTOM.pll)
• Synchronize the run and patch file systems (Oracle EBS 12.2 only)

Verify the environment (Oracle EBS 12.2 only)
Follow these steps if you are integrating MarkView with Oracle E-Business Suite 12.2 or higher

When configuring Oracle Forms, run any shell commands on the run file system.
1. On the Oracle E-Business Suite server, open a command shell and log in as the Oracle E-

Business Suite owner.
The default account for this user is applmgr.

2. Source the run file system environment file.
For example, from a UNIX shell, run the following command:
$ source $APPL_TOP/../../../EBSapps.env run

3. Verify that the environment is properly set by examining the relevant environment variable.
For example, from a UNIX shell, run the following command:
$ echo $FILE_EDITION  
    run

Set up the Oracle Forms environment variables
Before launching Oracle Forms Builder, set environment variables. Log in to the Forms host as a 
user with write privileges in the $APPL_TOP directory (for example, applmgr).

Oracle Forms Builder must run through a windowing system. Initiate this session on a desktop 
environment or from an X Windows client.

For X Windows clients, set the DISPLAY environment variable to the IP address of your local 
machine. For example:

export DISPLAY=xxx.xxx.xxx.xxx:0
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The $APPL_TOP directory contains configuration files which have the suffix .env and set 
environment variables. These environment variables must be set properly so you can compile forms 
and libraries.

Before invoking Oracle Forms Builder, nvoke the appropriate configuration file to establish the 
proper working environment. Use the shell command that runs scripts or batch files in your current 
environment:
• C shell: source APPS<sid>_<hostname>.env
• KornShell: APPS<sid>_<hostname>.env

where <sid> is the database SID and <hostname> is the server name.

The configuration file establishes several environment variables, including the following:

Variable What it Holds

APPL_TOP The name of the directory where the configuration files reside.

FORMS_PATH in R12.x One or more directories required to compile forms and libraries.

AU_TOP The source code for all forms.

To verify FORMS_PATH:
1. Check FORMS_PATH to make sure that it includes $AU_TOP/resource.
2. Oracle Forms Builder must have $AU_TOP/forms/US in its path. Either:

• Launch Oracle Forms Builder from the directory $AU_TOP/forms/US.
• Set the variable FORMS_PATH to include $AU_TOP/forms/US.

Start Oracle Forms Builder
Before running the Oracle Forms Builder installer, verify that the Java version on the system 
matches the Oracle EBS Java (32-bit or 64-bit versions).

To start Oracle Forms Builder for Oracle Release 12, enter the following command in a shell:

frmbld

Update the custom library (CUSTOM.pll)
The custom library (CUSTOM.pll) is an Oracle Forms library shipped with Oracle Applications. The 
custom library is attached to all forms in the E-Business Suite. As shipped by Oracle, this library 
performs no functions, but provides callouts for custom logic.

The MarkView installer overwrites CUSTOM.pll to integrate it with MarkView. Therefore, if you added 
your own customizations to CUSTOM.pll, restore the version of CUSTOM.pll that contains your 
modifications and manually add the MarkView integration code.
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Step 1: Back up the active CUSTOM.pll and CUSTOM.plx files
Back up the active versions of the CUSTOM.pll and CUSTOM.plx files before you restore the 
modified CUSTOM.pll file.

1. Create the following directory (if it does not already exist):
$c_MARKVIEW_TOP/MVOA/<version_number>/restore

where <version_number> is the Oracle version number.
2. Copy:

$AU_TOP/resource/CUSTOM.plx

to:
$c_MARKVIEW_TOP/MVOA/<version_number>/restore

3. Copy:
$AU_TOP/resource/CUSTOM.pll

to:
$c_MARKVIEW_TOP/MVOA/<version_number>/restore

Step 2: Restore the modified CUSTOM.pll file
If you did not modify the CUSTOM.pll file, skip this step and proceed to Step 3: Open CUSTOM.pll for 
editing on page 83.

If you added your own customizations to CUSTOM.pll, restore the version of the file that contains 
your changes. The MarkView installer creates restore directories with both CUSTOM.pll and 
CUSTOM.plx files in

$c_MARKVIEW_TOP/MVOA/<version_number>/Restore_<timestamp>

where <version_number> is the Oracle version number, and <timestamp> is the date and time when 
the MarkView installer ran.

1. Locate the original CUSTOM.pll file in $c_MARKVIEW_TOP/MVOA/<version_number>/
Restore_<timestamp>.
If multiple restore directories exist, use the directory which contains the most recent version of 
your modified files.

2. Copy:
$c_MARKVIEW_TOP/MVOA/<version_number>/Restore_<timestamp>/CUSTOM.pll

to:
$c_MARKVIEW_TOP/MVOA/<version_number>/libraries/

Step 3: Open CUSTOM.pll for editing
1. Start Oracle Forms Builder as described in Start Oracle Forms Builder on page 82.
2. Connect to the Oracle APPS database schema.

a. Select File > Connect.
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b. Enter the Oracle APPS database user, password, and connect string (the same credentials 
specified during MarkView for Oracle Applications installation).

3. Select File > Open and open:
$c_MARKVIEW_TOP/MVOA/<version_number>/libraries/CUSTOM.pll

where <version_number> is the Oracle version number.
The name of the library, CUSTOM, appears under PL/SQL Libraries in the navigation tree.

Step 4: Attach libraries (customized versions of CUSTOM.pll only)
If you did not customize CUSTOM.pll, skip this step and proceed to Step 5: Edit the zoom_available 
and style functions and the event procedure on page 84. If you customized CUSTOM.pll, 
manually attach the following MarkView libraries to CUSTOM.pll:
• MVOAUTIL.pll
• MVVIEWER.pll
• MVFOLDER.pll
• SFAPI.pll

1. In the Object Navigator, expand PL/SQL Libraries > CUSTOM and select Attached Libraries.
2. Click the plus sign + button in the toolbar to create a new attached library.

The Attach Library window opens.
3. Click Browse.

The PL/SQL Library File window opens.
4. Navigate to $AU_TOP/resource and select MVOAUTIL.pll.
5. Click OK.

The PL/SQL Library File window closes.
6. Click Attach.
7. Repeat these steps for MVVIEWER.pll, MVFOLDER.pll, and SFAPI.pll.

All four attached libraries are visible under Attached Libraries in the tree.

Step 5: Edit the zoom_available and style functions and the event 
procedure

The following changes modify zoom_available, style, and event so that they call the MVOAUTIL 
library. Since these modifications require some additional analysis, contact Kofax Technical Support 
before you make these changes to CUSTOM.pll.

1. In the Object Navigator, expand PL/SQL Libraries > CUSTOM > Program Units and select
CUSTOM* (Package Body)@.

2. Right-click and select PL/SQL Editor.
3. In the function zoom_available section, comment out any existing return lines, such as:

# return(FALSE);

4. Add the following code to the function zoom_available section immediately before the end 
line:
return(MVOA_Util.Zoom_Available);
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5. In the function style section, comment out any existing return lines, such as:
# return(FALSE);

6. Add the following code to the end of the function style section immediately before the end 
line:
return(MVOA_Util.Zoom_Style);

7. In the procedure event section, comment out any existing return lines, for example:
# return(FALSE);

8. Add the following code to the end of the procedure event section immediately before the end 
line:
MVOA_Util.Event(event_name);
if ( (GET_APPLICATION_PROPERTY(Current_Form_Name) ='APXXXEER'  
or GET_APPLICATION_PROPERTY(Current_Form_Name) = 'SFXIISIM'
or GET_APPLICATION_PROPERTY(Current_Form_Name) ='APXINWKB')  
and event_name = 'ZOOM') then
execute_trigger('WHEN-WINDOW-ACTIVATED');
end if;

9. Select File > Save and close the PL/SQL Editor.

Step 6: Compile and copy CUSTOM.pll
1. Using Oracle Forms generator, issue the following command to compile CUSTOM.pll into 

CUSTOM.plx. In this command, <version_number> is the Oracle version number:

 These commands must be run on a single line. If you cut and paste from this guide, 
remove any line breaks and update the version number.

Oracle R12
frmcmp userid=apps/apps-pw@connectstring module=$c_MARKVIEW_TOP/MVOA/  
<version_number>/libraries/CUSTOM.pll module_type=LIBRARY compile_all=YES

2. Copy:
$c_MARKVIEW_TOP/MVOA/<version_number>/libraries/CUSTOM.pll

to:
$AU_TOP/resource

where <version_number> is the Oracle version number.
3. Copy:

$c_MARKVIEW_TOP/MVOA/<version_number>/libraries/CUSTOM.plx

to:
$AU_TOP/resource

where <version_number> is the Oracle version number.

Synchronize the run and patch file systems (Oracle EBS 12.2 
only)

Follow these steps if you are integrating MarkView with Oracle E-Business Suite 12.2 or higher.
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Proceed to one of the following procedures to synchronize the MarkView files between the run and 
patch file systems:
• Synchronize the MarkView files using adop phase=fs_clone command

The file systems synchronization with adop phase=fs_clone command requires a large amount 
of free disk space to be available for adop operations. The synchronization procedure is time-
consuming. For more information about space requirements, refer to the Oracle documentation.

• Synchronize the MarkView files using custom synchronization driver (for UNIX only)
This procedure requires less time and disk space compared to the synchronization using adop 
phase=fs_clone.

Synchronize the MarkView files using adop phase=fs_clone command
If you configured Oracle Forms or applied any changes to the Oracle Forms, do the following:

1. Before synchronizing the run and patch file systems, verify that no patching cycle is currently 
active.
For example, from a UNIX shell, run the following command:
$ adop -status

2. To propagate the changes to the secondary file system, run the following command:
 $ adop phase=fs_clone

adop phase=fs_clone command recreates the patch edition file system as an exact copy of 
the run edition file system.

3. For more information about using the Oracle adop (the AD Online Patching) utility, refer to the 
Oracle adop utility documentation.

Synchronize the MarkView files using custom synchronization driver (for 
UNIX only)

If you configured Oracle Forms or applied any changes to the Oracle Forms, do the following:
1. Before synchronizing the run and patch file systems, verify that no patching cycle is currently 

active.
For example, from a UNIX shell, run the following command:
$ adop -status

2. In <distribution_directory>\installer\tools, locate the copy_mv_objects.sh shell 
script,
where <distribution_directory> is the location where you downloaded and decompressed the 
installation files.

3. Copy copy_mv_objects.sh to: $APPL_TOP_NE/ad/custom/
Verify that the copied script has the Execute permissions.

4. In $APPL_TOP_NE/ad/custom/adop_sync.drv, add the following line between #Begin 
Customization and #End Customization:
sh %s_ne_base%/EBSapps/appl/ad/custom/copy_mv_objects.sh 
      %s_current_base% %s_other_base%

Next time you start a new patching cycle with the adop phase=prepare command, the 
MarkView files will be synchronized between the file systems.
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 The files will be automatically synchronized between the file systems each time you start a new 
patching cycle with the adop phase=prepare command.

If you do not want to propagate any subsequent changes in the MarkView files (for example, 
temporary changes in the customized Oracle Forms) from the run file system to the patch file 
system, comment out the added line in $APPL_TOP_NE/ad/custom/adop_sync.drv to stop 
synchronization.
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Chapter 8

Capture and Output modules

For more information about the MarkView Capture and Output modules, see the following 
documents on the Kofax MarkView Product Documentation site:
• Kofax MarkView Planning Guide
• Kofax MarkView Technical Specifications.

Upgrade each Capture and Output module separately.

About upgrading Data Export Server for Kofax Transformation 
Modules

The Data Export Server provides data from Oracle and MarkView to Kofax Transformation Modules 
for validation and is required for MarkView AP.

Upgrade the Data Export Server on all machines running Kofax Transformation Modules. That 
assumes the export data services are installed on the Kofax Transformation Modules server. Usually, 
the export data services are installed on the Capture server as a part of the MarkView Capture and 
Output components and accessible via UNC path.

Before you start
Upgrade MarkView Application Server and Database components before you upgrade  any Capture 
and Output module. For more information, see Run the MarkView installer on page 64.

Download and extract the installer and Verify files
Download the compressed MarkView System setup files from the Kofax Fulfillment Site.

To access the files:
1. Log in as the local administrator for the operating system for the Windows Capture and Output 

server.
2. Create a temporary distribution directory for the compressed MarkView installer file, for 

example, C:\mvcodist.
3. Download the following file into the distribution directory:

KofaxMarkView-<version_number>_Capture_Output.zip
4. Extract the file.

88

https://docshield.kofax.com/Portal/Products/en_US/MarkView/10.5.0-yw2qf8m7r6/MarkView.htm
https://delivery.kofax.com/


Kofax MarkView Upgrade Guide for Oracle E-Business Suite

 The built-in ZIP utilities in certain versions of Windows have issues with lengthy directory 
paths. Use a third-party extraction utility if your directory paths are more than 200 characters 
long.

Install Oracle Database 19c Client (19.3) for Microsoft Windows
For the Oracle Data Access Components supported, see "Required Third-Party Technologies" in the
Kofax MarkView Technical Specifications document. Look at the table and select between the 32-bit or 
64-bit version.

If you plan to integrate with Kofax Capture and Kofax Transformation Modules on Windows Server 
2019, complete the following procedure.

1. Install Oracle Database 19c Client (19.x) (ODAC).

a. Run the installer.

b. Select the Custom installation type.

c. On the Available Product Components page, select the following components.
• Oracle ODBC Driver.
• Oracle Provider for OLE DB.
• Oracle Data Provider for .NET.

d. Install the product.
2. If you installed ODAC Xcopy version, register Oracle.DataAccess.dll in the GAC by running the 

following commands:
OraProvCfg.exe /action:gac /providerpath:<oracle_client>\odp.net\bin
\4\Oracle.DataAccess.dll
OraProvCfg.exe /action:config /force /product:odp /frameworkversion:v4.0.30319
/providerpath:<oracle_client>\odp.net\bin\4\Oracle.DataAccess.dll

3. If you installed ODAC Xcopy version and you encounter problems with database connectivity, 
run the following commands to register Oracle products in the GAC manually.
cd <oracle_client>\odp.net\bin\4

OraProvCfg.exe /action:ungac /providerpath:<oracle_client>\odp.net\bin
\4\Oracle.DataAccess.dll

OraProvCfg.exe /action:ungac
/providerpath:<oracle_client>\odp.net\PublisherPolicy
\4\Policy.4.112.Oracle.DataAccess.dll

OraProvCfg.exe /action:ungac
/providerpath:<oracle_client>\odp.net\PublisherPolicy
\4\Policy.4.121.Oracle.DataAccess.dll

cd <oracle_client>\odp.net\bin\4

OraProvCfg.exe /action:gac /providerpath:<oracle_client>odp.net\bin
\4\Oracle.DataAccess.dll

OraProvCfg.exe /action:gac
/providerpath:<oracle_client>\odp.net\PublisherPolicy
\4\Policy.4.112.Oracle.DataAccess.dll

OraProvCfg.exe /action:gac
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/providerpath:<oracle_client>\odp.net\PublisherPolicy
\4\Policy.4.121.Oracle.DataAccess.dll

cd <oracle_client>\odp.net\bin\2.x

OraProvCfg.exe /action:ungac /providerpath:<oracle_client>\odp.net\bin\2.x
\Oracle.DataAccess.dll

OraProvCfg.exe /action:ungac
/providerpath:<oracle_client>\odp.net\PublisherPolicy\2.x
\Policy.2.102.Oracle.DataAccess.dll

OraProvCfg.exe /action:ungac
/providerpath:<oracle_client>\odp.net\PublisherPolicy\2.x
\Policy.2.111.Oracle.DataAccess.dll

OraProvCfg.exe /action:ungac
/providerpath:<oracle_client>\odp.net\PublisherPolicy\2.x
\Policy.2.112.Oracle.DataAccess.dll

OraProvCfg.exe /action:ungac
/providerpath:<oracle_client>\odp.net\PublisherPolicy\2.x
\Policy.2.121.Oracle.DataAccess.dll

cd <oracle_client>\odp.net\bin\2.x

OraProvCfg.exe /action:gac /providerpath:<oracle_client>\odp.net\bin\2.x
\Oracle.DataAccess.dll

OraProvCfg.exe /action:gac
/providerpath:<oracle_client>\odp.net\PublisherPolicy\2.x
\Policy.2.102.Oracle.DataAccess.dll

OraProvCfg.exe /action:gac
/providerpath:<oracle_client>\odp.net\PublisherPolicy\2.x
\Policy.2.111.Oracle.DataAccess.dll

OraProvCfg.exe /action:gac
/providerpath:<oracle_client>\odp.net\PublisherPolicy\2.x
\Policy.2.112.Oracle.DataAccess.dll

OraProvCfg.exe /action:gac
/providerpath:<oracle_client>\odp.net\PublisherPolicy\2.x
\Policy.2.121.Oracle.DataAccess.dll

Where <oracle_client> is the Oracle Database 19c Client installation folder.

 Some Windows folders (such as C:\Users\<USER NAME>) may be protected and have 
permission restrictions.
Folder location values that contain spaces must be enclosed in double quotation marks. 
Example: "C:\oracle client\network\admin".

Customize the tnsnames.ora file
Your tnsnames.ora file is an Oracle DBMS file that specifies the names and locations of your 
databases. MarkView uses the information to communicate with the database. A template 
tnsnames.ora file is installed with the Oracle components.

Edit the template tnsnames.ora file to:
• Refer to the correct databases
• Contain the name and location of your Oracle DBMS
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 Edit tnsnames.ora for each instance of ODAC installed on your system.

Bar Code and Mail Gateway prerequisites
Kofax VirtualReScan (VRS) includes a bar code reader. Determine whether you need to install VRS 
separately:
• If you are installing Bar Code Server on a system with Kofax Capture, you do not need to install 

VRS separately. VRS is installed silently as part of all Kofax Capture installations.
• If you are installing Bar Code Server on a system without Kofax Capture, install VRS. See the Kofax 

VirtualReScan (VRS) Installation Guide for information about installing VRS. For a list of supported 
versions, see the Kofax MarkView Technical Specifications document on the Kofax MarkView 
Product Documentation site.

Upgrade Capture and Output modules
Upgrade each Capture and Output module separately.

1. Stop MarkView Capture and Output server components before upgrading.
2. Log in as the local administrator for the operating system for the Windows Capture and Output 

server.
3. Navigate to <distribution_directory> and run one of the available installers: 

MVBarcodeServer.Installer.msi, MVDataExport.Installer.msi, MVImport.Installer.msi, or 
sfMailService.Installer.msi.

4. Follow the prompts to upgrade the components you selected.
5. When prompted to select the upgrade directories, browse to the base directories where the 

Capture and Output components were originally installed.
6. Click Finish on the Maintenance Complete window.
7. Reboot the system to activate the changes.

Configure Capture and Output modules
Follow these steps to configure newly installed instances of the Capture and Output modules. 
Upgrades to existing instances of the Capture and Output modules do not require reconfiguring. 
After upgrading the existing instances of Data Export Server, Import Server, or Mail Gateway to 
version 10.5.0, reenter your password.

Configure Data Export Server
Follow these steps to configure newly installed instances of Data Export Server. Upgrades to 
existing instances of Data Export Server do not require reconfiguring.

1. Double-click the MV Data Export Server - Configuration shortcut on your desktop.
2. Enter an instance Name that identifies the function that the instance will perform, such as 

Contacts, and click OK.
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3. Select the instance and click Preferences.
4. In the MarkView Data Export Server Preferences window, provide the following:

• Database user: The MarkView schema user
• Database password: The password for the MarkView schema user
• Database host: The TNS alias name that was configured in the TNS names file (such as 

tnsnames.ora) for the database instance of the MarkView schema
5. In the Data Function list, select the data function for the instance.

Data Function Description

Provides vendor information to Kofax Transformation Modules Validation for 
selecting valid vendors/vendor sites to associate with invoices. Each record in this 
data feed is a Supplier Site, so you might have multiple records for Suppliers with 
multiple Sites. Provides the following values for each vendor/vendor site:

Get Vendor

Company
Active/Inactive
Enabled/Disabled
Organization Name/Org Short 
Name
Supplier Site Code
Street Name
Street 2

Street 3
City Name
State
Zip
Phone
Fax
Supplier ID

Supplier Site ID
Org ID
Tax ID 1 (VAT Registration 
Number)
Tax ID2
Bank Code
Bank Account
IBAN

Get Contacts Provides contact information to Kofax Transformation Modules Validation for 
associating contacts with invoices. Provides the following values for each invoice 
approver.
• Last Name
• First Name
• User ID

Each invoice approver must have an email address configured for use with 
MarkView.

Provides organization information to Kofax Transformation Modules Validation 
for associating valid organizations with invoices. This data is derived from 
Organizations configured in MarkView; it is not the full list of Organizations 
defined in Oracle Applications. Provides the following values for each 
organization:

Get Organizations

ORGID
ORGNAME
ADDRESSLINE1
ADDRESSLINE2
CITY

REGION
POSTALCODE
COUNTRY
BASECURRENCY

Get Purchase Order 
Numbers

Provides purchase order information to Kofax Transformation Modules Validation 
UI for associating valid purchase orders with invoices. Provides the following 
values for each purchase order:
• Purchase Order #
• PO Type (Blanket or Standard)
• Release Number (for Blanket POs only)
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Data Function Description

Generate Tax 
Regime Feed

Provides tax Regime information for Oracle EBS 12.x (data available is specific to 
the Org of the invoice)

Generate Tax Feed Provides tax code information for Oracle EBS 12.x (data available is specific to the 
Org and Tax Regime of the invoice)

Generate Tax 
Jurisdiction Feed

Provides the Tax Jurisdiction information for Oracle EBS 12.x (data available is 
specific to the Org, Tax Regime, and Tax of the invoice)

Generate Tax 
Status Feed

Provides the Tax Status information for Oracle EBS 12.x (data available is specific 
to the Org, Tax Regime, and Tax of the invoice)

Other Provides custom information for use in the Validation UI.

When you select a data function, MarkView populates the following fields:
• Output folder
• Output file
• XSL Transform

6. Ensure that the Output folder points to the location of the Kofax Transformation Modules 
project file. The default is C:\KTM\MarkView\KTM Source Files\Databases.

7. Set the database polling interval and the connection retry interval, then click OK.
8. Repeat these steps for the remaining functions: Contacts, Vendors, Purchase Orders, and 

Organizations.
9. Open the Windows Service Manager.

10. Specify the startup type (automatic or manual) as follows:

a. Right-click the MarkView service name.

b. Select Properties.

c. In the Startup Type list, select Automatic or Manual.
11. If your configuration requires access to network resources requiring authentication:

a. Right-click the MarkView service name.

b. Select Properties.

c. Select the Log On tab.

d. Log in as a user with access to the network resources.

Configure Bar Code Server and Mail Gateway

Configure the Bar Code Server source
Use the Scanner Configuration Utility to configure a Kofax VirtualReScan (VRS) file import scan 
source and set that source as default. The process depends on your VRS version. See the Kofax 
VirtualReScan (VRS) User Guide for more information.

1. Open Scanner Configuration Utility.
2. If Kofax Software Import Source (no image processing) appears in the list of configured 

sources, remove it.
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3. Configure a file import scan source that uses Image Processing.
4. Set the source you create as the default.

Configure Mail Gateway
To open the Mail Gateway window and configure server instances, double-click the MarkView 
Process Mail Gateway Configuration shortcut on your desktop.

Configure the instance
1. Open MarkView Mail Gateway and click either

• New
OR:

• Preferences.
2. Enter a new instance name and click OK.

The Preferences window, which includes five tabs, opens.
3. Complete the fields on each tab as described in the sections that follow.

Configuration settings take effect the next time you start the service.

Configure monitoring options

The Monitoring tab settings specify which accounts to monitor and how often.
1. Set the following information to complete the tab.

Field Name Description

Process Outbound 
Messages

Select this option to monitor and process outbound mail messages.

Process Inbound 
Messages

Select this option to monitor and process inbound mail messages.

Polling Period (seconds) Set this value to the number of seconds to wait before checking for new 
messages. Mail Gateway processes any messages it finds until none remain 
to process. The gateway waits the duration of the polling period before 
checking again.
Default: 60

2. To continue, do one of the following:
• Select another tab.
• Click OK to confirm your selections and close the window.

Configuration settings take affect the next time you start the service.

Configure error options

The Error tab settings specify the actions that Mail Gateway takes in response to errors.
1. Set the following information to complete the tab.
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Field Name Description

Reconnect on Errors Select this option to have Mail Gateway periodically attempt to reconnect at 
the retry interval specified. Otherwise, Mail Gateway remains disconnected on 
errors and stops the service.
Mail Gateway automatically disconnects from the database and the mail 
system when a database or a mail error occurs.

Error Retry Period 
(minutes)

The number of minutes to wait between retry attempts when reconnecting.
Default: 1

2. To continue, do one of the following:
• Select another tab.
• Click OK to confirm your selections and close the window.

Configuration settings take affect the next time you start the service.

Configure MarkView process options

The MarkView tab specifies which settings to use to connect to the database and the database 
objects to use to process outbound message.

1. Enter the following information to complete the tab.

Field Name Description

Username The name of the database account.

Password The password associated with the database account.

Host The name of the host database as defined in the TNS file.

User ID SQLFLOW_MAIL
This is the user account created to connect to the system for processing inbound 
and outbound messages.

Application 
Function

SQL*Flow Mail Gateway
This is the application function created to retrieve work items for processing 
outbound messages.

Completed 
Action

Sent Outbound Email
This is the action created to retrieve work items for processing outbound messages.

Work Item Class Outbound Email Message
This is the work item class created for outbound messages.

2. Click Test to validate database connectivity.
3. To continue, do one of the following:

• Select another tab.
• Click OK to confirm your selections and close the window.

Configuration settings take effect the next time you start the service.

Configure mail options

Mail tab settings specify which options the gateway uses to send and receive email.
1. Select a protocol which determines the available options.
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2. Complete the tabs for your outbound protocol.

SMTP Outbound Protocol Options

Field or checkbox Value

Protocol SMTP

SSL Enable to use SSL on authentication.

Server Enter the host name or IP address of the SMTP server or servers to use, 
such as SMTP.KOFAX.COM.
To allow Mail Gateway to try multiple mail servers in case of failures, use a 
semicolon to delimit a list of servers.

Port Enter the TCP/IP port on which to communicate with the SMTP server.
Default: 25

Enable authentication Select if your SMTP server requires authentication.

Enable OAuth Select to use OAuth credentials to authenticate without password.
To configure OAuth credentials, click OAuth Credentials.
The credentials set saved as default is automatically applied for any 
protocol with OAuth authentication enabled.
Register Mail Gateway on your OAuth provider site. When you enable 
OAuth, the password is no longer used to access the mailbox, although it 
remains unchanged.

Timeout Specify how many seconds Mail Gateway waits for a response from the 
server before returning an error.
Default: 30

Username If you selected a type of authentication, enter the name of the account to 
use to access the SMTP server.

Password If you selected a type of authentication, enter the password for the 
Username account that accesses the SMTP server.

MAPI Outbound Protocol Options

Field or checkbox Value

Server The host name or IP address of the MAPI server or servers to use.
To allow Mail Gateway to try multiple mail servers in case of failures, use 
semicolons to delimit a list of servers.

Username If the MAPI client requires a user name, enter a user name.
The Microsoft Exchange Inbox client does not require a user name.

Password If the MAPI client requires a password, enter a password.
The Microsoft Exchange Inbox client does not require a password.

3. Click Test Connection to verify your settings.
4. Complete the tabs for your inbound protocol.
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POP Inbound Protocol Options

Field or checkbox Value

Protocol POP

SSL Enable to use SSL on authentication.

Server Enter the host name or IP address of the POP3 server to use.

Port Enter the TCP/IP port on which to communicate with the POP3 server.
Default: 110

Timeout Specify how many seconds Mail Gateway waits for a response from 
the server before returning an error.
Default: 30

Preferred Format Select the message format to use.
Some inbound mail messages may contain the same message in 
both text and HTML formats.

Enable OAuth Select to use OAuth to authenticate without password.
To configure OAuth credentials, click OAuth Credentials.
The credentials set saved as default is automatically applied for any 
protocol with OAuth authentication enabled.
Register Mail Gateway on your OAuth provider site. When you 
enable OAuth, the password is no longer used to access the mailbox, 
although it remains unchanged.

Username Enter the name of the account to use to access the POP3 server.

Password Enter the password for the user name account that accesses the 
POP3 server.

Mailbox Select the folder. The field is disabled for the POP3 server.
Default: Inbox

MAPI Inbound Protocol Options

Field Value

Server If you use the Microsoft Exchange Inbox client, enter the name of the Profile 
you created when you configured the Microsoft Exchange Inbox client
For other MAPI clients, see the client documentation.

Username If the MAPI client requires a user name, enter a user name.
The Microsoft Exchange Inbox client does not require a user name.

Password If the MAPI client requires a password, enter a password.
The Microsoft Exchange Inbox client does not require a password.

IMAP Inbound Protocol Options

Field or checkbox Value

Protocol IMAP
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Field or checkbox Value

SSL Enable to use SSL on authentication.

Server Enter the host name or IP address of the IMAP server to use.

Port Enter the TCP/IP port on which to communicate with the IMAP server.
Default: 143

Enable OAuth Select to use OAuth to authenticate without password.
To configure OAuth credentials, click OAuth Credentials.
The credentials set saved as default is automatically applied for any 
protocol with OAuth authentication enabled.
Register Mail Gateway on your OAuth provider site. When you 
enable OAuth, the password is no longer used to access the mailbox, 
although it remains unchanged.

Timeout Specify how many seconds Mail Gateway waits for a response from 
the server before returning an error.
Default: 30

Preferred Format Select the message format to use.
Some inbound mail messages may contain the same message in 
both text and HTML formats.

Username Enter the name of the account to use to access the IMAP server.

Password Enter the password for the user name account that accesses the 
IMAP server.

Mailbox Select the folder.
Default: Inbox

5. Click Test Connection to perform connection with the current settings.
6. Click OK to confirm your selections and close the window.

For the configuration settings to take affect, restart the service.

Configure OAuth credentials

To use OAuth credentials, you must register Mail Gateway on your OAuth provider site, such as 
Google Developer Console. This is required to enable the application to access your email account 
without the password. If you experience troubles with registering the application on the OAuth 
provider site, contact the OAuth provider customer service.

 We recommend that you create all instances of Mail Gateway before saving OAuth credentials.
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OAuth Credentials UI elements

UI element Value

Client ID The identifier provided to an application during the registration on the 
OAuth provider site.
Example:
Google Client ID: 1072099888437-8q5k7u2ibf1m7r3m3v9lg6j2qgb6h6 
oj.apps.googleusercontent.com

Microsoft Client ID: ba98929d-45ec-4cbd-91af-0ad6f4416fb9

Client Secret The secret code received from the OAuth provider.
This code is specific for an application. Some providers do not use a client 
secret, so the field may be left empty in such a case.
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UI element Value

Authorization URL The URL of the page that a user enters manually to grant access rights to the 
registered application.
This URL should contain the Client ID parameter to enable the "Authorize 
application" button.
Example:
Google Authorization URL: https://accounts.google.com/o/oauth2 
/auth?scope=https%3A%2F%2Fmail.google.com&redirect_uri=urn 
:ietf:wg:oauth:2.0:oob&response_type=code

Microsoft Authorization URL: https://login.microsoftonline.com/6f8 
c8d80-c6d3-4b33-b30a-f45fda35bca5/oauth2/v2.0/authorize?res 
ponse_type=code&redirect_uri=https%3A%2F%2Flogin.microsoft 
online.com%2Fcommon%2Foauth2%2Fnativeclient&response_mod 
e=query&scope=offline_access%20https%3A%2F%2Foutlook.office 
.com%2FIMAP.AccessAsUser.All&state=12345&client_id=aef27f 
c4-7763-465e-8152-cfd3b6fb604b

Append Client ID Click to add your Client ID to the Authorization URL.

Authentication URL The URL that the application uses to perform authentication for operations 
in the service mode.
In the Authentication URL, the values for parameters "scope" and
"redirect_uri" should correspond to the values in the Authorization URL.
Example:
Google Authentication URL: https://accounts.google.com/o/oauth2 
/token?scope=https%3A%2F%2Fmail.google.com&redirect_uri=urn 
:ietf:wg:oauth:2.0:oob

Microsoft Authentication URL: https://login.microsoftonline.com 
/6f8c8d80-c6d3-4b33-b30a-f45fda35bca5/oauth2/v2.0/token?sco 
pe=offline_access%20https%3A%2F%2Foutlook.office.com%2FSMTP 
.Send%20User.Read&redirect_uri=https%3A%2F%2Flogin.microsoft 
online.com%2Fcommon%2Foauth2%2Fnativeclient

Authorize Application Click to perform the provider authorization and get the access tokens. The 
access tokens represent the authorization of an application to access specific 
parts of a user's data.
After you click the button, the Authorize Application window appears. Then, 
the system default browser window appears prompting to authorize the 
application and providing the authorization code. The code is shown on the 
interactive page or is given as a value of the URL parameter after the OAuth 
provider redirects you to the new page. Copy the code without parameters (if 
any) and paste it in the Authorize Application window. Then click Submit to 
pass the code to Mail Gateway.
Example:
In this example, the code is in bold.
login.microsoftonline.com/common/oauth2/nativeclient?
code=0.AX0AgI2Mb9PGM0uzCvRf2jW8pZ2SmLrsRb1Mka8K1vRBb7mcAAA

AgABAAIAAAAmoFfGtYxvRrNriQdPKIZ

&state=12345&session_state=286eff1d-cf79-4172-

8a74-2ba4e3e2ab79
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UI element Value

Status The text in the Status field is self-adjusting depending on the values in other 
fields. For example, once the authorization code is submitted, the Status field 
text is changed.
• READY: The access tokens are received successfully.

The OAuth credentials can be used to connect to the mail service.
• NOT READY: Read the proceeding message to troubleshoot the issue.

The OAuth credentials set cannot be saved.

Save as Default for all 
protocols

Select to share the same tokens among several Mail Gateway instances.
When selected, the current tokens are accessible for every Mail Gateway 
instance.

 If you select "Save as Default for all protocols," you rewrite the 
default credentials for all protocols. All previously configured protocols 
remain unchanged, but their OAuth settings are no longer default.

Use Default Credentials Click to insert the default settings into the OAuth Credentials window fields.

Save Click to store the access tokens.

Cancel Click to discard changes.

Once you save the OAuth credentials, the window is closed and the connection starts using the 
access tokens. To verify the configuration, click Test Connection on the mail configuration tab.

Configure logging options

The Log tab settings specify the types of messages that appear in the Event Log:
• Errors
• Errors and Warnings (Default)
• Errors, Warnings, and Normal Messages

To continue, do one of the following:
• Select another tab.
• Click OK to confirm your selections and close the window.

Configuration settings take affect the next time you start the service.

Configure Microsoft Outlook with MAPI protocol for Mail Gateway
If you use the MAPI protocol and use Microsoft Outlook as your MAPI client for Mail Gateway, 
disable the Outlook Email Security Update option in Microsoft Outlook. The security update 
prevents Microsoft Outlook from operating as a MAPI client through a Windows NT Service. The 
Outlook Email Security Update is built into Outlook 2002 and higher and is an optional update to 
older versions of Outlook.
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Configure Mail Gateway to support invoice approval and rejection by 
email
Configuration settings take affect the next time you start the service.

Set up the Outbound instance
1. Double-click the MarkView Process Mail Gateway Configuration shortcut on your desktop.
2. In the MV Mail Gateway window, create a new OUTBOUND instance and click Preferences.
3. Click the Monitoring tab and do the following:

a. Enable Process Outbound Messages.

b. Clear Process Inbound Message.

c. Set the Polling Period (seconds) to 30.
4. Click the MarkView tab and complete the Database fields, for example:

• Username: markview
• Password: markview
• Host: r4ebsr12.vis01

Where r4ebsr12.vis01 is a TNS name in the TNSNAMES.ORA file for the database connection.
5. Click Test to verify your connection.
6. On the MarkView tab, complete the MarkView Process fields, for example:

• User ID: SQLFLOW_MAIL
• Application Function: SQL*Flow Mail Gateway
• Completed Action: Sent Outbound Email
• Work Item Class: Outbound Email Message

7. Click the Mail tab and complete the Outbound section, for example:
• Protocol: SMTP
• SSL: (if needed)
• Server: smtp.kofax.com
• Port: 25
• Enable authentication: (if needed)
• Timeout: (if needed)
• Username: (if needed for authentication)
• Password: (if needed for authentication)

8. Click Test Connection to verify your settings.
9. Click OK.

Set up the Inbound instance
1. Double-click the MarkView Process Mail Gateway Configuration shortcut on your desktop.
2. In the MV Mail Gateway window, create an INBOUND instance and click Preferences.
3. Click the Monitoring tab and do the following:

a. Clear Process Outbound Messages.
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b. Enable Process Inbound Message.

c. Set the Polling Period (seconds) to 30.

d. Click Test to verify your connection to the host server.
4. Click the MarkView tab and complete the Database fields as follows:

• Username: markview
• Password: markview
• Host: r4ebsr12.vis01

5. Click Test to verify your connection.
6. On the MarkView tab, complete the MarkView Process fields, for example:

• User ID: SQLFLOW_MAIL
• Application Function: SQL*Flow Mail Gateway
• Completed Action: Sent Inbound Email
• Work Item Class: Inbound Email Message

7. Click the Mail tab and complete the Inbound section, for example:
• Protocol: IMAP
• SSL: (if needed)
• Server: imap.gmail.com
• Port: 25
• Enable authentication: (if needed)
• Preferred format: Text
• Username: chorton@gmail.com
• Password: ********
• Mailbox: Inbox

8. Click Test Connection to verify your settings.
9. Click OK.

Enable the feature in MarkView
Once you set up Mail Gateway to support invoice approval and rejection by email, complete the 
following task in MarkView Administration.

1. Log in to MarkView and navigate to Administration > MarkView Admin.
2. Select the Preferences tab.
3. Locate and change the settings for the following preferences:

• MVAP_CONTROL_EMAIL_ADDRESS: Enter an SMTP email address. This is the email address 
from which Mail Gateway sends approval and rejection emails.

• MVAP_ENABLE_APPROVAL_REJECTION_EMAIL: Set to TRUE.
• MVAP_ENABLE_SUCCESS_MESSAGE: Set to TRUE.

Configure Capture and Output services
1. After installation, open the Windows Service Manager.
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2. Specify the startup type (automatic or manual) as follows:

a. Right-click the MarkView service name.

b. Select Properties.

c. In the Startup Type list, select Automatic or Manual.
3. If your Capture and Output configuration requires access to network resources requiring 

authentication:

a. Right-click the MarkView service name.

b. Select Properties.

c. Select the Log On tab.

d. Log in as a user with access to the network resources.

Add SSL certificate to Windows (for SSL only)
Skip this section if you do not use SSL to provide secure web communications for the application 
server.

If you have a self-signed certificate for the application server, add the certificate to Trusted Root 
Certification Authorities of the Windows Computer account or user account.

If you have any other certificate received from the certificate authority, add all root and 
intermediate certificates from the certification chain to Trusted Root Certification Authorities of 
the Windows Computer account or user account.

1. Start the mmc console.
2. On the File menu, click Add/Remove Snap-in.
3. In the Available snap-ins list, select Certificates and click Add.
4. Select the account and expand Certificates.
5. Expand Trusted Root Certification Authorities and click Certificates.
6. Right-click the list on the right and, on the context menu, select All Tasks.
7. Click Import to import the certificates and follow the steps in the Certificate Import Wizard.

Troubleshoot Capture and Output configuration utilities
Windows Security settings may cause issues when running the Capture and Output configuration 
utilities. If you see errors when you run a configuration utility, right-click the desktop shortcut for 
the utility, select the Compatibility tab, and select Run as Administrator to set the access-level 
permanently.

104



Chapter 9

Configure MarkView for Accounts Payable

To configure MarkView for Accounts Payable:

• Configure the Oracle Payables Open Interface import job to move data from the AP Invoice 
Interface tables to the AP Invoice tables.

• Add organizations to MarkView. See  the Kofax MarkView Administrator's Guide, Volume 1.
• Add users to user groups associated with organizations. Either configure AUSS to assign 

MarkView users to user groups associated with organizations (see Set up MarkView users with 
AUSS on page 107) or add the users manually (see the Kofax MarkView Administrator's Guide, 
Volume 1.) Ensure that every MarkView user has a corresponding Oracle HR  record with a valid 
email address. Users without email addresses cannot participate in MarkView workflows.

• Configure an optional default GL account to create dummy lines on a Non-PO Invoice. See
Configure default GL accounts for organizations.

• Update workflow filters. See Update Accounts Payable workflow filters on page 107.
• Change the Execution File Name of the AlertApprovalCheck Concurrent Program Executable.

Configure default GL accounts for organizations
You can configure a default GL account for an organization, which is used to create dummy lines 
on a Non-PO Invoice when it is created in Oracle. Set up default GL accounts in Oracle prior to 
configuring Organizations in MarkView.

1. Log in to MarkView and navigate to Administration > Module Admin.
2. Select the Organizations tab.

The Org Admin window opens.

3. Click Add.
The Org Admin - Create a New Org Record form appears.
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4. In the Org Name list, select the organization to add.

 You cannot add an organization that is not defined in Oracle.

5. Enter a new Org Short Name or accept the default Org Short Name, which MarkView 
populates with the name specified in Oracle. (If you use lowercase letters, MarkView converts 
them to uppercase.)
MarkView uses the Org Short Name to more efficiently retrieve information. An Organization 
Name can have up to 260 characters with spaces and special characters, whereas the Org 
Short Name is limited to 8 alphanumeric characters with no spaces.

6. (Optional) To use the configuration of an existing organization as the configuration for the new 
organization, select an organization under Copy Configuration From.
For example, if your shared service center has 15 organizations that will follow the same 
workflow processes and have the same Sub Types, you can fully define and configure one 
organization and copy that configuration to the other 14 when you add them to MarkView.

7. Click Insert.
8. If you did not use an existing organization as a template, enter a valid default GL account 

number:

a. Click Configuration on the new organization line.
The Preferences window for the organization opens.

b. On the menu on the left, click GL Account, Hierarchy, and Instance.

c. Click Update.
The Update GL Account, Hierarchy, and Instance window for the organization opens.

d. Enter the Default GL Account.

e. Click Update.
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Configure the Oracle Payables Open Interface Import job
Configure the Oracle Payables Open Interface Import job to move data from the AP Invoice 
Interface tables to the AP Invoice tables.

The Payables Open Interface Import job creates the invoices in the Oracle AP Invoice tables after 
Kofax MarkView Export Connector has prepared the invoice and image data. This concurrent 
request can be submitted as a single or recurring request. For MarkView, the key parameters for 
this Payables Open Interface Import concurrent request are:
• Source: MarkView Connector
• Hold Name: 170_SYSTEMS_HOLD
• Hold Reason: 170_SYSTEMS_HOLD

The Hold Name was configured during the installation of MarkView. The default is 
170_SYSTEMS_HOLD. Your hold name may be different. It is also stored as the value of the 
MarkView preference MVAP_170_MARKVIEW_HOLD.

 When configuring and scheduling the Payables Open Interface Import, configure the import 
to apply the 170_SYSTEMS_HOLD during the process. Doing so guarantees that MarkView 
immediately applies the hold to each imported invoice. The hold remains in place until all 
workflow actions are completed and the invoice is ready for payment. Applying the hold prevents 
an imported invoice from circumventing the workflow if a system component malfunctions.

For information about configuring Oracle Payables Open Interface Import jobs, see the Oracle 
documentation.

Update Accounts Payable workflow filters
To ensure that all workflow filters are up-to-date, log in to the database as the MarkView schema 
owner and run the following SQL statement:

begin
SF_Designer.RebuildFilterDispatch;
end;
/
exec SF_Filter_Util.UpdateAllFilterResults;
commit;

 In production environments, this can be a lengthy process.

Set up MarkView users with AUSS
To upgrade from a version of MarkView with configured Automated User Setup and Synchronization 
(AUSS), there is no AUSS-specific upgrade process, you can skip this chapter.
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Automated User Setup and Synchronization (AUSS) maps user Source System Groups to 
corresponding MarkView Groups and Roles through MarkView Profiles. This mapping provides 
MarkView users with privileges required for the tasks they perform in MarkView. Thus, AUSS 
leverages user information from Oracle E-Business Suite or Microsoft Active Directory Service 
without requiring an administrator to manually recreate it in MarkView per each Source System 
user. You can also use MarkView Profiles to add users to default user groups associated with 
organizations.

When integrated with Oracle Source System, ensure that the users to be synchronized have a valid 
email address in their Oracle HR record. Oracle users without email addresses cannot participate in 
MarkView workflows. The user must have an entry in the FND_USER and PER_ALL_PEOPLE_F tables 
in the Oracle APPS database schema. The FND_USER and PER_ALL_PEOPLE_F tables are joined by 
the EMPLOYEE_ID and PERSON_ID fields.

The following table contains terms and definitions used in AUSS.

Term Description

Source System The system from which AUSS loads user information into MarkView. 
Your options are Oracle E-Business Suite (Oracle) and Microsoft Active 
Directory Service (Active Directory).

Source System Group The AUSS term for Oracle Application Responsibilities and Active 
Directory Groups.

MarkView Profile The profile that maps the Source System Groups to MarkView Groups 
and MarkView Roles.

MarkView Group The group that determines user access to MarkView documents and 
related privileges in MarkView.

MarkView Role Workflow functions the user can access.

Oracle Application Responsibility The Oracle Source System Group to which an AUSS administrator maps 
MarkView Profiles.

Active Directory Group The group in the Active Directory server to which an AUSS 
administrator maps. The users in Active Directory are members of 
security groups.

LDAP Search Filters Search filters that select the entries on the LDAP server to be returned 
for a search operation.

LDAP Attributes Mapping Mapping of LDAP user attributes to MarkView user attributes. Set 
Active Directory Attributes to manage Active Directory filter results.

Manually created MarkView user A user created in MarkView by a MarkView administrator.

Source System user A user in the Source System. If the user is synchronized, an account of 
the same user name is created/updated in MarkView.

AUSS managed user Such MarkView user that is subject to synchronization: has or had at 
least one assignment to the Source System Groups added in AUSS 
setup.

Full synchronization AUSS conducts a complete comparison of user accounts in the Source 
System and MarkView.

Initial synchronization AUSS conducts a first-time full synchronization during which user 
information is transferred from the Source System to MarkView.
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Term Description

Incremental synchronization AUSS looks for changes only since the previous synchronization.

AUSS interface
• Current Status: Displays the current AUSS status on near real-time basis. The visual refresh 

occurs every 10 seconds. See Current Status.

• Source System: Accesses Source System Groups information for both Active Directory and 
Oracle. If you use Active Directory as a source system, Source System also displays the Active 
Directory Connection tab, LDAP Search Filters, and LDAP Attributes Mapping. See Source System.
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• MarkView Profiles: Lists available MarkView Profiles. See for a list of the default profiles. See
MarkView Profiles for information about adding, editing, importing and exporting profiles.

• AUSS Options: Opens the window in which you can set up synchronization schedules, set 
passwords, create backup files, configure notifications, and set up queues. See AUSS Options.
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• Synchronization: Enables manual synchronization of user information between AUSS and the 
Source System. See Synchronization.

• Journal: Displays the synchronization process history and changes. See Journal for information 
about the Journal tab.
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Active Directory source system connection information
If you select Active Directory as a source system, you will need to specify the LDAP data.

Use this list as a reference for all fill-in fields in the Source System tab for Active Directory.

Field Description

Active Directory Connection

LDAP connection 
URL

<protocol>://<host>:<port>/<root>

Where:
<protocol> is the LDAP protocol, such as ldap or ldaps
<host> is the LDAP server name or IP address
<port> is the LDAP server port to which AUSS connects. Default: 389
<root> is the root entry of the LDAP server you are connecting to, such as 
dc=AUSS,dc=local

User name LDAP admin user DN (Distinguished Name), such as CN=Administrator, DC=local

Password LDAP admin user password

LDAP Search Filters

User base DN(s) The base Distinguished Name (DN) subtree that is used when searching for user entries 
on the LDAP server.

User search filter Filter string for objectclasses required by AUSS: (objectClass=person)

Group base DN(s) The base Distinguished Name (DN) subtree that is used when searching for group entries 
on the LDAP server.
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Field Description

Group search 
filter

Filter string for objectclasses required by AUSS: (objectClass=group)

LDAP Attributes Mapping
(Objects such as Last Name are described by LDAP attributes. MarkView uses Attributes to filter Active 
Directory users for AUSS.)

User name LDAP user attribute for Common Name (CN) or logon account name (sAMAccountName)

First name LDAP user attribute for first name (givenName)

Last name LDAP user attribute for last name (SN)

Email LDAP user attribute for email address (mail)

Source group LDAP user attribute for user group (memberOf)

Run the MarkView AUSS Setup Wizard
1. Log in to MarkView and navigate to Administration > AUSS Mapping Administration.

The MarkView AUSS Setup Wizard opens.
2. Follow the prompts of the MarkView AUSS Setup Wizard.
3. If you have the AUSS configuration backup file, click the corresponding link to upload it.

With this file, you upload the information about your source system settings, initial user 
options, MarkView profiles, synchronization schedule, and notifications. When prompted to 
select the source system, continue with the previously used source system.
For Active Directory Source System, the backup file fills in the source system connection 
information fields automatically.

4. For Active Directory Source System only: After you fill in the source system connection 
information fields (see Active Directory source system connection information), click Test 
connection.
• If you see an error message, verify if the field settings are correct.
• If the test is successful, click Next and then apply changes.

5. Review the steps to complete the configuration and click Go to AUSS Home.

Configure AUSS
Run the MarkView AUSS Setup Wizard and perform the following tasks to configure AUSS:

1. Configure the source system as described in Source System.
2. Set up the user options. Navigate to AUSS Options > Initial User Options and follow the 

instructions in Initial User Options.
3. Configure MarkView Profiles as described in MarkView Profiles.
4. Set up the synchronization schedule. Navigate to AUSS Options > Sync Schedule and Options

and follow the instructions in Synchronization schedule and options.
5. If you want to run the first synchronization manually, see Synchronize for the first time.
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Source System
Select the source system that you use to supply user data and follow the required configuration 
procedure:
• Microsoft Active Directory Service source system
• Oracle E-Business Suite source system

Microsoft Active Directory Service source system
If you use the Active Directory source system, see Active Directory source system connection 
information for the source system connection details.

1. Log in to MarkView and navigate to Administration > AUSS Mapping Administration.
2. On the Source System tab, open Active Directory Connection, enter or verify the LDAP 

connection information, and click Test connection.
• If you see an error message, confirm the field settings.
• If the test is successful, click Save changes.

3. Open LDAP Search Filters, configure the LDAP search filters using the context sensitive help, 
and click Check filter.
• If you see an error message, confirm the field settings.
• If the test is successful, the search results are displayed.
• Click Save changes.

4. Open LDAP Attribute Mapping, type a user personal information and a source group, and 
click Check mapping.
• If you see an error message, confirm the field settings.
• If the test is successful, click Save changes.

5. Use Source System Groups to limit the scope of AUSS users by selecting specific groups from 
the user's Source Systems.
AUSS allows mapping of the selected groups in Source System with MarkView Profile.

Oracle E-Business Suite source system
If you use the Oracle E-Business Suite source system, add Source System Groups.

1. Log in to MarkView and navigate to Administration > AUSS Mapping Administration.
2. On the Source System Groups tab, click Add Source Groups.
3. In the Application drop-down list, select an application. Available Source Groups are listed.
4. To find a specific source group on the list, in the Filter field, start typing the name.
5. Select Source System Groups that contain MarkView users and click Add selected.
6. Optionally you can remove a previously added Source System Group. In the list, select the 

Source System Group and click Remove.
7. To apply the changes, click Save changes.
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Initial User Options
Use the Initial User Options tab to configure the default setup for all synchronized users.

1. Log in to MarkView and navigate to Administration > AUSS Mapping Administration.
2. On the AUSS Options tab, click Initial User Options.
3. Change the default Initial user password, if required.
4. Select Print queue and Export queue assigned for work item processing.
5. Click Save changes.

MarkView Profiles
The MarkView Profiles screen displays MarkView profiles with configured MarkView Groups and 
Roles.

Use the MarkView Profiles tab to review a brief description of the selected MarkView Profile with the 
list and the count of associated MarkView Groups, MarkView Roles, and Source System Groups.

You can add, delete, or edit profiles. Select a profile to add Source System Groups, MarkView 
Groups, and MarkView Roles and to map multiple groups from User Source Systems to MarkView 
Groups and MarkView Roles.

Create or edit a profile
Edit the existing profiles or create new profiles and map MarkView Groups, Roles, and Source 
Groups before you import users.

1. Log in to MarkView and navigate to Administration > AUSS Mapping Administration.
2. On the MarkView Profiles tab:

• To add a profile, click New.
• To edit a profile, select the profile and click Edit or double-click the profile.

3. To create a new profile, enter the Profile Name and Profile Description and add at least one 
MarkView group or role.

4. Select MarkView Groups:

a. On the MarkView Groups tab, click Add.
The Select MarkView Groups window opens.

b. To find a specific group on the list, in the Filter field, start typing the name.

c. Click Add selected.
5. (Optional) Select Auto-populate MarkView Roles based on MarkView Groups.

When you select Auto-populate, MarkView Roles with the same names as the MarkView User 
Groups are automatically made part of this profile. However, each role name must be unique 
within MarkView.

6. If you did not select Auto-populate, select MarkView Roles now:

a. On the MarkView Roles tab, click Add.
The Select MarkView Roles window opens.

b. To find a specific role on the list, in the Filter field, start typing the name.
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c. Click Add selected.
7. Click Save changes to save the new profile.
8. Select Source Groups:

a. On the Source System Groups tab, click Add.
The Select Source Groups window opens.

b. To find a specific source group on the list, in the Filter field, start typing the name.

c. Click Add selected.

d. Click Save changes to edit the profile.

e. To verify that the source system group is mapped to the profile, navigate to Source 
System > Source System Groups.

MarkView profile export and import
The AUSS Import/Export feature enables bulk updates to profile mappings. An Administrator can:
• Export selected profiles to a comma separated value file (CSV)
• Edit the CSV file.
• Import the updated CSV file into AUSS.

AUSS then processes the imported CSV file and updates the profiles.

CSV file format

The CSV file format is identical for both export and import purposes. The first line of the CSV file 
must be the field names in the order specified later. All fields in the CSV file are required for both 
importing and exporting. All field names and values, except for MarkView Group names, are case 
insensitive.

The following table lists the CSV file fields and their content.

Order .csv Field Name Field Content

1 AUSS Profile Profile name (1–100 single-byte characters)

2 Description Profile description (0–1000 single-byte characters)

3 Source Group Source group name (1–100 single-byte characters)

4 Source Application Source application name

5 Source System Source system type (Oracle or Active Directory)

6 MarkView Group A MarkView group name (1–200 single-byte characters)

7 MarkView Role A MarkView role name (1–200 single-byte characters)

8 User Controllable User controllable flag for MarkView Role (Y or N)

If a profile has multiple associated source groups or MarkView groups and roles, you can add 
additional rows in the CSV file to represent the one-to-many relationship of the MarkView profile to 
its source groups or MarkView groups and roles.
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Tips for CSV files:
• Before you import or export, check your file path to ensure that you have read/write/modify 

access.
• Imported profiles are identified by the name.

• If the profile name does not exist, AUSS adds the new profile name.
• If the profile name exists, AUSS overwrites the profile information with the imported values 

from the CSV file including the mapping for that profile. The values in the CSV file replace the 
values for that profile in the database.

• If a profile name is not in the imported CSV file, AUSS does not make any changes to that 
profile. Importing a CSV file does not delete any profiles.

Export profile CSV files from AUSS

You should be a user in the AUSS Mapping Administrator user group to perform this task.
1. Log in to MarkView and navigate to Administration > AUSS Mapping Administration.
2. On the MarkView Profiles tab, select the MarkView Profiles to export and click Export.

 If you do not select specific profiles, AUSS exports all profile data.

3. Follow the prompts to download the CSV file. Validate the path and file name to ensure that 
you have access to the exported file.

Edit a CSV file
1. Make a backup copy of the exported CSV file. If editing errors exist, you can reimport this 

backup file to revert to the pre-edited profile settings.
2. Open the exported CSV file in Microsoft Excel or a text editor.
3. Edit the profile lines.
4. Save the file as a CSV file. If you save the file in another format, you cannot import the data 

back into AUSS.

Import profile CSV files to AUSS
1. Log in to MarkView and navigate to Administration > AUSS Mapping Administration >

MarkView Profiles.
2. Export your profile data to a backup CSV file. Validate the path and file name to ensure that you 

can recover your backup data.
3. Click Import and select the CSV file to import.
4. Correct any errors reported. See the Troubleshooting AUSS section of the Kofax MarkView 

Administrator's Guide, Volume 1.
5. If no errors exist, the changes made to the CSV file appear in the MarkView Profiles.

Synchronize for the first time
To complete the initial AUSS setup, run the synchronization for the first time. Either follow manual 
steps in this section, or configure AUSS automatic synchronization schedule as described in
Synchronization schedule and options.

1. Log in to MarkView and navigate to Administration > AUSS Mapping Administration.
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2. Ensure that your Source System Group to MarkView Profile mappings are correct and 
complete.

3. On the Synchronization tab, click Synchronize to synchronize users.
The Start Manual Synchronization window opens.

4. In the Start Manual Synchronization window, select Override manually created MarkView 
users if you want to update manually created MarkView users during AUSS synchronization.

 This option determines whether to update manually created users or not. If the option is 
selected and there is a Source System user with the same user name as a manually created 
user, the MarkView user receives assignments in accordance with AUSS mappings and 
loses all the previous assignments that do not match AUSS mappings. Such overridden user 
becomes managed by AUSS in subsequent synchronizations. If the option is not enabled, 
AUSS does not update such users. Subsequent incremental synchronizations can also 
override manually created MarkView users with the option enabled, but only for the users 
which AUSS detects as updated since the previous synchronization.
If you will need to override manually created MarkView users at a different time later, you will 
be able to do it by running manual synchronization with both Override manually created 
MarkView users and Force full synchronization options enabled.

5. Select a synchronization method:
• Synchronize all Source System users: For the first-time synchronization, adds all Source 

System users to MarkView even if they do not belong to any Source System Group 
configured in AUSS.

• Synchronize only AUSS managed users: For the first-time synchronization, adds only the 
Source System users that belong to at least one Source System Group configured in AUSS.

6. For the initial synchronization, do not select Force full synchronization.
7. Click Start sync to start synchronization.
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About using AUSS
With Kofax MarkView AUSS, you can map your Source System Group users to corresponding 
MarkView Groups and Roles through MarkView Profiles.

In addition to the AUSS settings specified in Configure AUSS, use the following AUSS options:
• View the information about the current AUSS state and analyze synchronization data in near real 

time.
• Create a backup file with the current AUSS configuration data.
• Reset AUSS configuration and revert to initial setup.
• Enable email notifications about successful or unsuccessful synchronization.
• Configure the synchronization schedule and options.
• Review the synchronization history and track changes.

Current Status
The Current Status screen displays the overview information about the current AUSS state. Select 
the Current Status tab to review and analyze the following near real-time data. The data updates 
every 10 seconds.
• Synchronization Status: Displays current synchronization progress including the AUSS state in 

general (success, failure, or unknown after the first upgrade), the date and time of last successful 
and unsuccessful synchronization with the synchronized users count and the duration of the 
process.
If required, download log files to view the synchronization details.

• Current Synchronization: Displays the information about current synchronization status 
including the percentage value of the process completeness, the start time and duration, 
synchronization options, and the synchronized users count. If sync is started, a user may see the 
process by clicking the link View process log.
During the synchronization process, you may view the process log.

• System Statistics: Displays general information about synchronization statistics including 
MarkView profiles count and source system groups count. Click the corresponding links to review 
the full list of profiles and groups. System Statistics provides the maximum memory data and the 
schedule details. Click Edit schedule to configure the synchronization schedule.
The System Statistics information remains if you clear the configuration.

AUSS Options
Use the following additional options to set up AUSS:
• Set the initial password that users need when logging in to MarkView for the first time on the

Initial User Options tab.
• Define print and export queues to use for AUSS.
• Enable automatic synchronization. See Synchronization schedule and options.
• Back up your current AUSS configuration or reset the configuration information.
• Configure email notifications about successful or failed jobs.
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Configuration Management

In Configuration Management, you can create a backup file with your AUSS configuration data. 
Use this file if you Run the MarkView AUSS Setup Wizard.

The backup file includes the information about a source system, MarkView profiles, a 
synchronization schedule and options, notifications, and initial user options.

Use Configuration Management to delete the AUSS configuration. MarkView AUSS will only keep 
the Journal and System Statistics information. Before you click Reset configuration, verify that you 
backed up your current AUSS configuration.

 Once you click Reset configuration, your Source System Groups, Initial User Options, 
MarkView Profiles, Synchronization Schedule and Options, and Notifications will be deleted.

After you reset the configuration, MarkView AUSS Setup Wizard starts. For details, see Run the 
MarkView AUSS Setup Wizard.

Notifications

Use the AUSS Notifications tab to configure email notifications that indicate if the synchronization 
process is a success or a failure.

To send email notifications, select Enable the Successful Job notification and Enable the Failed 
Job notification. Customize the email address from which notifications are sent, email recipients, 
email subject and content.

The From field is filled in automatically according to the MVFC_OUTBOUND_SMTP_USER preference 
value.

Do not use spaces in the To field for email recipients.

If you enable the Failed Job notification, you can also select the option to attach a log file that does 
not exceed 10 MB to the notification. After you verify the settings, save changes.

After you fill in all required fields, you may type a test email address in the To field and click Verify
to receive the example of notification immediately.
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Synchronization
AUSS synchronization adds new users to MarkView from the source system and updates groups and 
roles to which users are assigned.

The initial AUSS synchronization moves the group and user data from the source system to 
MarkView. AUSS assigns users to the appropriate MarkView Groups and Roles, based on MarkView 
Profile mappings. After running the initial synchronization, you can configure an automatic 
synchronization schedule to keep Source System user changes synchronized with MarkView user 
data and assignments. To enable automatic synchronization, see Synchronization schedule and 
options.

AUSS performs synchronization in one direction only: from the source system to MarkView. Do not 
maintain users in MarkView that you manage with AUSS. Manual changes in MarkView might be 
overwritten the next time you synchronize users.

 If a user record is deleted in your source system, AUSS disables the MarkView user record. 
AUSS does not delete MarkView user records.

If the synchronization is running, the Synchronization window displays manual synchronization 
status, including the time when the process was started, the user who started it, the 
synchronization duration, options, and processed users count. The window also displays the last 
lines of a log file as they appear in a real-time mode. The Synchronize one user and Synchronize
buttons are disabled during the synchronization. If the synchronization is not running, you may 
start the synchronization for a selected user or for all users with the required options.

The synchronization process varies depending on your situation:
• For the first synchronization after a new MarkView installation, see Synchronize for the first time

on page 117.
• For the first synchronization after an upgrade, see Manually synchronize the source system and 

MarkView after initial synchronization on page 122.
• To set up periodic synchronization, see Synchronization schedule and options.

Synchronization schedule and options

Use Sync Schedule and Options to enable automatic synchronization.
1. Log in to MarkView and navigate to Administration > AUSS Mapping Administration.
2. On the AUSS Options tab, click Sync Schedule and Options.
3. Select the required synchronization options from the list.

a. Select or clear Override manually created MarkView users.
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 Scheduled synchronization searches for changes in the source system since the 
previous synchronization. Only users updated since the previous synchronization or 
users that belong to updated Source System Groups are processed during incremental 
synchronization and thus affected by the Override manually created MarkView 
users option. To process all Source System users and override manually created 
MarkView users, run manual synchronization with both the Override manually created 
MarkView users and Force full synchronization options enabled.

b. Select a synchronization method:
• Synchronize all source system users: Adds/modifies all Source System users that were 

added/updated since the previous synchronization or belong to updated Source System 
Groups.

• Synchronize only AUSS managed users: Adds/modifies Source System users that 
belong to updated Source System Groups. Modifies only those updated users who 
already exist in MarkView. For example, if there is a new Source System user added 
since the previous synchronization and this user does not belong to any Source System 
Group managed by AUSS, then this user is not added in MarkView in this case.

4. In the synchronization schedule, select one of the following options and configure the 
synchronization time if required:
• One-Time: In the drop-down list, select the HH:MM value that increments by 30 minutes.

The synchronization starts in HH:MM.
• Daily: In the drop-down list, select the HH:MM value that increments by 30 minutes.

The synchronization starts every day at HH:MM.
• Periodically: In the Time interval (hours) field, specify the time period over which the 

synchronization repeats.
Select the Starting point field if you want to set the time of the day when the 
synchronization starts. The synchronization starts when the next time interval is reached.

• Disable: Select to disable automatic synchronization schedule.
5. Click Save changes to apply the synchronization settings.

Manually synchronize the source system and MarkView after initial 
synchronization

To synchronize MarkView users with AUSS:
1. Log in to MarkView and navigate to Administration > AUSS Mapping Administration.
2. Ensure that your Source System Group to MarkView Profile mappings are correct and 

complete.
3. If you want to synchronize all users manually, navigate to Synchronization and click

Synchronize.

a. Determine whether or not to overwrite your manually created MarkView user information 
with user information from Active Directory or Oracle. If you select Override manually 
created MarkView users, this option replaces the MarkView user information with the 
Source System user information provided that the following conditions are met:
• A user exists in both MarkView and Active Directory or Oracle
• A user is enabled and active in the source system
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To overwrite your MarkView user information, select Override manually created 
MarkView users. The synchronization replaces the MarkView user information with 
the Source System user information for any user who appears in both places. Unless 
you select the Force full synchronization option, AUSS will process only users added/
updated since the previous synchronization or users that belong to updated Source 
System Groups. The Override manually created MarkView users option affects only the 
users to be processed in the current synchronization session.
To keep your existing MarkView user information, clear Override manually created 
MarkView users. The synchronization keeps the MarkView user information for any user 
who appears in both places.

b. Select a synchronization method:
• Synchronize all Source System users: Updates all users that have a valid record in the 

ERP system. For incremental synchronization, adds/modifies all Source System users 
that were added/updated since the previous synchronization or belong to updated 
Source System Groups. For full synchronization, adds/modifies all Source System users 
even if they do not belong to any Source System Group configured in AUSS.

 Full synchronization is performed initially. All subsequent synchronizations are 
incremental, unless you select the Force full synchronization option.

• Synchronize only AUSS managed users: Updates only such Source System users 
that have at least one assignment to a Source System Group. For incremental 
synchronization, adds/modifies Source System users that belong to updated Source 
System Groups. Modifies only the updated users who already exist in MarkView. For full 
synchronization, adds/modifies only the Source System users that belong to at least one 
Source System Group configured in AUSS.

c. Select Force full synchronization if required.


• If the Force full synchronization option is disabled, the synchronization will only 

capture changes since the previous synchronization. If any user information is missing 
and is not re-captured the next time you synchronize, use Force full synchronization
to synchronize all the differences between the source system and MarkView according 
to the current AUSS settings. During the full synchronization AUSS also disables 
all the users who are currently inactive in the source system and removes manual 
assignments to groups and roles for other users.

• If you use Oracle EBS as a source system, with Role Based Access Control (RBAC) 
configured, incremental synchronization will not track Role Hierarchy changes 
correctly because Oracle EBS does not track such changes. For example, if a user 
has Role A and Responsibility B is connected to this role, the user will indirectly have 
Responsibility B and the respective record in the database. However, if Responsibility 
B is deleted from Role A in Role Hierarchy, the respective record for the user 
will not be end-dated but completely removed in Oracle EBS, so incremental 
synchronization will not be able to track such a change. In this case, use the Force 
full synchronization option to synchronize all the differences including indirect 
responsibilities deleted as a result of Role Hierarchy changes.
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4. To manually synchronize a specified user, click Synchronize one user. If you choose this 
type of synchronization, the selected user will be removed from any groups and roles 
manually assigned in MarkView. To remove manual assignments for a MarkView-created 
user (a manually created user with a valid record in the ERP system), also select the Override 
manually created MarkView users option (see Step b below).

a. In the Start User Manual Synchronization window, start typing the name of the user you 
want to synchronize and select the user in the drop-down list.
You can only synchronize one user at a time.

b. Determine whether or not to overwrite your manually created MarkView user information 
with user information from Active Directory or Oracle. If you select Override manually 
created MarkView users, this option replaces the MarkView user information with the 
Source System user information provided that the following conditions are met:
• A user exists in both MarkView and Active Directory or Oracle
• A user is enabled and active in the source system

To overwrite your MarkView user information, select Override manually created 
MarkView users. The synchronization replaces the MarkView user information with the 
Source System user information for any user who appears in both places.
To keep your existing MarkView user information, clear Override manually created 
MarkView users. The synchronization keeps the MarkView user information for any user 
who appears in both places.

5. Click Start sync to start synchronization.

Journal

The Journal tab displays the synchronization history and change tracking.

The Sync History table includes the following data:
• Started by: The user who started the synchronization.
• Result: The actual status of the synchronization. For example, Success.
• Started on: The date and time when the synchronization started.
• Stopped: The date and time when the synchronization ended.
• User count: The number of synchronized users.
• Options: The synchronization method and the Override manually created MarkView users

option selection.
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Use additional Sync History options to refresh the page, to export the information to a XLS file, or 
to remove records.

The Change History table displays:

• Action: Added, Changed, or Deleted
• Area: The area where the change took place.
• Element: The item that was changed. This field can include MarkView Groups and MarkView 

Roles, fill-in fields in AUSS Options.
• Old value: If the item was added, the column is blank.
• New value: If the item was deleted, the column is blank.
• User name: The user who performed the action.
• Date: The date and time when the action was performed.

It may help to troubleshoot some issues. The administrator user can export the information to a XLS 
file.
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Chapter 10

Configure Self-Service Invoice

To configure SSI with MarkView:
• Schedule periodic Payables import scheduling with hold. See Configure the SSI Oracle Payables 

Open Interface job on page 126.
• If you plan to use AUSS to configure your SSI users, use the Self-Service Invoice profile in AUSS.

You can map the Source System Group (the Oracle EBS responsibility) for those users to the Self-
Service Invoice profile. See Configure AUSS on page 113 for information about configuring this 
profile.

• If you do not plan to use AUSS, see the Kofax MarkView Administrator's Guide, Volume 1  to add 
users to the SSI Users group in MarkView.

• If you plan to enable SSI users to submit follow-up documents in email messages, install Kofax 
Import Connector (KIC) with the MarkView system and install an email client on the SSI user's 
client machine.
The SSI_EMAIL_ADDRESS preference points to an address Kofax Import Connector monitors. See 
the Kofax MarkView Administrator's Guide, Volume 1  for information about setting preferences.

• After initial setup, see the Kofax MarkView Administrator's Guide, Volume 1  for information about:
• Setting SSI Preferences: At a minimum, set SSI_EMAIL_ADDRESS and review the default settings 

for
• SSI_FOLLOWUP_REMINDER_01
• SSI_FOLLOWUP_REMINDER_02
• SSI_FOLLOWUP_REMINDER_03

• Setting Invoice Header and Invoice Line field display for SSI invoice requesters.
• Configuring scan and email settings.

Configure the SSI Oracle Payables Open Interface job
Configure the Oracle Payables Open Interface import job to move data from the AP Invoice 
Interface tables to the AP Invoice tables. The Payables Open Interface Import job creates the 
invoices in the Oracle AP Invoice tables after SSI has prepared the invoice and image data. This 
concurrent request can be submitted as a single or recurring request. The key parameters for this 
Payables Open Interface Import concurrent request are:
• Source: MarkView Self-Service Inv
• Hold Name: 170_SYSTEMS_HOLD
• Hold Reason: 170_SYSTEMS_HOLD
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The default Hold Name is 170_SYSTEMS_HOLD. If you changed this value, your hold name may 
be different. See Configure the Oracle Payables Open Interface Import job on page 107 for more 
information.

 When configuring and scheduling the Payables Open Interface Import, configure the import 
to apply the 170_SYSTEMS_HOLD during the process. Doing so guarantees that MarkView 
immediately applies the hold to each imported invoice. The hold remains in place until all 
workflow actions are completed and the invoice is ready for payment. Applying the hold prevents 
an imported invoice from circumventing the workflow if a system component malfunctions.

For information about configuring Oracle Payables Open Interface import jobs, see the Oracle 
documentation.
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Chapter 11

Integration with other Kofax products

After you install MarkView, follow the steps in this chapter to integrate with
• Kofax Capture (KC)
• Kofax Import Connector (KIC)
• Kofax Transformation Modules

Integration with Kofax Capture and Kofax Transformation 
Modules

Kofax MarkView Export Connector enables you to export documents from Kofax Capture to 
MarkView.

Kofax MarkView Export Connector does not support the following:
• Exporting non-image files, PDF files, or OCR full text files
• Using the original file name, as defined for Export Properties in Kofax Capture

Kofax Transformation Modules requires the Data Export Server to provide data from Oracle to Kofax 
Transformation Modules for validation.

Before you  upgrade Kofax MarkView Export Connector, verify that your system meets the minimum 
system requirements. For the version numbers, see the Kofax MarkView Technical Specifications
document on the Kofax MarkView Product Documentation site.

MarkView requires:
• Kofax Capture and 32-bit ODBC drivers

(64-bit ODBC drivers are required for MarkView Capture and Output components version 10.5.0. 
For more information, see the Kofax MarkView Technical Specifications document).

• ODAC with the following required components:
• Oracle Data Provider for .NET
• Oracle Provider for OLE DB

• For transformation, you also need Kofax Transformation Modules

Upgrade Kofax Capture Server on the server, and the Kofax Capture client on all workstations 
before  upgrading Kofax MarkView Export Connector. Before you upgrade Kofax Transformation 
Modules or Kofax Capture, back up your files.
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 MarkView does not support the Kofax Transformation Modules annotation feature. See the 
Kofax Transformation Modules documentation for information about disabling annotation for 
MarkView.

Install Oracle Database 19c Client (19.3) for Microsoft Windows
For the Oracle Data Access Components supported, see "Required Third-Party Technologies" in the
Kofax MarkView Technical Specifications document. Look at the table and select between the 32-bit or 
64-bit version.

If you plan to integrate with Kofax Capture and Kofax Transformation Modules on Windows Server 
2019, complete the following procedure.

1. Install Oracle Database 19c Client (19.x) (ODAC).

a. Run the installer.

b. Select the Custom installation type.

c. On the Available Product Components page, select the following components.
• Oracle ODBC Driver.
• Oracle Provider for OLE DB.
• Oracle Data Provider for .NET.

d. Install the product.
2. If you installed ODAC Xcopy version, register Oracle.DataAccess.dll in the GAC by running the 

following commands:
OraProvCfg.exe /action:gac /providerpath:<oracle_client>\odp.net\bin
\4\Oracle.DataAccess.dll
OraProvCfg.exe /action:config /force /product:odp /frameworkversion:v4.0.30319
/providerpath:<oracle_client>\odp.net\bin\4\Oracle.DataAccess.dll

3. If you installed ODAC Xcopy version and you encounter problems with database connectivity, 
run the following commands to register Oracle products in the GAC manually.
cd <oracle_client>\odp.net\bin\4

OraProvCfg.exe /action:ungac /providerpath:<oracle_client>\odp.net\bin
\4\Oracle.DataAccess.dll

OraProvCfg.exe /action:ungac
/providerpath:<oracle_client>\odp.net\PublisherPolicy
\4\Policy.4.112.Oracle.DataAccess.dll

OraProvCfg.exe /action:ungac
/providerpath:<oracle_client>\odp.net\PublisherPolicy
\4\Policy.4.121.Oracle.DataAccess.dll

cd <oracle_client>\odp.net\bin\4

OraProvCfg.exe /action:gac /providerpath:<oracle_client>odp.net\bin
\4\Oracle.DataAccess.dll

OraProvCfg.exe /action:gac
/providerpath:<oracle_client>\odp.net\PublisherPolicy
\4\Policy.4.112.Oracle.DataAccess.dll

OraProvCfg.exe /action:gac
/providerpath:<oracle_client>\odp.net\PublisherPolicy
\4\Policy.4.121.Oracle.DataAccess.dll
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cd <oracle_client>\odp.net\bin\2.x

OraProvCfg.exe /action:ungac /providerpath:<oracle_client>\odp.net\bin\2.x
\Oracle.DataAccess.dll

OraProvCfg.exe /action:ungac
/providerpath:<oracle_client>\odp.net\PublisherPolicy\2.x
\Policy.2.102.Oracle.DataAccess.dll

OraProvCfg.exe /action:ungac
/providerpath:<oracle_client>\odp.net\PublisherPolicy\2.x
\Policy.2.111.Oracle.DataAccess.dll

OraProvCfg.exe /action:ungac
/providerpath:<oracle_client>\odp.net\PublisherPolicy\2.x
\Policy.2.112.Oracle.DataAccess.dll

OraProvCfg.exe /action:ungac
/providerpath:<oracle_client>\odp.net\PublisherPolicy\2.x
\Policy.2.121.Oracle.DataAccess.dll

cd <oracle_client>\odp.net\bin\2.x

OraProvCfg.exe /action:gac /providerpath:<oracle_client>\odp.net\bin\2.x
\Oracle.DataAccess.dll

OraProvCfg.exe /action:gac
/providerpath:<oracle_client>\odp.net\PublisherPolicy\2.x
\Policy.2.102.Oracle.DataAccess.dll

OraProvCfg.exe /action:gac
/providerpath:<oracle_client>\odp.net\PublisherPolicy\2.x
\Policy.2.111.Oracle.DataAccess.dll

OraProvCfg.exe /action:gac
/providerpath:<oracle_client>\odp.net\PublisherPolicy\2.x
\Policy.2.112.Oracle.DataAccess.dll

OraProvCfg.exe /action:gac
/providerpath:<oracle_client>\odp.net\PublisherPolicy\2.x
\Policy.2.121.Oracle.DataAccess.dll

Where <oracle_client> is the Oracle Database 19c Client installation folder.

 Some Windows folders (such as C:\Users\<USER NAME>) may be protected and have 
permission restrictions.
Folder location values that contain spaces must be enclosed in double quotation marks. 
Example: "C:\oracle client\network\admin".

Upgrade Kofax MarkView Export Connector
Perform the following procedure on all machines running Kofax Capture or Kofax Transformation 
Modules, including all scan and validation stations.

1. Log in as an administrator.
2. If you are upgrading from MarkView 8.0.0.5 or earlier, uninstall the existing version of Kofax 

MarkView Export Connector.
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 If you are upgrading from MarkView 8.0.0.5 or earlier with Kofax Capture 10.1, follow the 
instructions in the Technical Support note to uninstall the existing version of Kofax MarkView 
Export Connector at https://techsupport.kofax.com/knowledge-base/11827.

a. Stop the Kofax Capture Service.

b. On the Windows machines where Kofax Capture is installed, navigate to Control Panel >
Programs and Features.

c. Follow the prompts to uninstall the older version of Kofax MarkView Export Connector. If 
the uninstall opens a command prompt window and appears to be stuck for more than 5 
minutes, close the command prompt window.

3. On the MarkView Application Server host, navigate to the MarkView installation directory, open 
the export-connector folder, and locate the kcec-markview.msi file.
For example: <installation_directory>/export_connector/kcec-markview.msi

4. Copy kcec-markview.msi to a temporary directory on the Windows machine on which Kofax 
Capture is installed.

5. To start the installation, run kcec-markview.msi as Administrator or use the Administrator 
command line.

6. When the installation wizard opens, follow the prompts.
When the installation is complete, a message indicates that Kofax MarkView Export Connector 
was successfully installed.

7. Click Finish.
8. Verify that the Kofax Capture service is running.
9. Repeat these steps on all scan and validation stations.

Set up the ODBC Data source
Configure the ODBC Data source on both the Kofax Transformation Modules server and Kofax 
Capture Network Server (KCNS). If you are not using Kofax Capture Network Server, also configure 
an ODBC data source on each MarkView scan station.

1. Configure a data source using the Microsoft ODBC Administrator application.
• For 32-bit operating systems, start Microsoft ODBC Administrator on the Microsoft Start 

menu.
• For 64-bit operating systems without Kofax Transformation Modules, run \Windows
\SysWOW64\odbcad32.exe to launch the 32-bit version of Microsoft ODBC Administrator.

• For 64-bit operating systems with Kofax Transformation Modules, start Microsoft ODBC 
Administrator on the Microsoft Start menu.

2. In the ODBC Data Source Administrator window, select the System DSN tab.
3. Click Add.

The Create New Data Source window opens.
4. In the list of drivers, select the driver installed by Oracle ODAC, usually Oracle in 

OraClientxxx_home1, and click Finish.
The configuration window opens.
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5. Enter values in the following fields:
• Data Source Name (DSN): Enter the name, such as MarkView. Use this when Prepare the 

Kofax Transformation Modules project template for use.
• Description (optional)
• TNS Service Name: Configure the TNS Service Name and User ID to connect to the 

MarkView schema.
• User ID: Enter a MarkView schema name.

6. Clear Enable Query Timeout.
7. Click Test Connection.

The Oracle ODBC Driver Connect window opens.
8. When prompted, enter the password.

If you see an error message, confirm the field settings.
If the test is successful, you see a Connection Successful message.

9. Click OK to close the success message.
10. Click OK to close the configuration window.

The MarkView Data Source appears in the Data Source Name list. This ODBC connection 
corresponds to a listener running on your database server. Use the DSN to connect.

11. For 64-bit operating systems with Kofax Transformation Modules, you need to also configure 
32-bit ODBC drivers:

a. Run \Windows\SysWOW64\odbcad32.exe to launch the 32-bit version of Microsoft ODBC 
Administrator.

b. Repeat steps 2 through 10 to install and configure 32-bit ODBC drivers.

About MarkView Kofax Transformation Modules Project templates
MarkView automatically installs the project template "MarkView KTM Invoices 50" in C:\KTM
\Markview. When you customize the project, create a new runtime version of the project directory 
that stores the MarkView Kofax Transformation Modules project fpr file and all the files needed for 
the project.

Copy your customized MarkView Kofax Transformation Modules project files to a safe location 
before you upgrade. After you upgrade, refer to your customized project files when you manually 
edit the new project files. Then, save the edited project files in your runtime directory, such as
<MarkView_KTM_project>\MyProject.

Follow the instructions in this section to prepare the project template and batch class templates. 
For more information, see the user documentation for Kofax Transformation Modules and Kofax 
Capture.

Prepare the Kofax Transformation Modules project template for use
1. Ensure that you have a read-write access to the Kofax Transformation Modules project:

a. In Windows, navigate to your Kofax Transformation Modules project folder, such as
<MarkView_KTM_project>.

b. Select the Kofax Transformation Modules project and right-click Properties.
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c. Select the General tab and clear Read-only.

d. Select Apply changes to this folder subfolders and files and click OK.

e. Click OK.
2. Start Kofax Transformation Modules Project Builder.
3. Open the Kofax Transformation Modules project:

a. Select File > Open Project.

b. Locate the MarkView Kofax Transformation Modules Invoices project folder, such as
<MarkView_KTM_project>.

c. Open the MarkView Kofax Transformation Modules Invoices 50 project file.
A warning may appear. Click Close to close the warning. You will address any warnings 
later in this process.

4. Click Save Project As and save the edited project to a new name.
MarkView creates a new directory under <MarkView_KTM_project>, such as
<MarkView_KTM_project>\MyProject and stores the Kofax Transformation Modules project 
fpr file and all the files needed for the project.

5. Select Project > Script Variables and set the following script variables:
• Project type : Enter Oracle.
• Oracle Version : Enter the Oracle version.
• Demo: Select True or False (set to False when connecting to a live MarkView environment).
• DatabaseDataSource: Specify the connection string for the Oracle database where the 

MarkView schema is located in the format of tns_names_entry.SID.
• DatabaseUID: Enter the MarkView schema name.
• DatabasePWD: MarkView database password.

6. For R12 environments, point the TaxCodes database to a blank TaxCodes.txt file.
The data export service properties for TaxCodes do not apply to R12. However, for the Oracle 
R12 environment, you need to point the database to a blank TaxCodes.txt file to prevent Kofax 
Transformation Modules project validation errors.
• Create a blank TaxCodes.txt file in your Kofax Transformation Modules project folder, such as
<MarkView_KTM_project>\KTMSourceFiles\Databases.

• In the Kofax Transformation Modules project, select Project > Project Settings >
Databases.

• Select TaxCodes and click Properties.
• Specify the full path to the blank text file. For example, <MarkView_KTM_project>
\KTMSourceFiles\Databases\TaxCodes.txt.

7. Set the LineItems properties:

a. Select Project > Project Settings.
The Project Settings window opens.

b. Select the Tables tab.

c. In the Table Models area, highlight LineItems and click the Edit Table Model Properties
icon .
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The Properties window opens.

d. In the Visible column, enable the check boxes for the following fields for Oracle EBS 12.x:
• R. Code
• Tax
• Tax Status
• J. Code

e. In the Visible column, clear the check boxes for the following fields for Oracle EBS 12.x:
• Receipt Year
• Service Entry Sheet Number
• Service Entry Sheet Line Number
• Tax Code

f. Click OK to close the window.

g. In the Project Tree panel, navigate to Project > Project Class > Invoice > Fields.

h. Double-click the LineItems field definition or right-click LineItems and select Properties.
The Properties window opens.

i. In the Always Valid column, enable the check boxes for the following fields for Oracle EBS 
12.x:
• Receipt Year
• Service Entry Sheet Number
• Service Entry Sheet Line Number
• Tax Code

j. In the Always Valid column, clear the check boxes for the following fields for Oracle EBS 
12.x:
• R. Code
• Tax
• Tax Status
• J. Code

k. Click OK to close the window.
8. (Optional) If you need to set the default Organization ID value, configure the DefaultOrgId 

variable.
For example, if the Organization ID field is blank, the vendor list is not filtered by Organization 
ID correctly. The DefaultOrgId variable value used by Vendor Locator (VL locator) filters 
vendors.

a. Navigate to Project > Script Variables.

b. In Name, locate DefaultOrgId.

c. For the DefaultOrgId variable, set the appropriate Organization ID value and click OK.
9. (Optional) If you do not want to delete extracted lines for Non-PO and Pre-Approved Invoices, 

in Project > Script Variables, set AfterExtractDeleteLineItems to False and click OK.
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Validate the Kofax Transformation Modules project
1. Select File > Validate Project.

Kofax Transformation Modules displays any error messages related to the project.
2. If you see database validation warning messages, reestablish links in the project to correct the 

database text files.

a. Select Project > Project Settings.

b. Select the Databases tab. Find and correct any database validation issues.
3. If you see library errors, reestablish links in the project to correct the dictionary text files.

a. Select Project > Project Settings.

b. Select the Dictionaries tab.

c. Select the dictionary with validation errors and click Properties.

d. In the Referenced import file box, select the text file of the server with the same name as 
the dictionary (such as <MarkView_KTM_project>\KTM Source Files\Dictionaries
\DocumentType_Validation.txt) and click OK.

e. Click Import to reimport the dictionaries.
4. Repeat the validation until the process no longer generates errors.
5. If you want to change the default online learning folder defined for the Kofax Transformation 

Modules project.

a. Select Project > Project Settings.

b. Select the General tab.

c. Under Online Learning, select Enable online learning.

d. In the Path to online learning box, browse to the appropriate folder (such as C:\KTM
\OnlineLearning_MarkView) and click OK.

6. Select File > Save Project Settings.
7. Click File > Exit to close Project Builder.

About Kofax Capture batch class templates
The following batch class templates are available when imported:
• MarkView Document: Used to separate documents that do not go through Kofax Transformation 

Modules.
• MarkView Invoice: Used to separate documents that go through Kofax Transformation Modules.

The batch class templates are set up with batch fields based on Kofax Capture Values, such as Batch 
Name, Batch ID, Batch Creation Date, Batch Creation Time, and Scan Operator.

Import the batch class templates
1. Log in to Kofax Capture as an administrator.
2. Select Import.
3. In the Open window, select <MarkView_KTM_project>\Markview.cab and click Open.
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4. In the Import/Export window, click OK when the unpacking is completed.
5. In the Import window, click Add All.
6. Select Save duplicates to new name.
7. Click Import.
8. Follow the prompts to save the batch classes to a new name.
9. Click OK when the import is completed.

Prepare the batch class templates
1. Highlight the MarkView Document batch class.
2. Select Properties.
3. On the Separation and Form Identification tab, select Custom. In the list, select MarkView 

Bar Code Separators and click Edit Profile.
The Custom Separation and Form Identification Profiles window opens.

4. Enter the following values:
• Enable Bar Code.
• In the list, select MarkView Bar Code.
• Set Found on stand-alone separator sheet as follows:

• To discard the bar code cover sheet after import, select this option.
• To keep the bar code cover sheet with imported documents, deselect this option.

• In the Search Text field, enter:
^(CP|DT)ID-

• Enable Treat search as regular expression.
5. Click Save and Close.
6. Click Apply.
7. Select the MarkView Invoice batch class and repeat steps 2 through 6.

Prepare Kofax Import Connector to use MarkView Bar Code separators
1. From Kofax Capture Administration, highlight the MarkView Document batch class.
2. Expand the batch class to import through Kofax Import Connector until you see Sample Page 1 

with a bar code.
3. Right-click Page Level Bar Codes and select Properties.
4. On the Available Fields pane, select BarCode, click Add, and click Apply to add the Bar Code 

index field.
5. Highlight the MarkView Document batch class.
6. Select Properties.
7. On the Separation and Form Identification tab, select Custom. In the list, select MarkView 

Bar Code Separators12 and click Edit Profile.
The Custom Separation and Form Identification Profiles window opens.

8. Enter the following values:
• Enable Bar Code.
• In the list, select MarkView Bar Code12.
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• Set Found on stand-alone separator sheet as follows:
• To discard the bar code cover sheet after import, select this option.
• To keep the bar code cover sheet with imported documents, deselect this option.

• In the Search Text field, enter:
^(CP|DT)ID-

• Enable Treat search as regular expression.
9. Click Save and Close.

10. Click Apply.
11. Select the MarkView Invoice batch class and repeat steps 2 through 10.

Customize the batch class templates

If you customized your batch classes, copy your customized batch classes to a safe location before 
you upgrade. After you upgrade, refer to your customized batch classes when you manually edit 
the new batch classes. Then, save the edited batch classes in your runtime directory, such as
<MarkView_KTM_project>\MyProject.

Synchronize MarkView batch classes with the Kofax Transformation Modules 
project

1. Open the Kofax Capture Administration module.
2. On the Batch tab, right-click the MarkView Invoice batch class and select Synchronize Kofax 

Transformation Project.
3. In the Synchronization Tool window, select the Classes tab.
4. Select File > Load Project.
5. In the Project File window, open the project (the .fpr file).
6. When the system notifies you that you are replacing the project, click Yes to keep the existing 

class and field settings.
7. Click Next Step.

The Synchronization Tool window displays data in two columns: Extraction Field and Index 
Field.

8. If you have Kofax Capture 10, verify that Unit Price is set correctly in both the Extraction Field
and Index Field columns:

a. Scroll down in the Extraction Field list until you see Unit Price.

b. If necessary, use the drop down list to change the value in the Index Field column to Unit 
Price.

9. Click Next Step.
10. Click Synchronize.
11. When synchronization is complete, verify the batch class image folder location.

a. Right-click the batch class and select Properties.

b. In the Batch Class Properties window in the Image folder field, verify the path.
12. Click OK to save and exit.
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Set up scan users
You must configure a Kofax Capture scan user and a MarkView scan user. Otherwise, the scan 
operation fails and generates an error message.
• See the Kofax Capture Administrator's Guide, Administration Module, for information about using 

the Kofax Capture Administration interface to add and configure a Kofax Capture scan user.
• See the Kofax MarkView Administrator's Guide, Volume 1  for information about using the MarkView 

Administration interface to add a MarkView scan user.

Scan user requirements:
• The Kofax Capture scan user and the MarkView scan user must have the same name.
• In MarkView, the scan user must be a member of a MarkView group with scan privileges, such as 

the SCAN USERS group.

 If separate users will perform Kofax Transformation Modules validation, add the validation 
users to the SCAN USERS group as well.

Set up Kofax MarkView Export Connector
After you associate a document class with a batch class in Kofax Capture, specify and set up Kofax 
MarkView Export Connector to use when exporting your documents.

1. Start Kofax Capture Administration.
2. Select the Batch tab.
3. Expand the batch class to view associated document classes.
4. Right-click the MarkView Document class and select Export Connectors.

The Export Connectors window lists all available export connectors. Available export 
connectors are those that are registered with Kofax Capture.

5. Under the Available Export Connectors column on the left side of the window, select Kofax 
MarkView Export Connector.

6. Click Add to add Kofax MarkView Export Connector to the list of assigned export connectors.
7. In the Assigned Export Connectors section, select Kofax MarkView Export Connector and 

click Setup.
8. In the Kofax Capture Export Connector - MarkView window, specify the settings for 

exporting documents.
• Name: MarkView Document EC
• Export Settings Instance: MarkView Document
• Skip first page of each document: Clear this check box
• Threshold: Select Enable and change the Brightness level and Contrast level values, if 

required.
9. Click Apply and click OK.

10. Close the Export Connectors window.
11. Right-click the MarkView Invoice class and select Export Connectors.
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The Export Connectors window lists all available export connectors. Available export 
connectors are those that are registered with Kofax Capture.

12. Under the Available Export Connectors column on the left side of the window, select Kofax 
MarkView Export Connector.

13. Click Add to add Kofax MarkView Export Connector to the list of assigned export connectors.
14. In the Assigned Export Connectors section, select Kofax MarkView Export Connector and 

click Setup.
15. In the Kofax Capture Export Connector - MarkView window, specify the settings for 

exporting invoices, such as:
• Name: MarkView Document EC
• Export Settings Instance: MarkView Invoice EC
• Skip first page of each document: Clear this check box.
• Threshold: Select Enable

16. Click Apply and click OK.
17. Close the Export Connectors window.

Set up Database Validation for batch classes
Perform the following procedure for each MarkView Document and MarkView Invoice class. 
Depending on the number of database tables in your environment, changing between tabs in this 
process can take a long time.

1. In Kofax Capture Administration, expand the batch class, right-click the document class and 
select Database Validation.

2. Click the Browse button and select the ODBC Datasource that you created for this 
environment.

3. Select Properties.
4. Update the user name and password.
5. When prompted that changing the value will break current mappings, click Yes.
6. On the Table Settings tab, select the following values:

• Index field to validate: Kofax.Separation.BarCodeValue
• Validate against table: MV_BAR_CODE_TYPE
• Match Column: BAR_CODE_TYPE_ID

7. If you use Kofax Capture Network Server, select the KCN Server tab and enable the Use KCN 
Server for validation check box.

8. Click OK.
9. Click Close.

Publish a batch class
After you select the batch class settings, publish the batch class. The publishing process checks the 
integrity of the settings in your batch class and makes the batch class available for use. If problems 
exist with any of the settings, error and warning messages appear along with the recommended 
actions for fixing the problems.
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If you edit your batch class, publish your batch class again before you use the batch class. Changes 
are not applied to batches created before the new publication date.

1. Open the Kofax Capture Administration module.
2. Select the Batch class tab.
3. Right-click the batch class and, on the context menu, select Publish.

The Publish window opens.
4. Select your batch class and click Publish. Kofax Capture checks all of your batch class settings 

and displays the results in the Results box.

• If no problems exist, the message "Publishing successful" appears.
• If problems exist, error and warning messages appear along with the recommended actions 

to resolve the problems. Perform the recommended actions, and then try to publish the 
batch class again.

After successfully publishing, you can create batches based on your batch class. As your batches 
flow through your Kofax Capture system, they are routed from module to module. The batch class 
definition specifies the modules that process a batch and the order that processing occurs.

Process batches in Kofax Capture
Use the following information to enhance your understanding of exporting batches. See the Kofax 
Capture documentation or help for more information.

Set up scanning for MarkView documents
1. Log in to Kofax Capture Batch Manager as Admin.
2. Create a new batch.
3. In the Create Batch window, enter a batch name and description (optional).
4. In the Batch Properties Queues list, select Scan.
5. In Batch Manager, select the batch you just created and click Process Batch. The Kofax 

Capture Scan page opens.
6. In the left-hand panel, select a configured scanner as the source.
7. Scan a document with a bar code cover page.
8. To split a multi-page document, select the number of pages per document and optionally 

select Retain document properties in split documents.
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9. Click Split.
10. In Batch Manager, click Process Batch to send the batch to Kofax Transformation Modules 

Server.
11. Click Process Batch to send the batch to Kofax Transformation Modules Validation.
12. Click Process Batch to send the batch to Learning Server.
13. Click Process Batch to send the batch to Export, and make the scanned documents available in 

MarkView.

Export batches
The Kofax Capture Export module processes batches based on the settings of the associated batch 
classes. The Export module exports documents and index data, using the properties defined during 
the export connector setup.

The Kofax Capture Export module usually runs as an unattended module on a Windows 
workstation, periodically polling the Export module for available batches. Configure the Export 
module to run during off-hours to avoid impact on the throughput of Kofax Capture and the 
network system.

Start the Export module
On the Start menu, select Programs > Kofax Capture > Export.

All batches queued for export are exported after initiation of the Export module.

Export a batch
Start the Kofax Capture Export module. The module main window opens. Any batches waiting to be 
exported are processed.

Once your batch is exported, it is removed from Kofax Capture. If any documents or pages are 
rejected, the batch is routed to the Kofax Capture Quality Control module.

Exit the Export module
On the Batch menu, select Exit.

XSLT files modification
If you customized your existing XSLT file, apply your customizations to the new XSLT files and restart 
the Kofax Capture service.
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Set up Kofax Capture and Kofax Transformation Modules for 
MarkView

About Auto-Categorization
Auto-Categorization allows MarkView batch classes to bypass categorization in Kofax Capture to 
allow Kofax Transformation Modules to perform the categorization. Depending on the batch class 
property setting specified for RequireCategorizationInCapture, Kofax Capture handles batch classes 
as follows:
• 1 (ON): Prevents documents in the batch classes from moving out of Kofax Capture unless they 

are completely categorized.
• 0 (OFF): Allows documents in the batch classes to continue from Kofax Capture without being 

categorized.

If a document that has no categorization reaches Kofax Transformation Modules, Kofax 
Transformation Modules tries to categorize the document automatically based on extracted values.

Prerequisites:

• The Kofax Transformation Modules version is in compliance with the Kofax MarkView Technical 
Specifications document on the Kofax MarkView Product Documentation site.

• The Kofax Transformation Modules validation station is connected to the MarkView database.

Set the default document type for invoices without PO numbers
1. Open Kofax Transformation Modules Project Builder.
2. Open your MarkView Kofax Transformation Modules project and select Script Variables.
3. Near the bottom of the script variables table, locate DefaultNonPODocumentType.
4. Set the value to use as the default document type for invoices that enter the system without a 

PO number. Supported values include:
• NON-PO INVOICE
• PRE-APPROVED INVOICE

By default, Kofax Transformation Modules uses NON-PO INVOICE, which you can override.
5. Click OK.
6. Save the project.

Set the RequireCategorizationInCapture property
The RequireCategorizationInCapture property specifies how Kofax Capture processes MarkView 
batch classes.

1. Open Kofax Capture Administration.
2. Right-click the MarkView Invoice or MarkView Document batch class and select Properties.
3. Select the General tab and in the Batch Fields table, locate RequireCategorizationInCapture.
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4. Set the Default setting to one of the following:
• 1 (ON): Requires categorization
• 0 (OFF): Does not require categorization

5. Click OK.
6. Save the batch class and proceed as follows:

• For a MarkView Invoice batch class only, synchronize the batch class to the project and 
publish the batch class.

• For a MarkView Document batch class, publish the batch class.

About the MarkView Workflow Agent
The MarkView Workflow Agent enables Kofax Capture to handle MarkView batches introduced 
through non-scan Kofax Capture products in the same way that Kofax Capture handles batches 
introduced through Kofax Scan.

Kofax Capture processes MarkView batches based on the batch class settings. For example, in a 
batch imported through Kofax Import Connector:
• If the Workflow Agent cannot communicate with MarkView, Kofax Capture routes the batch to the 

Quality Control queue.
• If AlwaysStopForReview specifies that all documents go to review, Kofax Capture routes all 

imported batches to the configured review queue.

Workflow Agent batch class properties
Two MarkView batch class properties define how Kofax Capture processes MarkView batch classes 
imported through an application other than Kofax Scan. These properties do not affect MarkView 
batch classes imported through Kofax Scan.

• AlwaysStopForReview: When enabled, routes every document in the batch to review in Kofax 
Capture, whether or not the documents have a valid bar code.
• Disable (default): 0 (False)
• Enable: 1 (True)

• ReviewQueue: Specifies the review queue to which Kofax Capture routes documents in the batch 
that need review.
• Scan (default): Routes documents to the Scan queue
• QC: Routes documents to the Quality Control queue

To change how Kofax Capture processes a MarkView batch imported through an application other 
than Kofax Scan, edit the batch class properties for the destination associated with the connection. 
Workflow Agent properties appear on the Batch fields tab.

 If you access the Document fields tab and change or add a value for the BarCode or
Kofax.Separation.BarCodeValue fields, the Kofax.Separation.BarCodeValue always takes 
precedence.

See the Kofax Import Connector documentation for information about editing the destination.
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Interaction between Kofax Capture and Workflow Agent batch class 
properties
The combination of batch class settings that you use determines how Kofax Capture processes non-
scanned MarkView Invoice batch classes.
• If you set AlwaysStopForReview to 1 (ON), non-scanned documents always stop for review in the 

defined review queue.
• If you set AlwaysStopForReview to 0 (OFF) and RequireCategorizationInCapture to 1 (ON), non-

scanned documents only stop for review if Kofax Capture cannot decode the bar code value.

 For MarkView batch classes imported through an application other than Kofax Scan, the 
RequireCategorizationInCapture property appears on the Batch Fields tab of the destination that 
handles the batch.

Integration with Kofax Import Connector
Before configuring the integration between MarkView and Kofax Import Connector, verify that you 
have the following installed and configured:
• MarkView
• Kofax Capture
• Message Connector

For information about installing and configuring Message Connector and Kofax Capture Plug-In, 
see the documentation provided with the product from the fulfillment site.

The integration process involves completing the following processes in Kofax Import Connector and 
Kofax Capture Administration:
• Configure Message Connector
• Set up destinations on page 147
• Configure connections on page 151

Configure Message Connector
1. On the Start menu, select All Programs.
2. Select Kofax > KIC-Electronic Documents > Message Connector Configuration.

If a user access control prompt appears, click Yes to allow the configuration to proceed.
By default, the window displays a list of basic features.

3. Click Advanced.
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4. Expand the General panel and configure the following options.

Option Setting

Operator Email Specify the administrator email address to receive a copy of messages that fail 
conversion.

Email From Specify the email address from which the system sends notifications.

Keep Failed Failed inbound messages are those not imported into Kofax Capture and not 
forwarded to an operator. If you select the option to keep failed messages, the 
messages are treated as pending. To keep from running out of disk storage 
space, process or manually delete these messages.
• Disable: For the best result, clear the check box for this option.
• Enable: Stores messages on the message connector server. You must 

manually delete stored messages.

Storage Size Enter the amount of disk space in MB reserved for storing messages.
• Minimum: 10 MB
• Maximum: 64,000 MB

For SMTP protocol, use the default. Allocate enough space for mail storage.
For POP3 with KeepFailed disabled, allocate enough space for active email 
processing.

Storage File Enter the file name and location for file storage. The default file location is: C:
\Program Files\Kofax\KIC-ED\MC\Storage.bin. Monitor the size of this 
file and ensure that it does not exceed 50% of the available disk space.
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Option Setting

Prefetched Messages Enter the number of messages that the connector should prefetch from all 
boxes, folders, and other passive input methods.
• Minimum: 1
• Maximum: 100

Own Computer Name For SMTP and Web Services, enter the name of the computer or domain 
where you will install the solution.

Load Balancer Support For SMTP and Web Services input, select the supported load balancer.

5. To convert Microsoft Word plain text (.txt) or html files, expand the Document Conversion
panel and configure the following options.

Option Setting

MS Office Documents Select the software to use for converting Microsoft Word and plain-text (.txt) 
documents.

MHTML and HTML 
Documents

Select the software to use for converting MHTML and HTML documents.

MS Office User If you use MS Office for the conversions, Kofax recommends that you use a 
dedicated, named user for production mode.
To do so, select This User.

Name The Windows user name for MS Office. Verify that the user has the correct 
privileges to use Kofax Capture as well as MS Office.

Password The password for the selected Windows user. Set the password to never 
expire.

Custom Extension List Enter a list of extensions, separated by spaces, for file types to convert to 
PDF using a customizable script. Create the script in the Scripts sub-folder 
with the name "CustomToPdf.bat".

6. Expand the Email Outbound panel and configure the following settings, which send 
notifications to MarkView.

Option Setting

SMTP Server Mode Select how to locate the outbound SMTP server.

SMTP Smart Host Enter the domain name or IP address of the SMTP host for outgoing 
messages. (Use a fully qualified mail server name.)

TCP Port Specify the port on the SMTP host for outgoing messages (use 25).

User ID Enter the User ID for SMTP authentication.

Password Enter the password associated with User ID for SMTP authentication.

SSL Active Select the setting for Secure Sockets Layer protocol.

7. Click Save and Exit.
8. Restart the service to activate the changes.
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Configure destinations and connections
Configuring the Kofax Capture Plug-In to work with MarkView requires you to set destinations, 
configure connections, and map import types to destinations.

Set up destinations
For details about configuration settings, see the Kofax Import Connector documentation.

1. On the Start menu, select All Programs > Kofax Capture xx.x > Administration (where xx.x is 
the current version of Kofax Capture).
If prompted to log in, do so.

2. Select the Electronic Documents tab and click Configuration.
3. Proceed as follows:

• To create a destination: Go to the right-hand pane of the window, locate Destination Tasks
and click Add Destination.

• To edit a destination: In the Destinations list, select a <destination> to edit; in the right-hand 
pane, locate Destination Tasks and click Edit Destination.

A—Destinations List
B—Destination Tasks
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4. In the Destination configuration window, complete the fields on the Import settings tab 
with the following information.

Panel Settings

Destination information • Name: Enter a name for the destination.
• Description: Enter a description.

Message content 
options

• Import content:
• Attachments: Imports only email attachments
• Body and attachments: Imports the body of the email and the 

attachment
• Body only: Imports only the body of the email and no attachments

• Include original content: Enable to include original message content.
• Include complete message as EML file: Enable to include original content in 

EML format.
• Originals import mode: If you enable "Include original content" or "Include 

complete message as EML file," select whether to import the content to 
Kofax Capture or to save the content to a Kofax Capture batch folder.

Import mode • Convert to: Select the file format to which the Kofax Capture Plug-In should 
convert files.

• Conversion mode: If you select a "Convert to" file format, specify whether 
to convert the both the message body and attachment (All Content) or to 
convert only non-image parts of the message.

• Image format: 300x300 B/W
• Message rendering VRS: None

Batch settings • Batch size: 1 (Default)
• Batch timeout: 300 (Default)
• Batch priority: 5 (Default)
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5. Select the Import mappings tab, and complete the form using the following information.

Option Setting

Batch class • MarkView Document: Recommended setting
• MarkView Invoice: For importing into Kofax Transformation Modules

 For environments with multiple instances, select the instance 
batch class to which to import.

Document class Select a document class based on your Batch class selection. For example, 
if you select the MarkView Invoice batch class, select the MarkView Invoice 
document class.
• MarkView Document
• MarkView Invoice

To configure your system to read a bar code on the cover page of the 
imported document, select (Loose Pages - No document will be used.).

Create document per 
attachment

• Enable: Recommended setting
• Disable: To combine all incoming email attachments as a single 

MarkView document

Folder class Undefined: Recommended setting

Form type Select the Form type based on your Batch class selection. For example, if 
you select the MarkView Invoice batch class, select the MarkView Invoice 
form type.
• MarkView Document
• MarkView Invoice

To configure your system to read a bar code on the cover page of the 
imported document, select (Undefined Form Type - No Form Type will 
be used.).

6. At the bottom of window, change the settings for sub tab fields as described next. 
For fields not described, keep the default settings. For information about using 
RequireCategorizationInCapture, AlwaysStopForReview, and ReviewQueue, see Set up Kofax 
Capture and Kofax Transformation Modules for MarkView on page 142.

Sub Tab Name Field or Index Name Value

AlwaysStopForReview Disable (default): 0 (FALSE)
Enable: 1 (TRUE)

BatchName The name you specify appears as 
the origin information on MarkView 
documents.
If internal users forward emails 
that have informative subject lines, 
set this value to Message Field > 
KfxMessageSubject.

Batch Fields

Kofax.MarkView. BarCodeSepSearch ^(CP|DT)ID-
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Sub Tab Name Field or Index Name Value

MailTo KfxRecipientTo
If you enter a list of addresses, only 
the first address in the list is used.

MailCc Not used.

MailFrom KfxOriginatorNumber

MailFromName KfxOriginatorName

MailSubject KfxMessageSubject

RequireCategorizationInCapture • 1 (ON)
• 0 (OFF)

ReviewQueue Scan (default)
QC

Folder Fields Keep the default settings

BarCode • Set a constant value using a bar 
code string from the bar code 
cover sheet.

• To route documents to manual 
review, create a cover sheet for an 
Uncategorized Document and use 
that bar code string.

Comment Leave blank. This option creates 
a sticky note on the MarkView 
document with the comment that 
you specify here.

Kofax.Separation.BarCodeValue The value you set in this field takes 
precedence over the value set in the 
BarCode field.
• Set a constant value using a bar 

code string from the bar code 
cover sheet.

• To route documents to manual 
review, create a cover sheet for an 
Uncategorized Document and use 
that bar code string.

Document Fields
If you selected (Loose-
Pages - No document 
will be used.)  as the
Document Class, the
Document Fields are 
empty.

ScanStationID For location filtering in MarkView, 
set to a location name, such as 
TORONTO, HOUSTON.

Advanced Fields Leave fields empty.

7. Click OK.
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Configure connections
1. In the right-hand pane of the Kofax Capture Plug-In window, locate the Connection Tasks and 

proceed as follows:
• Click Add Connection.
• In the top half of the window, select a connection to edit, go to the Connection Tasks pane, 

and click Edit Connection.

A—Connections List
B—Connection Tasks

2. In the Connection configuration window, configure the following options:
• Connection name: Use a generic name
• Message Connector URL: Enter the URL of the computer where Message Connector is 

running.
• For a secure connection, use https://<address:port>.
• For a non-secure connection, use http://<address:port>.

• Default destination: Specify the default destination to associate with import connections 
that you configure.

3. To validate the connection, click Test Connection.

 If validation fails, you might need to perform additional configuration. See the Kofax 
Import Connector documentation or consult with your Kofax Capture administrator.

4. Under Import Connectors, click Add and select Mailbox Import to set up a mailbox import 
connector.
Set up one mailbox per organization-workflow-priority combination.

Option Setting

Display name Enter a descriptive, unique <name> for this mailbox.

Host Enter the POP3 or IMAP <host name> of the inbound mail server.
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Option Setting

Protocol Select the protocol to use for accessing the mailbox.
• IMAP
• POP3

SSL Select the security option to use:
• NEVER
• ALWAYS
• NEGOTIATE

User name (Required) Enter the User name associated with the mailbox.

Password (Required) Enter the Password associated with the user name for the mailbox.

For more information about setting up access to mailboxes and other import connectors, see 
the Kofax Import Connector Administrator's Guide.

5. To test the settings, click Test Mailbox.
You should see a successful connection message.
If the test fails, check with your mail server administrator to verify that you supplied the correct 
information.

6. Click OK to save the import connector settings, and OK again to save the Connection settings.
7. Restart the Kofax Capture Plug-In service to activate your configuration changes.

Map mailboxes to destinations
Map each mailbox to a corresponding destination using the following procedure as a guideline. For 
details, see the Kofax Import Connector documentation.

1. In the Kofax Capture Plug-In window, select a <connection>, go to the Connection Tasks pane, 
and click Add Rule.

2. Complete the form using the following settings:

Option Setting

Service filter Select EMAIL.

Recipient list Enter the <email address> of those to receive documents from this mailbox. 
Separate multiple email addresses with commas.

Address Enter the <email address> from which Message Connector receives the document. 
Kofax Capture imports documents with this address to the configured destination.

Destination Select a <destination> in the list. If you do not see any destinations, see Set up 
destinations on page 147 to set up destinations.

3. Click OK.
4. If prompted to restart the service, click Yes.

Configure the email subject to override bar codes
In addition to configuring email accounts for specific categorizations, Kofax Capture can read 
the text version of a MarkView bar code string. To enable this feature, complete the following 
procedure.
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Verify that you have a dedicated email server that can be polled from the Kofax Capture server for 
the subject line override.

1. Configure the mailbox.
2. Set up a new destination (see Set up destinations on page 147).
3. On the Destination configuration window, select the Import mappings tab.
4. Under Document fields, locate the BarCode row or the Kofax.separation.BarcodeValue row.
5. In the row to set, click the Value column and select Message Fields > KfxMessageSubject.
6. (Optional) If you reuse the field for location filtering, add a location to the ScanStationID Value 

field.

 To prevent the need for each user to generate a bar code for each use, an administrator can 
generate a set of bar codes in production and distribute them along with a chart. For example:
• OU (Organization): ORG1
• Document Type: PO Invoice
• Priority: Normal
• Mail Subject (Bar Code String): DTID-10$CPID-190846\

Use the bar code override

To email copies of invoices into the MarkView workflow when you do not have a dedicated mailbox 
for the document type-organization-priority combination, send the attachment in an email to the 
address that you configure using the instructions in Configure the email subject to override bar 
codes on page 152.

1. Using the chart provided, look up the bar code string based on the Organization (OU), 
Document Type, and Priority.

2. Copy and paste the bar code string into the email subject line. Verify that you do not add 
leading or trailing characters to the string.

3. In the body of the email, add information (such as the document type, organization, priority, or 
notes) to help the administrator with troubleshooting in case the conversion fails.
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Integration with Kofax Analytics for 
MarkView

This chapter gives you information about settings needed to maintain and optimize Kofax Analytics 
for MarkView performance if you plan to use this Kofax product. Follow the steps in this chapter 
after you installed Kofax Analytics for MarkView according to the Kofax Analytics for MarkView 
Administrator's Guide.

About Kofax Analytics for MarkView
Kofax Analytics for MarkView is an extension of Kofax MarkView that produces a graphical business 
intelligence dashboard based on near real-time data collected during the batch processing 
workflow. Kofax Analytics for MarkView presents finance processes data in graphical and interactive 
views.

Kofax Analytics for MarkView is a browser-based product built on Kofax Insight. Kofax Insight 
is a process intelligence platform that monitors, analyzes and helps optimize your operational 
business activities to ensure compliance, eliminate risk and provide insight and visualization of all 
information.

Kofax Analytics for MarkView brings together data from the Oracle E-Business Suite system, 
MarkView, and Kofax Capture with Kofax Transformation Modules workflows to give you strategic 
information about your business activities. Kofax Analytics for MarkView provides the insight and 
metrics required to analyze the effectiveness of business processes.

With Kofax Analytics for MarkView you can:
• Prioritize daily activities
• Take advantage of available discounts
• Check for duplicate invoices and possible compliance violations
• Review invoice summary data
• Take action to meet key performance indicators
• Review invoice full history and status
• Optimize cash resources
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Enable Kofax Analytics for MarkView in the Kofax MarkView 
Export Connector (optional)

Skip this step if you do not want to use Kofax Capture and Kofax Transformation Modules with 
Kofax Analytics for MarkView.

Perform the following steps for all systems where Kofax MarkView Export Connector is installed.
1. In the Kofax MarkView Export Connector installation directory, locate the 

Kofax.MarkViewExport.Notifier.dll.config file and open it for editing.
2. To enable Kofax Analytics for MarkView, locate the "EnableKofaxAnalytics" key and set the 

value to true as follows:
<appSettings> 
            <add key="EnableKofaxAnalytics" value="true"/> 
             …
        </appSettings>

3. Save the .config file and reopen Kofax Capture.

Configure access to Kofax Analytics for MarkView
Configure your MarkView menu to access Kofax Analytics for MarkView from MarkView.

1. Log in to MarkView and navigate to Administration > Module Admin.
2. Select the Menu Item tab.
3. Scroll to the bottom of the page and click Insert.
4. Complete the form and click Insert again to save the changes.

• Menu Name: Main Menu
• Menu Sequence: Next available value for Main Menu items.
• Item Type: URL
• Default Item Label: The name that appears in the interface, such as Kofax Analytics for 

MarkView.
• Item Value: The URL link to the Kofax Analytics for MarkView home page in the following 

format:
http(s)://<host>:<port>/Insight/View/

Where <host> is the name of the server where you installed Kofax Insight and <port> is the 
port used by Kofax Insight.

• MV Home Aware: Y

When you add a menu item, the item remains inactive until you assign it to a user group. For more 
information about assigning menu items to User Groups, see the Kofax MarkView Administrator's 
Guide, Volume 1.
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User authorization in Kofax Analytics for MarkView
The Kofax Analytics for MarkView viewer user is the same as the MarkView user.

Verify that a user profile meets the following requirements:

• The user is enabled in MarkView.
• The user is added to the MV Analytics user group.

 You can create a number of groups for Kofax Analytics for MarkView to add different set of 
organizations.
When you create theKofax Analytics for MarkView user group, specify the group name as 
follows:
"MV Analytics - xxx", where "- xxx" is a unique value.

• The MV Analytics user group is assigned for at least one organization in MarkView.

After a user is added to MarkView, verify that the viewer user follows the procedures in this section 
to ensure that data appears on the Kofax Analytics for MarkView viewer as expected.

1. To access Kofax Analytics for MarkView, open a web browser and enter the URL such as
http(s)://<host>:<port>/Insight/View, where <host> is the name of the server where 
you installed Kofax Insight and <port> is the port used by Kofax Insight.

 The URL address is defined by the settings used for IIS during Kofax Insight installation.

2. Log in to Kofax Analytics for MarkView using the MarkView user name and password.
3. Verify that you have access to the predefined data for organizations.

 Kofax Analytics for MarkView supports all organizations that a user is authorized in 
MarkView and Oracle EBS.

User authorization for invoice actions in MarkView
Kofax Analytics for MarkView lets authorized users take actions on invoices. You can Increase 
Priority, Reassign, or Escalate an invoice.

The MarkView administrator sets the access to Kofax Analytics for MarkView invoice actions in 
MarkView.

Increase Priority
The Increase Priority action is available with standard MarkView installation. To set the access to the 
Increase Priority action:

1. Log in to MarkView and navigate to Administration > MarkView Admin.
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2. Select the Toolsets tab and click Add.

3. Enter the toolset name such as Analytics Toolset and the sequence, and click Save.

4. To create new mapping between the new toolset and the existing MarkView tools, select the
Toolsets Tool tab and click Add.

5. Click Select Tool and in the List of Values, locate the Increase Priority Tool.

6. Add the Increase Priority Tool to the appropriate Analytics Toolset and click Save.

7. Open User Groups and select the appropriate MV Analytics group or create a new one for users 
that must be authorized for Increase Priority action.

8. Open details, select the Document Toolset Auths tab, and click Add to add new document-
toolset authorization mapping.

9. In the Document Type filed, select ALL.

10. In the Toolset field, select the toolset that you created for the Increase priority action such as 
Analytics Toolset and click Save.

After you added the Increase Priority Tool to the appropriate User Group, the members of this 
group are authorized to use the Increase Priority action in Kofax Analytics for MarkView.

Reassign
To set the access to the Reassign action:

1. Log in to MarkView and navigate to Administration > MarkView Admin.

2. Select the Tools tab and locate Reassign Document Tool in the list.
• If you have the Reassign Document Tool, follow the same process to add the tool to the 

appropriate user group as for the Increase Priority Tool.
After you added the Reassign Document Tool to the appropriate User Group, the members 
of this group are authorized to use the Reassign action in Kofax Analytics for MarkView.

• If you do not have the Reassign Document Tool, select the User Groups tab and create a 
new MarkView group and add users.
The user group name must be MV ANALYTICS REASSIGN which is case-insensitive.

Escalate
To set the Escalate Document action:

1. Log in to MarkView and navigate to Administration > MarkView Admin.

2. Select the Tools tab and locate Escalate Document Tool in the list.
• If you have the Escalate Document Tool, follow the same process to add the tool to the 

appropriate user group as for the Increase Priority Tool.
After you added the Escalate Document Tool to the appropriate User Group, the members 
of this group are authorized to use the Escalate action in Kofax Analytics for MarkView.

• If you do not have the Escalate Document Tool, select the User Groups tab and create a 
new MarkView group and add users.
The user group name must be MV ANALYTICS ESCALATE which is case-insensitive.
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 If you do not have Reassign Document or Escalate Document Tool installed in MarkView,
Action History in MarkView Viewer does not display new items after reassign or escalate action in 
Kofax Analytics for MarkView.

Enable Kofax MarkView Export Connector notifications
If you want to use Kofax Analytics for MarkView with Kofax Capture and Kofax Transformation 
Modules, enable the integration after you install Kofax MarkView Export Connector. Perform the 
following steps for all systems where Kofax MarkView Export Connector is installed.

1. In the Kofax MarkView Export Connector installation directory, locate the 
Kofax.MarkViewExport.Notifier.dll.config file and open it for editing.

2. To enable Kofax Analytics for MarkView, locate the "EnableKofaxAnalytics" key and set the 
value to true as follows:
<appSettings> 
            <add key="EnableKofaxAnalytics" value="true"/> 
             …
        </appSettings>

3. Save the .config file and reopen Kofax Capture.
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Make other updates after applying an 
Oracle Applications patch

Add MarkView classes to the EBS class path (Oracle EBS 12.2 
only)

After running the Oracle Objects installer on Oracle EBS 12.2, you must add the MarkView classes to 
the $JAVA_TOP/customall.jar file that is on the EBS class path by following the steps in this section. If 
you do not add the MarkView classes, you may encounter errors while working with Oracle Forms, 
for example an unexpected error may occur in the iExpenses module.

1. Run the Oracle Adadmin utility to generate the new jar files.

a. In the Oracle Adadmin utility, select option 1: Generate Applications Files menu.

b. Select option  4: Generate product JAR files.

c. If you wish to force regeneration of all jar files, when prompted, enter Y.
2. Restart Oracle EBS Applications.

Redo modifications

When an Oracle Applications patch is applied to the system, it is often a standard implementation 
without modifications. Therefore, some integration changes may be lost if an Oracle Applications 
patch is applied. While the exact changes are patch-dependent, you should verify and, if necessary, 
complete the following tasks after applying any Oracle Applications patch:

Reapply modifications to SFXINWKB
To apply modifications to the latest version of the form:

1. Back up your existing SFXINWKB.fmb file (located in $c_MARKVIEW_TOP/forms/US) to a safe 
location.

2. Copy the new APXINWKB.fmb file to $c_MARKVIEW_TOP/forms/US.
3. Rename the APXINWKB.fmb file as SFXINWKB.fmb.
4. Integrate the new version of the form.
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Reapply modifications to Expense
To reapply your modifications to the Expense, rerun the Oracle Objects installer and re-install the 
AP_WEB_OA_CUSTOM_PKG:

1. On the Oracle E-Business Suite server, navigate to <distribution_directory>/installer/bin, 
where <distribution_directory> is the temporary distribution directory.

2. Run ./install.sh to start the installer.
3. Select OA Framework Integration for Expense.
4. Follow the prompts for a Partial Install.
5. Re-install the AP_WEB_OA_CUSTOM_PKG in the Oracle Applications schema.
6. Reconfigure Expense Management. See the Kofax MarkView Installation Guide for the 

information about performing the expense management configuration.

Observe best practices
After applying an Oracle patch update, we strongly recommend that you follow the same best 
practices prescribed in the "Software Support for Upgrades and Bug Fixes" section of your Software 
Support Terms and Conditions.

As part of your software support, you are entitled to technical support assistance for software 
upgrades and bug fixes to troubleshoot and diagnose any incidents which may arise. All incidents 
will be addressed through the software support process described in the Software Support Terms 
and Conditions.

Before upgrading, consider contacting Kofax to discuss options for analyzing the overall impact of 
these product upgrades on the MarkView implementation.

It is required policy that all system changes be applied in your test environment and be tested 
thoroughly before migrating such system changes into a production environment.

For more information, see the detailed list of steps and best practices outlined in your copy of 
Software Support Terms and Conditions. This is an overview of these procedures:
• Back up the TEST system.
• Perform the upgrade in the TEST environment.
• Unit test the fix.
• Perform a User Acceptance Test of the changed TEST system.
• Back up the PROD system.
• Install in PROD during scheduled system downtime.
• Test PROD system before normal Production uptime.
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Troubleshoot your upgrade

This appendix identifies conditions you might encounter and suggests ways to resolve them. For 
more information, see the Release Notes and the Kofax Knowledge Base.

JVM location errors
If you encounter problems related to locating a JVM, take the following steps:

1. Use the java -version command to check your environment path for a valid version.
For the version supported, see the Kofax MarkView Technical Specifications document on the
Kofax MarkView Product Documentation site.

2. If the version returned is not supported, specify the Java version to determine how your path 
resolves.

Invalid JDK errors
Errors related to an invalid JDK vary depending on your platform, but the problem is usually caused 
by the location of the JDK in the path. To resolve the problem, modify your path environment 
variable so that the JDK version appears before all other JDKs, JREs, and JVMs.

Too many open files
The error "java.io.FileNotFoundException: Too many open files" indicates that open files limit on 
your system should be increased.

UNIX: increase ulimit nofile setting (max number of open files).
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Appendix B

Migrate environments

Migrate your MarkView production environment to a non-production environment to test new 
functionality, train new users, or troubleshoot issues which you might encounter in your production 
environment. Use a third-party tool to clone the MarkView production database. Then, use the 
MarkView Migration utility to generate an SQL script to update the environment-specific MarkView 
URLs and design-time data on the non-production environment.

Also, you can use the MarkView Migration utility to move to a new application server without 
upgrading MarkView.

To migrate Kofax Analytics for MarkView from a production to non-production environment, 
additional setup is required. For more information, see the Kofax Analytics for MarkView 
Administrator's Guide.

• Migrating Data to Existing Non-Production Environments: If you already have a functioning 
non-production environment, refresh the database with a more recent copy of the production 
environment. See Migration Utility: Configure an existing non-production environment.

• Migrating Data to New Non-Production Environments: If you need a new non-production 
environment, see Configure a new non-production environment on page 164.

Migration Utility: Configure an existing non-production 
environment

Follow these steps before you use the Migration Utility:
1. Copy your production database schema to your non-production database.
2. Copy your production document server to your non-production document server.
3. Log in to a working MarkView environment (for example, your production environment) as an 

Administrator who is a member of the MODULE ADMINISTRATOR group.
4. Select Administration > Migration Utility.

Use the Migration Utility
1. Complete the values for your site using the following information.

Section Field Name Description

Application Server Post 
Migration

Application Server • WebLogic
• JBoss (use for WildFly and JBoss EAP)
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Section Field Name Description

Fully Qualified Hostname Enter the fully qualified hostname of the 
target application server.

HTTP Port Enter the HTTP port of the target 
application server.

Preferences Select to update the MarkView 
preference URLs to use the target 
application server.

Volume Paths Select to update the MarkView volume 
paths to use the new application server.

Volume Path To Leave Open If you select Volume Paths, select the
Volume Path To Leave Open in the list. 
Values include:
• Close All
• DEVELOPMENT
• PRODUCTION
• TEST

Menu Items Select to update the MarkView menu 
item URLs to use the new application 
server.

Configuration to be 
Updated to Reference 
Application Server Post 
Migration

Export Server Queue 
Assignments

Select to update the MarkView export 
queue assignments to use the new 
application server.

Enable SSL (HTTPs) on 
Application Server

Select to update the MarkView 
URLs to use HTTPs. This option also 
generates the SQL to update the 
WEBCLNT_HTTP_TYPE to the correct 
value (http or https) depending on 
whether SSL is enabled.

SSL Wallet Location If you select Enable SSL (HTTPs) on 
Application Server, enter the SSL Wallet 
Location. (Required for SSL wallets only.)

SSL Wallet Password If you select Enable SSL (HTTPs) on 
Application Server, enter the SSL Wallet 
Password. (Required for SSL wallets 
only.)

Clear Pending Export Requests Select to clear the pending export 
requests.

Route New Mail to Complete 
Mail Queue

Select to route the new mail items to the 
Complete Mail queue.

Data Cleanup Tasks

Override Outbound E-mail 
Destination

Select to update the MarkView 
Outbound Destination email 
address override preference, 
MVT_TEST_EMAIL_ADDRESS, to use a 
new email address.

163



Kofax MarkView Upgrade Guide for Oracle E-Business Suite

Section Field Name Description

E-mail Address If you select Override Outbound E-
mail Destination, enter the email 
address (required). The email address 
must meet the RFC2822 standards for 
valid syntax. See http://tools.ietf.org/
html/rfc2822#section-3.4.1 for more 
information about the RFC2822 
standards.

E-Mail Import 
Configuration

The fields in this section are no longer supported.

2. Select Generate SQL to generate the script and direct where to save the script.
3. Execute the script against the MarkView schema on the target database.

Configure a new non-production environment
If you are configuring a new non-production environment, or the current non-production database 
was overwritten with your production environment, follow these steps to configure your non-
production environment.

1. Follow the instructions in Before you start to prepare your new non-production environment.
2. Copy your production database schema to your non-production database.
3. Copy your production document server to your non-production document server.
4. Install the MarkView application server.

Install the same MarkView version as in your production environment.
• For point releases, such as MarkView 10.5.0, use the standard installer. Follow the 

instructions in this guide.
• For service packs, such as MarkView 10.x.x, only apply the service pack. Do not first install 

the MarkView point release. For example, if your production system is at MarkView 10.x, 
only apply service pack 10.x.x to the new non-production environment. This is because your 
database is already at version 10.x.

• If applicable, apply any fix pack to the new non-production application server to bring it to 
the same level as your production environment.

After the MarkView application server is installed, follow the instructions in Move to a new 
application server during MarkView upgrade.

5. Refresh the new non-production environment. See Refresh a new non-production 
environment.

Refresh a new non-production environment
1. Log in to a working MarkView environment (for example, your production environment) as an 

Administrator who is a member of the MODULE ADMINISTRATOR group.
2. Select Administration > Migration Utility.
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3. Complete the values for your site using the following information.

Section Field Name Description

Application Server • WebLogic
• JBoss (use for WildFly and JBoss EAP)

Fully Qualified Hostname Enter the fully qualified hostname of the 
target application server.

Application Server Post 
Migration

HTTP Port Enter the HTTP port of the target 
application server.

Preferences Select to update the MarkView 
preference URLs to use the target 
application server.

Volume Paths Select to update the MarkView volume 
paths to use the new application server.

Volume Path To Leave Open If you select Volume Paths, select the
Volume Path To Leave Open in the list. 
Values include:
• Close All
• DEVELOPMENT
• PRODUCTION
• TEST

Menu Items Select to update the MarkView menu 
item URLs to use the new application 
server.

Configuration to be 
Updated to Reference 
Application Server Post 
Migration

Export Server Queue 
Assignments

Select to update the MarkView export 
queue assignments to use the new 
application server.

Enable SSL (HTTPs) on 
Application Server

Select to update the MarkView 
URLs to use HTTPs. This option also 
generates the SQL to update the 
WEBCLNT_HTTP_TYPE to the correct 
value (http or https) depending on 
whether SSL is enabled.

SSL Wallet Location If you select Enable SSL (HTTPs) on 
Application Server, enter the SSL Wallet 
Location. (Required for SSL wallets only.)

SSL Wallet Password If you select Enable SSL (HTTPs) on 
Application Server, enter the SSL Wallet 
Password. (Required for SSL wallets 
only.)

Clear Pending Export Requests Select to clear the pending export 
requests.

Data Cleanup Tasks

Route New Mail to Complete 
Mail Queue

Select to route the new mail items to the 
Complete Mail queue.
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Section Field Name Description

Override Outbound E-mail 
Destination

Select to update the MarkView 
Outbound Destination email 
address override preference, 
MVT_TEST_EMAIL_ADDRESS, to use a 
new email address.

E-mail Address If you select Override Outbound E-
mail Destination, enter the email 
address (required). The email address 
must meet the RFC2822 standards for 
valid syntax. See http://tools.ietf.org/
html/rfc2822#section-3.4.1 for more 
information about the RFC2822 
standards.

E-Mail Import 
Configuration

The fields in this section are no longer supported.

4. Select Generate SQL to generate the script and direct where to save the script.
5. Execute the script against the MarkView schema on the target database.
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Appendix C

Customization migration tools

To migrate the MarkView customization data, use a third-party utility to create a production 
environment image in the non-production environment. After the third-party utility performs the 
migration, the MarkView configuration data export-import tools extract and merge all MarkView 
customization data into the database. They are located in the tools directory:

Tool Description

export-config Assigns the following to the CONFIG module:
• Volumes and volume paths
• URL preferences
• URL-type menu items
• Export queue assignments
• Connector configurations

import-config Closes all open volumes and merges the data extracted by the CONFIG module into 
the database.

export-module Extracts all the data assigned to the module to a file that the import-module can 
read

import-module Merges the data from the import-module into the database

The configuration data export-import tools preserve the unique non-production environment 
settings. The process includes:
• Running the export-config tool in the non-production environment.
• Running a third-party tool to create a production environment image in the non-production 

environment.
• Running the import-config tool in the non-production environment.

 Use Kofax Capture (KC) Database Utility Application (DBUtil) to migrate the Kofax Capture 
database and integrate with the Windows file system. Do not use third-party database tools to 
migrate the Kofax Capture database. See the DBUtil online help for additional information.

Migrate customizations
1. Log in to the application server host operating system as the application server owner 

and navigate to the tools directory <distribution_directory>\tools, where 
<distribution_directory> is the location where you downloaded and decompressed the 
installation files.
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2. UNIX:
config.sh <dbHost> <dbPort> <dbSID> <mvuser> <mvpasswd> <configFile>

Windows:
config.bat <dbHost> <dbPort> <dbSID> <mvuser> <mvpasswd> <configFile>

Where:
• <dbhost> is the database server host.
• <dbport> is the MarkView main application server port (default 7777).
• <dbSID> is the database SID name.
• <mvuser> is the MarkView schema user name.
• <mvpasswd> is the password for the MarkView schema user.
• <configFile> is the name of your configuration file.

The message "Configuration is successful" appears when the import is completed. The 
message also lists the location of a log file with more information about the export.

3. Run the import-config tool to import the data.
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Third-party license agreement

BEA Public License Version 2.1

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.
• "License" shall mean the terms and conditions of this agreement.
• "Licensor" shall mean BEA Systems, Inc.
• "Legal Entity" shall mean the union of the acting entity and all other entities that control, 

are controlled by, or are under common control with that entity. For the purposes of this 
definition, "control" means
(i) the power, direct or indirect, to cause the direction or management of such entity, 
whether by contract or otherwise, or
(ii) ownership of fifty percent (50%) or more of the outstanding shares, or
(iii) beneficial ownership of such entity.

• "You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted 
by this License, including but not limited to each Contributor other than Licensor in such 
Contributor’s role as a licensee for the Software.

• "Source Format" shall mean the preferred form for making modifications, including but not 
limited to software source code, documentation source, and configuration files.

• "Object Format" shall mean any form resulting from mechanical transformation or 
translation of a Source Format, including but not limited to compiled object code, generated 
documentation, and conversions to other media types.

• "Software" shall mean the original version of the software accompanying this agreement as 
released by BEA, including in Source or Object Format, and also any documentation provided 
therewith.

• "Derivative Works" shall mean any work, whether in Source or Object Format, that is 
based on (or derived from) the Software and for which the editorial revisions, annotations, 
elaborations, or other modifications represent, as a whole, an original work of authorship. 
For the purposes of this License, Derivative Works shall not include works that remain 
separable from, or merely link (or bind by name) to the interfaces of, the Software and 
derivative works thereof.

• "Contribution" shall mean any work of authorship, including the original version of the 
Software and any modifications or additions to that Software or Derivative Works thereof, 
that is intentionally submitted to Licensor for inclusion in the Software by the copyright 
owner or by an individual or Legal Entity authorized to submit on behalf of the copyright 
owner. For the purposes of this definition, "submitted" means any form of electronic, verbal, 
or written communication sent to the Licensor or its representatives, including but not 
limited to communication on electronic mailing lists, source code control systems, and issue 
tracking systems that are managed by, or on behalf of, the Licensor for the purpose of 
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discussing and improving the Software, but excluding communication that is conspicuously 
marked or otherwise designated in writing by the copyright owner as "Not a Contribution."

• "Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom 
a Contribution has been received by Licensor and subsequently incorporated within the 
Software.

2. Grant of Copyright License. Subject to the terms and conditions of this License, each 
Contributor hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-
free, irrevocable copyright license to reproduce, prepare Derivative Works of, publicly display, 
publicly perform, sublicense, and distribute the Software and such Derivative Works in Source 
or Object Format. Each Contributor represents that to its knowledge it has sufficient copyright 
rights in its Contribution, if any, to grant the foregoing copyright license.

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor 
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, 
irrevocable (except as stated in this section) patent license to make, have made, use, offer 
to sell, sell, import, and otherwise transfer the Software, where such license applies only 
to those patent claims licensable by such Contributor that are necessarily infringed by 
their Contribution(s) alone or by combination of their Contribution(s) with the Software 
to which such Contribution(s) was submitted. If You institute patent litigation against any 
entity (including a cross-claim or counterclaim in a lawsuit) alleging that the Software or 
a Contribution incorporated within the Software constitutes direct or contributory patent 
infringement, then any patent licenses granted to You under this License for that Software 
shall terminate as of the date such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the Software or Derivative Works 
thereof in any medium, with or without modifications, and in Source or Object Format, 
provided that You meet the following conditions:
• You must give any other recipients of the Software or Derivative Works a copy of this 

License; and
• You must cause any modified files to carry prominent notices stating that You changed the 

files; and
• You must retain, in the Source Format of any Derivative Works that You distribute, BEA’s 

copyright notice, "© [Date] BEA Systems, Inc. All rights Reserved.", and all other copyright, 
patent, trademark, and attribution notices from the Source Format of the Software, 
excluding those notices that do not pertain to any part of the Derivative Works; and

• You must affix to the Software or any Derivative Works in a prominent manner BEA’s 
copyright notice, "(© [Date] BEA Systems, Inc. All rights Reserved." whenever You distribute 
the Software or such Derivative Works in Object Format.

You may add Your own copyright statement to Your modifications and may provide additional 
or different license terms and conditions for use, reproduction, or distribution of Your 
modifications, or for any such Derivative Works as a whole, provided Your use, reproduction, 
and distribution of the Software otherwise complies with the conditions stated in this License.

5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution 
intentionally submitted for inclusion in the Software by You to the Licensor shall be under 
the terms and conditions of this License, without any additional terms or conditions. 
Notwithstanding the above, nothing herein shall supersede or modify the terms of 
any separate license agreement you may have executed with Licensor regarding such 
Contributions.
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6. Trademarks. This License does not grant permission to use the trade names, trademarks, 
service marks, or product names of the Licensor, except as required for reasonable and 
customary use in describing the origin of the Software and reproducing the content of the 
NOTICE file.

7. Disclaimer of Warranty. EXCEPT AS EXPRESSLY SET FORTH IN THIS AGREEMENT, THE SOFTWARE 
IS PROVIDED ON AN "AS IS" BASIS, WITHOUT WARRANTIES OR REPRESENTATIONS OF ANY 
KIND, EITHER EXPRESS OR IMPLIED INCLUDING, WITHOUT LIMITATION, ANY WARRANTIES OF 
TITLE, NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 
You are solely responsible for determining the appropriateness of using and distributing the 
Software and assume all risks associated with Your exercise of rights under this Agreement, 
including but not limited to the risks and costs of program errors, compliance with applicable 
laws, damage to or loss of data, programs or equipment, and unavailability or interruption 
of operations. Further, You understand that although each Contributor grants the licenses 
to its Contributions set forth herein, no assurances are provided by any Contributor that its 
Contribution does not infringe the patent or other intellectual property rights of any other 
entity. Each Contributor disclaims any liability to You for claims brought by any other entity 
based on infringement of intellectual property rights or otherwise. As a condition to exercising 
the rights and licenses granted hereunder, You hereby assume sole responsibility to secure any 
other intellectual property rights needed, if any.

8. Limitation of Liability. EXCEPT AS EXPRESSLY SET FORTH IN THIS AGREEMENT, NO 
CONTRIBUTOR SHALL HAVE ANY LIABILITY TO YOU FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING WITHOUT LIMITATION LOST 
PROFITS), HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, 
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY 
OUT OF THE USE OR DISTRIBUTION OF THE SOFTWARE OR THE EXERCISE OF ANY RIGHTS 
GRANTED HEREUNDER, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

9. Accepting Warranty or Additional Liability. Commercial distributors of software may accept 
certain responsibilities with respect to end users, business partners and the like. While this 
license is intended to facilitate the commercial use of the Software, if You include the Software 
in a commercial product offering, You may do so only in a manner which does not create 
potential liability for any Contributor. Therefore, if You include the Software in a commercial 
product offering, You shall and hereby do agree to defend and indemnify each and every 
Contributor against any losses, damages and costs (collectively "Losses") arising from claims, 
lawsuits and other legal actions brought by a third party against such Contributor(s) to the 
extent caused by Your acts or omissions in connection with Your distribution of the Software 
in a commercial product offering. The obligations in this section do not apply to any claims or 
Losses relating to any actual or alleged intellectual property infringement. In order to qualify to 
receive indemnification from You, a Contributor must:

a. promptly notify You in writing of such claim, and

b. allow the You to control, and cooperate with the You in, the defense and any related 
settlement negotiations.

The Contributor indemnified by You may participate in any such claim at its own expense.
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